	
	Комментарии [0] 

	


	Вряд ли стоит спорить с тем, что компьютерная графика это искусство не отображения какого-либо объекта, а скорее имитация отображения. Дело даже не в том, что мы чаще всего занимаемся не разработкой чего-либо, а подгонкой исходного материала под необходимый результат (хотя так оно есть и, видимо, будет еще очень долго). Но все остальное, что мы делаем, не является прерогативой двумерной компьютерной графики, а является лишь повторением чего-либо, что и без вычислительных машин применяется (либо применялось) в обычном (неинформатизированном) мире. 
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Доказать? Пожалуйста. К примеру, монтаж. Большинство новичков используют PhotoShop для издевательств над своими фотографиями, чаще всего делают фотографии, где они находятся вместе с известными людьми. Разумеется, это примитив по технике исполнения и требует лишь здоровой доли занудства (для многократного повторения однообразных действий), но выглядит весьма и весьма забавно. Так вот, этим же еще наши деды могли баловаться, правда, на обычных фотографиях. Даже профессия есть, люди которой решают подобные проблемы, - ретушер. 

Или, если мы что-либо непосредственно рисуем в программе, мы повторяем определенные наработки художников того или иного течения. Обычно в этом плане компьютерная графика определяется стилем сюрреалистов. Причина - нет четкого сюжета, и поэтому любое визуально приятное нагромождение объектов, обработанное кучей фильтров, уже можно, назвав потуманней, отправить на какой-нибудь дизайнерский сайт, проводящий конкурс работ в том или ином графическом пакете. И это совсем не плохо, даже наоборот - иногда очень интересные вещи создаются. Но посмотрите работы Сальвадора Дали - все, что вы пытаетесь сделать сейчас с помощью вашего компьютера, этот мастер уже реализовал в своих работах обычной кисточкой. У него можно найти элементы, крайне похожие на те, которые сейчас реализуются при помощи приемов машинной графики: пикселизацию, массовый индластинг, многократное повторение, неполную прорисовку и так далее. К чему все это пишется? Я пытаюсь доказать, что компьютерная графика есть искусство самореализации через имитацию, интуитивный поиск аналогий. Поэтому хорошо сделать работу значит хорошо сделать ее похожей на что-то - реальный пейзаж, настоящую групповую фотографию, сюрреалистичную картину, рисунок карандашом и так далее. При этом не стоит отказывать компьютерной графике в индивидуальности - она индивидуальна в неограниченности путей для повторения чего-либо. 

Сегодня мы продолжим тему, начатую в предыдущей статье, а именно будем по-прежнему пытаться покорить природу. Сегодняшний пример имитирует реальную природу. Мы будем создавать морозный день в жаркой пустыне. И это вовсе не бред - средствами Adobe PhotoShop все будет реализовано достаточно быстро и крайне правдоподобно (неверующие - смотрите иллюстрацию). 

Техника, в которой мы будем работать, считается классической, и поэтому советую обратить на нее особое внимание. Фотографию лучше брать с пейзажем, подобным нашему - будет легче работать. Второй раз вы сможете повторить это уже практически с любым изображением. Наша фотография есть на сайте "Компьютерной газеты", так что продвинутые пользователи могут воспользоваться этой возможностью.
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Особенность двух последних эффектов, предлагаемых вашему вниманию, заключается в том, что в них при помощи стандартного набора инструментов, фильтров и эффектов исходные изображения преобразуются в диаметрально противоположные. А именно жаркий солнечный летний день становится дождливым и пасмурным, а знойные горы покрываются снегом и льдом. Но, хватит разговоров, перейдем непосредственно к работе.

Для начала подберите фотографию, с которой вы будете работать. Я выбрала на первый взгляд абсолютно не подходящее изображение гор под палящими лучами солнца. Казалось бы, что может связывать этот жаркий пустынный пейзаж с холодной зимой, но немного усердия - и горы покроются снегом, а от пустыни не останется ни следа. Для начала покроем снегом ровные участки на изображении. Для этого при помощи пера выделите все плоские области, включая подножья скал. Вы можете воспользоваться любым другим инструментом выделения, предлагаемым создателями PhotoShop, но на мое усмотрение перо позволяет наиболее четко определить границы выделяемых объектов, а главное путь, созданный данным инструментом, можно редактировать. Если на вашем изображении присутствуют какие-либо объекты, которые должны быть покрыты меньшим количеством снега, чем остальные участки равнины, то оставьте их невыделенными. 

Я для примера выбрала таким объектом дорогу. Преобразуйте выделенную область в маску. Для этого перейдите в палитру каналов и щелкните левой клавишею мыши по иконке с изображением белого кружка, ограниченного пунктирной линией. Переименуйте полученный канал в "Снег".

Если вы посмотрите на любой пейзаж, то увидите, что он имеет три измерения, и глубина в реальной природе выражена так же ярко, как высота и ширина. Для того чтобы передать ее, воспользуемся еще одним вспомогательным каналом, который назовем "Глубина". Итак, создайте новый канал, на котором нарисуйте градиентный переход от черного цвета к белому. Темная часть градиента должна располагаться вверху, а нижняя соответственно внизу. Эта маска будет нужна для того, чтобы применяемые к изображению фильтры были видны более четко на переднем плане, нежели на втором.

Создайте копию канала "Снег" и назовите его "Снег 1", затем, находясь в только что созданном канале, загрузите маску "Глубина" в выделение. Для этого щелкните по необходимому каналу левой клавишею мыши, удерживая Ctrl, либо щелкните правой клавишею мыши по данному каналу и из раскрывшегося меню выберите "Преобразовать в выделение". Размойте канал "Снег 1", если одного раза не достаточно, то повторите эту операцию вновь. Так как снежные сугробы имеют неправильную форму и покрывают землю неоднородно, то примените фильтр "Выделить края" из набора "Набросок". На предложенном вашему вниманию изображении фильтр был применен со следующими настройками: Баланс изображения - 25, Смягчение - 11, Контраст - 17.

Перейдите в палитру слоев, предварительно загрузив маску "Снег 1" в выделение. Создайте новый слой, скопировав на него выделенную область. Для этого щелкните правой клавишею мыши по слою с фоном и из раскрывшегося меню выберите: "слой через копирование". Для удобства можете назвать его "Равнина". При работе с этим изображением слоев будет довольно много, так что советую их именовать понятнее для себя, чтобы не запутаться впоследствии.

Сейчас, наконец, перейдем к непосредственному созданию снега. Для этого, находясь на только что созданном слое, проделайте следующее "Изображение - Настройки - Убрать цвет". Не перепутайте данную операцию с преобразованием изображения в черно-белый режим, так как мы только изменяем цвет на фотографии, не изменяя при этом цветовые каналы, из которых он состоит. После преобразования участки снега должны стать довольно темного серого цвета. Для того чтобы они превратились в белые, необходимо несколько подкорректировать настройки данного слоя. Я предлагаю проделать это при помощи "Уровней". Для этого сделайте следующее: Изображение - Настройки - Уровни, либо сочетание клавиш Ctrl+L. Сейчас подвиньте белый маркер к пику графика (если начальное изображение очень темное), либо почти к самому пику (в том случае, когда особого осветления не требуется).

Если вы оставили менее заснеженные участки на переднем плане, то следующие несколько предложений для вас. Сейчас вам необходимо их выделить, особой точности здесь не требуется. Создайте слой через копию, а теперь новый слой "Передний план" поместите под слоем "Снег". Из-за того, что "Снег" будет перекрывать только что созданный "Передний план", точные границы выделения на нем и не требовались. Обесцветьте слой переднего плана аналогичным способом. Далее следует действовать в зависимости от того, какой объект вы редактируете. Если, к примеру, вы работаете с изображением дороги, то можете применить фильтр "Мокрая бумага" из серии "Набросок". Благодаря этому фильтру вы сможете воссоздать эффект неровной грязноватой поверхности. Можете слегка изменить прозрачность слоя, для того чтобы из-под снега проглядывала дорога со своим первоначальным цветом. Если снег получился слишком темный, то, как и в предыдущем примере, подкорректируйте настройки "Уровни" (Ctrl+L), придав дороге более светлый цвет.

После того, как с плоскими участками работа закончена, необходимо заняться скалами. Ведь если подумать, то на них тоже должен лежать снег, но больше всего его должно быть в расщелинах и на вершинах. Для того чтобы продолжить работу, создадим еще один слой. Назовите его "Скалы". Этот слой должен быть копией фона. При помощи следующих операций: Изображение - Настройки - Убрать цвет - обесцветьте ваши горы. Снова можете воспользоваться фильтром "Мокрая бумага", на этот раз для того, чтобы создать подобие комков снега, которые будут находиться в тех местах, откуда их не смог выдуть ветер. 

Для того чтобы отрегулировать прозрачность и видимость некоторых участков данного слоя, откройте палитру "Параметры слоя", щелкнув правой клавишей мыши по слою "Скалы". А теперь отредактируйте настройки в графе "Этот слой". Добейтесь того, чтобы ваши горы стали в достаточной степени видны из-под снега.

Сейчас вам необходимо создать еще один слой через копирование, предварительно выделив на фоновом слое небо. Для выделения вы можете воспользоваться любым стандартным инструментом выделения (от волшебной палочки и до пера).

Для того чтобы изображение приобрело практически законченный вид, необходимо правильно расположить слои. В самом верху должен быть слой "Небо", ниже - "Равнина", следующий - "Дорога", затем - "Скалы", ну а в самом низу должен располагаться исходный фоновый слой.

Теперь соедините разрозненные слои в единое целое. Для этого вы можете проделать ряд различных операций.

1-ое, что вы можете сделать, - это создать новый корректирующий слой "Цвет, Насыщенность". Если вы немного понизите параметры "Легкость" и "Насыщенность", то слишком яркие участки на вашем изображении потускнеют.

2-ое. Вы можете сделать небо более пасмурным, наложив на него еще один слой с фильтром "облака" и невысокой прозрачностью.

3-е. И наконец вы можете просто оттенить все ваше изображение, придать ему голубую дымку при помощи еще одного слоя, залитого темно-синим цветом. Прозрачность данного слоя установите небольшую.

Если вам хочется придать побольше яркости и выразительности вашему зимнему пейзажу, то вы можете воспользоваться приемами, описанными в КГ N№N№ 34, 39. Они есть в архиве на сайте газеты. Там были описаны приемы создания ледяной и снежной надписи. Все, что касалось текста, можно применить и к любому другому изображению.

На сегодня, пожалуй, закончим с эффектами, создаваемыми при помощи стандартного набора инструментов данного графического редактора, и перейдем ко второй части статьи.

Сегодня мы рассмотрим крайне интересный (как мне лично кажется) дополнительный плагин к Adobe Photoshop. Он, может быть, и не самый полезный, однако имеет уникальное свойство - это неплохое развлечение, даже можно гостей до слез рассмешить (особенно если после застолья:)). Называется эта прелесть KPT Goo. Как, наверное, уже обратили внимание постоянные читатели, мы уже описывали одно произведение этой компании - KPT 3. Этот плагин значительно более новый, хотя сделан по отдельной программе. Увы, я не скажу вам ее названия, так как видела года два назад, а память наша как решето - все мелкое теряется. Но это не суть важно. Что может делать этот плагин? В принципе, он искривляет все что угодно какими угодно способами, с не самыми лучшими настройками. В чем же его уникальность? А в том, что вы можете записывать все процессы изменения в видеофайл (AVI, MOV), а затем просматривать, падая со стула и продолжая процесс смеха уже на полу:). Ну, конечно, последний эффект достигается только если вы издеваетесь над изображением знакомых или вашими собственными. Заинтригованы? Приступим тогда непосредственно к описанию этого чуда KPT Goo.

Если вы достали этот фильтр и установили его, то время выбрать фотографию. Я советую, чтобы это было изображение лица, так как в этом случае возможности фильтра проявятся во всей своей красе. Единственное техническое требование: если вы не владеете третьим пентиумом с 256 мегабайтами памяти, то фотография должна быть разрешения не более 150 точек на дюйм - иначе тормоза будут умопомрачительными, можете поверить на слово и без проверок.

Интерфейс программы я бы не назвала направленным на профессионалов, однако и совсем для чайников назвать его трудно. Сразу мы можем видеть три области: непосредственно область редактирования, область выбора инструмента, область редактирования видео. Рассмотрим по порядку.
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Основное окно. Вы можете здесь наблюдать свою фотографию. Опций здесь очень мало: pan (в виде креста) - двигать изображение, Zoom in (знак +) - увеличение изображения. Zoom out (знак -) - уменьшение картинки, Reset Image (два листика) - вернуть к исходному. Эти инструменты используются для подготовки фотографии к трансформации. Вверху этой рабочей области вы можете найти стрелку, клик по которой откроет вам меню некоторых глобальных настроек, которые, на мой взгляд, бесполезны, и описывать поэтому их я не стану.

Панель инструментов. Перечень их, конечно, не очень широк, но сделать при их помощи можно многое. Когда вы будете смотреть инструменты, сразу тестите их действие на фотографии - эффект достаточно неожиданный.

Итак, первый - Smear. В принципе, это то же самое, что и инструмент "палец" в PhotoShop, даже настройки похожие. Только действия их несколько разные. Действует он так: смещает некоторое количество пикселей области на заданное расстояние. Если по-простому, то берете и мажете, как густую краску пальцем. Настроек всего две: диаметр инструмента и эффективность (если утрировано, то это значит, какое процентное количество от всех пикселей сместится и на какое расстояние. Разумеется, 100% - смещение всех точек на все расстояние). Это и будет ваша основная кисть.

Второй инструмент - Magnet (магнит). Действует несколько подобно Smear, но сносит область гораздо больше своих размеров и с меньшим искажением. Настройки те же.

Третий инструмент - UnGoo (ластик). Отменяет действие прочих кистей в области, обрабатываемой им.

Четвертый - Smooth (размытие). Название говорит само за себя. Временами этот инструмент очень напоминает UnGoo.

Noise - шум. Отличный инструмент, чтобы хорошо исказить лицо. Описывать бесполезно, это нужно видеть:).

Twirl - скручивание. Обратите внимание только на то, как изменить направление действия инструмента - около названия "Twirl" есть знак "+" или "-". "+" - движение по часовой стрелке, "-" - против. Для изменения режима достаточно щелкнуть второй раз по выбранному инструменту.

Pinch - стягивание. Сжимает изображение к центру, отлично можно сделать из толстяка жертву концлагеря:). Тоже все понятно. Но инструмент имеет второй режим работы "Bulge" - тут вы уже из своего худенького друга вполне можете борца сумо вырисовать. Вот вроде бы и все с кистями. Переходим к вопросу о создании видео.

Для этого в плагине есть отдельная рабочая область, имеющая вполне стандартный вид. Как ею пользоваться? Легче легкого. Ставите в первый кадр (простым щелчком левой клавиши мыши) нетронутую фотографию. Потом, к примеру, растягиваете при помощи Smear рот и сохраняете аналогичным образом во втором кадре. Стоит сразу сказать, что никакого отношения эти кадры к реальным не имеют - это просто опорные точки. Создав подобным образом пять - шесть этих самых опорных точек, нажмите кнопку "Preview". Этим самым вы увидите результат своего труда без сохранения в файле. Я думаю, вы сразу обратите внимание на то, как плавно программа реализует анимацию. Если постараться, можно сделать очень правдоподобно. В случае, когда вас не удовлетворяет скорость изменений, воспользуйтесь бегунком "Animation speed", который позволяет изменять этот параметр.

Если результат вам понравился, вы можете его сохранить в виде видеофайла. Для этого нажмите "Output", вам будет предложено выбрать формат файла. Я лично советую AVI. Но не стоит забывать одну важную вещь - этот стандарт без сжатия крайне много весит. Поэтому щелкните "Setting" и выберите сжатие 70-80%. Воспользовавшись "Size", можно сделать размер видеокартинки больше либо меньше исходного изображения.

Пример применения данного фильтра вы можете видеть на фотографии.

Конечно, этот фильтр можно применять не только для развлечения. Он прекрасно помогает в процессе создания многих эффектов благодаря проработанным кистям. Где его взять? Легче всего в Интернет - на сайте www.kpt.com . Весит он совсем немного - 3,7 мегабайта, что составляет примерно 15-20 минут модемной скачки. Он есть практически на всех дисках с дополнительными плагинами к Adobe PhotoShop.

На сим позвольте попрощаться.
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	В одном из недавно полученных писем читатель спрашивал меня, какие общие тенденции можно выделить из развития PhotoShop от третьей до шестой версии. Ему это необходимо было для курсовой работы, а мне это послужило определенным стимулом, дабы подумать на эту тему. Несомненна только одна тенденция, которая характерна, в принципе, и для большинства других программ - все меньше зависит от человека и все больше за него делает машина. Хорошо это или плохо, сказать однозначно невозможно. С одной стороны, чем меньше мы времени тратим для обучения и эффективной работы с программой, тем лучше. Но с другой стороны, чтобы в третьей версии программы добиться чего-то умопомрачительного на вид, требовалось действительно обладать талантом. Теперь это совсем не является необходимостью, и меня лично это огорчает. Но, впрочем, это только личные чувства. То есть, тенденция к упрощению стала первой и основной.
Шестая версия PhotoShop стала революционной в том плане, что наконец Adobe предпринял попытку "убийства" Corel Draw. В чем это заключается? Многие вещи, к примеру (и в основном) эмблемы, приходится рисовать в векторной графике. Раньше, только для создания эмблем многие дизайнеры держали на своем компьютере Corel Draw (впрочем, оговорюсь - "дрова корела" тоже очень мощный пакет, позволяющий решать кучу задач), теперь, после появления в PhotoShop 6.0 Shapes (Фигуры), ту программу можно смело удалять за бесполезностью. Этот эффект усиливает улучшенная работа с текстом и мощнейшие слоевые эффекты. То есть, вторая тенденция развития - постепенная интеграция векторной и растровой графики в одном мощнейшем пакете.

Третьей тенденцией стала оптимизация PhotoShop под работу веб-мастеров. Как помнят старые пользователи (наверное, их не так много :)), в третьей версии программы никаких специальных инструментов для облегчения работы по созданию сайтов не было. К шестой мы получили огромное количество средств, позволяющих реализовать большинство связанных с графикой в Интернет задач. Видимо, Adobe поняла, что самый мощный, самый динамичный пласт покупателей ее продукта это именно работники IT структур, а не только полиграфисты, как это было году в 96-м. И они правы. Интернет сейчас очень финансово емкая структура, что, впрочем, не совсем заметно в наше стране, где даже веб-дизайн в самых крупных (в наших мерках) студиях носит полупрофессиональный характер.

Эти три тенденции скорее всего станут основополагающими в развитии PhotoShop на ближайшие лет десять. Но вернемся от лирики к конкретике и перейдем непосредственно к примерам.

Мы наконец вернулись к идеальной форме серии, то есть будет описано три примера неявной работы в PhotoShop 6.0 (или 5.5). Описание их будет несколько упрощенное, но, на мой взгляд, наиболее конкретное из всех возможных.

Фигурная деревянная рамка 
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Иногда требуется сымитировать естественную, деревянную рамку для фотографии. Самый простой вариант обычной квадратной рамки описывать не станем - это очень просто и без того понятно, и, кроме того, в программе версии 6.0 есть уже готовый экшин Wood Frame, который делает это хоть и не идеально, но вполне пристойно.

Наша задача куда сложнее - сделать не просто деревянную и объемную рамку, но еще и произвольной формы. Выполнить это будет куда трудней.

Прежде всего, создайте новое изображение (Ctrl+N) в RGB цветовой системе. Размеры можно взять произвольные, но высота должна быть больше ширины примерно в полтора раза.

Теперь создадим контур будущей рамки. Для реализации этого идеально подходит инструмент Pen (Перо).

Используя перо, мы будем создавать новый путь, поэтому откройте палитру Paths.

Прежде всего нарисуйте просто замкнутый прямоугольник. Помните о том, что пути никакого отношения к изображению не имеют, это одна из форм интерпретации выделения.

Затем возьмите инструмент Add Anchor point Tool (перо с плюсом) и модифицируйте контур по вашему желанию. Чем сложнее получится контур (в разумных пределах), тем лучше. Помните о том, что излишнее количество элементов только мешает в получении хорошего результата.

Если вы удовлетворены полученным контуром, то его необходимо перевести в выделение. Для этого нажмите кнопку "Load paths as selection" в палитре Paths. Вы получите самое что ни на есть обычное выделение, но при этом путь у вас сохранится тоже, так что если вы что-то сделаете не так, то всегда сможете исправиться.

Теперь необходимо залить рамку деревянной текстурой. Вы можете воспользоваться либо готовой, фотографической текстурой (идеальный вариант), либо сами нарисовать ее по методике, описанной в одной из прошлых статей (качественный вариант), либо воспользоваться Стилями (Style) (быстрый вариант). Мы пойдем по последнему пути.

Скопируем кусок фона, соответствующий выделению на новый слой. Это необходимо для эффективного применения Стиля слоя (Layer Style). Чтобы это выполнить, нажмите сочетание клавиш Ctrl+C (Copy) и Ctrl+V (Paste) последовательно. Обратите внимание: раскладка в системе при этом должна быть обязательно английская. Изменения вы сможете наблюдать только в палитре слоев (Layers).

Откройте палитру Стили (Style). Загрузите набор "Textures". Это небольшая коллекция слоевых стилей, среди которых есть и дерево. Запустите "Oak". Как результат, вы получите что-то очень напоминающее деревянную доску.

Но нам необходимо добиться объема рамки. Для этого исполнения в PhotoShop есть весьма подходящая функция - Скосы и Рельеф: Layer->Layer Style->Bevel and Emboss (Слой->Стиль слоя->Рельеф и Объем). Настройки лучше подбирать под каждый отдельный случай, но контур необходимо брать по умолчанию, не изменяя параметр.

Теперь можно вставить непосредственно фотографию, для которой эта рамка и была создана. В нашем случае это портрет девушки. Вставить лучше всего следующим образом.

Откройте исходную фотографию. Выделите все (Ctrl+A) либо Select->All (Выделение->Все). Скопируйте (Ctrl+C) фотографию и вставьте (Ctrl+V) уже в изображении рамки на новый слой. Поправить размеры вставленной области можно при помощи Free Transform (Ctrl+T).

Но вид полученного изображения неудовлетворителен, так как не реалистичен. Для исправления этого необходимо сделать несколько корректирующих операций.

Прежде всего, примените к тому слою, на котором находится фотография, Bevel and Emboss, подобрав параметры на глаз. Обратите внимание на то, что, изменяя значение Direction (Направление), можно добиться впечатления как выпуклости, так и впадения фотографии в рамку.

Далее напишите подпись (T) к рамке и примените к ней все те же Слоевые Стили для получения объемных букв.

Все остальные улучшения также делаются через layer Style, поэтому не станем описывать их подробно. Скажем только, что гвозди на фотографии и оформление подписи сделаны при помощи выделения и Bevel and Emboss. Фон - это простой линейный градиент.

Вот и все, рамка готова.



Эффект жалюзи
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В этой главе будет описан процесс создания жалюзи. Существует три основных способа реализации этого эффекта. Первый - с использованием готовой текстуры. Второй очень похож на создание растровых полос, описанных в одной из прошлых статей. Третий же способ наиболее приемлемый с точки зрения результата и затрат времени. Про него и будет эта часть статьи.

Прежде всего, подберите готовое изображение, на которое будут накладываться жалюзи. Этот эффект не смотрится с рисованными картинками, поэтому необходимо найти фотографию. Содержание ее не имеет особого значения, но лучше, чтобы она была не меньше 400 на 400 пикселей по размеру.

После того, как вы открыли фотографию, необходимо посмотреть ее линейные размеры. Для этого нажмите Image->Image Size (Изображение->Настройка). Значения ширины (Width) и высоты (Height) запомните или запишите.

Откройте новую заготовку (Ctrl+N). Обратите внимание на размеры. Ширина должна соответствовать ширине отобранной фотографии, а высоту возьмите примерно в семь-восемь раз меньше. Фон (Background) обязательно должен быть прозрачным (Transparent).

Теперь, используя инструмент Rectangular Marquee Tool (Прямоугольное выделение), выделите третью часть нового изображения вертикально. Лучше это сделать в верхней части, но и в любом другом случае эффект получится.

Вы можете несколько улучшить внешний вид будущих жалюзи, если создадите их не прямоугольными, а несколько скошенными по краям. Для этого на этом этапе работы необходимо изменить выделение, используя Transform Selection: Select->Transform selection (Выделение->Трансформировать выделение) со значением Distort (Искривление).

Установите цвета в состояние по умолчанию (D) и возьмите инструмент Gradient Tool (Градиент). Обратите внимание на то, какой вид градиента используется. Для этой операции идеально подходит Linear (Линейный).

Залейте выделение таким образом, чтобы получилось нечто подобное теневой игре на реальных жалюзи. У вас всегда есть возможность посмотреть итоговый вариант.

Обратите внимание на то, что если вы хотите создать впечатление жалюзи, открытых снизу, то лучше черную часть градиента размещать сверху и наоборот соответственно.

Заготовка для создания эффекта готова. Удалите выделение (Ctrl+D) либо Select->Deselect (Выделение->Убрать выделение).

Определите это изображение как образец: Edit->Define Pattern (Правка->Определить образец). В результате в палитру образцов добавится новый.

На этом файл с заготовкой можно закрыть, он нам больше не понадобится. Сделаем активным рабочее изображение.

Дело в том, что в PhotoShop можно заливать не только цветом, но и примером (Pattern), то есть любой картинкой, которую вы, как этот самый пример, определили. Это свойство программы нам необходимо использовать.

Создайте новый слой (Ctrl+Shift+N). Выполните команду Fill: Edit->Fill (Правка->Залить), использовав в качестве источника Pattern и выбрав необходимый образец.

Результат уже достаточно похож на жалюзи, однако можно добиться и большего сходства.

Придадим пластинам некоторый объем. Для этого откройте палитру каналов (Channels) и создайте новый канал (Create a New Channel). Залейте его аналогично тому, как только что залили слой.

Перейдите в канал RGB. Никаких изменений изображения вы не увидите, так как альфа-канал это просто одна из форм выделения и отношения к изображению не имеет.

Используем фильтр Lighting Effects: Filter->Render->Lighting Effects (Фильтр->Рендер->Эффекты света). Обязательно установите в качестве Texture Channel (Канал текстуры) канал Alpha 1.

На этом работу можно считать законченной. Но для улучшения эффекта можно создать впечатление того, что свет идет из-за жалюзи, как это было, если бы смотрели из темноты в освещенное окно.

Для выполнения этой задачи применяется все тот же Lighting Effects. Перейдите на слой с фотографией и примените этот фильтр с настройками, подобранными на глаз.

Эффект сделан полностью. Стоит помнить, что это упрощенный, даже, можно сказать, халтурный вариант, но по этой же технологии делаются абсолютно фотографичного качества жалюзи.

Мозаичная поверхность

Этот эффект является одним из самых красивых и легко выполнимых. Сделать его настолько просто, что мы приведем два варианта создания, сильно отличающихся друг от друга по внешнему виду. Стоит сказать, что в PhotoShop 6.0 есть готовый экшин, создающий этот самый эффект, который так и называется "Puzzle". Однако им пользоваться я не рекомендую, так как качественней, чем руками, сделать все равно не получится.

Вариант 1.
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Прежде всего, подберите фотографию для работы. Дело в том, что этот эффект наиболее хорошо смотрится именно с готовыми изображениями фотографического качества, и поэтому необходимо использовать фотографию для получения полного впечатления от мозаики.

Теперь воспользуемся тем, что делает создание этого эффекта легкой и краткосрочной работой. Создатели Adobe PhotoShop 6.0 предусмотрительно положили несколько карт текстур в папку программы, среди них есть и карта мозаичной поверхности.

Создайте новый слой (Shift+Ctrl+N). Залейте его, используя Paint Bucket Tool (Ведро), белой краской. Дело в том, что следующий фильтр не работает с прозрачными слоями.

Запустим фильтр Texture Fill: Filter->Render->Texture Fill (Фильтр->Рендер->Заливка текстурой). После этого у вас появится окно выбора файла карты. По сути, карта это просто любое изображение в формате PSD. Сейчас необходимо открыть папку: Photoshop 6.0->Presets->Textures->Puzzle.psd.

Можно считать работу почти сделанной. Осталось совсем немного - совместить эти два слоя. Для этого щелкните в палитре слоев (Layers) по слою с текстурой правой клавишей мыши и в открывшемся меню выберите Blending Options.

В окне Blending Options нас интересуют только две настройки. Blend Mode (Свойства смешения) необходимо поменять на Multiply, а Opacity (Прозрачность) уменьшить до 70%.

Вот и все.

В свойствах смешения (Blend Mode) скрывается огромное количество возможностей. Поэкспериментируйте и примените не только Multiply, но и другие варианты. Результат вас не разочарует.

Вариант 2
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Этот способ значительно более интересный визуально и куда проще делается. Однако, он выглядит достаточно стандартно, а предыдущим вы можете делать поистине уникальные эффекты.

Итак, весь трюк основан на знании фильтра Texturizer и том, что в папке программы есть готовые карты текстур.

Запустите фильтр: Filter->Texture->Texturizer (Фильтр->Текстура->Текстуризатор). В параметре Texture (Текстура) выберите Load Texture (Загрузить) и необходимый файл, который находится по пути: Photoshop 6.0->Presets->Textures->Puzzle.psd.

При помощи параметра Scaling подберите необходимый размер ячеек, а при помощи Relief - необходимую глубину соединений.

Мы по этой причине целиком описали, как создавать эффект, а не сказали, что есть готовый Action. Дело в том, что его вы можете применить только с записанными настройками, в результате чего эффект зачастую не смотрится, особенно на больших изображениях. При использовании описанного же метода вы сами подбираете настройки и тем самым добиваетесь идеального результата.

В заключение хотелось бы попросить только одного. Пишите письма. Причем желательно не только с вопросами, но и со своими находками, новациями в работе с PhotoShop. Конечно же, если я использую ваш пример, то в статье он будет обозначен именем автора.
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	Эта статья является последней, посвященной Photoshop, на достаточно большой период времени. Дело в том, что, начиная со следующего номера, мы откроем новую серию статей, посвященную работе в Flash 5.
Поэтому в этой статье мы хотим написать три примера работы в Photoshop 6.0, которые еще не были описаны, — именно они были выбраны из достаточно большого количества опубликованного материала по одной причине — они действительно ярки и интересны. Одним словом, уйти в векторную графику, не познакомив вас с ними, мы не могли.
Кстати, относятся они ко всем трем основным разновидностям эффектов — трюки с текстом, прикладные эффекты и имитации природных явлений.

Хром
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Когда-то мы уже публиковали эффект с названием "Хром". Но один читатель обратил наше внимание на то, что тот эффект не похож на хром, а скорее, на старую бронзу. Действительно, это авторская промашка. Исправляемся уже сейчас — этот эффект действительно похож на настоящий хром.
Создайте новый файл произвольного размера и цветовой модели, которая позволяет работать с цветом. Это необходимо потому, что практически сразу изображение обретет цвет.
Напишите любой текст, воспользовавшись инструментом Text (клавиша, позволяющая выбрать его с клавиатуры, — T). Подберите для него подходящее место, особых указаний здесь не будет, так как создаваемый эффект не выйдет за пределы букв, а следовательно для его создания не обязательно свободное пространство.
Преобразуйте слой с текстом в обычный растровый режим, для чего щелкните по нему правой клавишей мыши и из раскрывающегося меню выберите Rasterize Layer (Рендеринг слоя). После этой операции буквы останутся на новом слое, но к ним станет возможно применять фильтры и другие функции PhotoShop.
Придадим надписи цвет. Мы предлагаем не делать их однородными, а воспользоваться одним из стилей палитры Styles. Выберите любой в сине-серых тонах. На приведенном примере мы воспользовались стилем, который входит в стандартную поставку PhotoShop и называется Blue Glass (Button).
Дублируйте полученный слой с текстом, для чего щелкните по нему правой клавишей мыши и из раскрывающегося списка выберите Duplicate Layer (Дублировать слой) или просто перетащите его, удерживая левой клавишею мыши к иконке с изображением белого листа, расположенной внизу палитры Layers (Слои).
Далее создадим на одном из слоев эффект объема, для чего преобразуем эффекты, создающие цветовые переходы.
Для этого щелкните двойным щелчком мыши по изображению строк с эффектами в палитре Layers (Слои) или проделайте следующее Layer->Layer Style... (Слой->Слоевые эффекты...) и в появившемся подменю выберите любой из эффектов.
После того, как перед вами появится основная палитра слоевых эффектов, обратите внимание на ее левую часть, где расположен список всех существующих эффектов, в котором отмечены уже использованные. Уберите птички со всех эффектов, то есть удалите их все.
Примените новые, создающие иллюзию объема, эффекты. На данном примере были использованы два слоевых эффекта: Outer Glow (Внешнее свечение) и Bevel and Emboss (Скосы и рельефы).
Не станем указывать настройки, они подходят только к нашему изображению. Если вы использовали тоньше или, наоборот, толще буквы или были какие-либо иные различия, то рекомендуем все же обращать внимание на свое изображение и получаемый результат.
Обратите внимание на свое изображение. Сейчас возможны два варианта того, как оно выглядит. Буквы могут быть плоскими, но цветными, или объемными, но бесцветными. Если у вас первый вариант, то, следовательно, слой с эффектами, образующими цвет, находится наверху. Если второй, то, наоборот, новый преобразованный слой с объемными эффектами находится над цветовым.
Необходимо расположить слои на изображении так, чтобы слой с цветом был наверху.
Уменьшите прозрачность верхнего слоя, чтобы стал виден слой с объемными буквами. На приведенном примере мы установили значение параметра Opacity (Непрозрачность) равным 54%.
В результате всех вышеописанных действий должны получиться довольно мрачные и темные буквы.
Если вы довольны результатом, получившимся на данном этапе, а для этого буквы должны обладать цветом и объемом, то слои можно склеить, в том числе и фоновый. Для этого достаточно нажать сочетание клавиш Ctrl+Shift+Е или проделать Layer->Merge Visible (Слой->Слияние видимых).
Для исправления эффекта мрачности воспользуемся основным инструментом цветокоррекции, а именно кривыми. С их помощью увеличим контрастность некоторых цветов на изображении. Для того чтобы открыть диалоговое окно данной опции, необходимо проделать Image->Adjust->Curves (Изображение->Настройки->Кривые) или нажать сочетание клавиш Ctrl+M.
Кривая должна иметь два перегиба и быть подобной той, которую когда-то мы использовали для создания золотой надписи.
Изменим немного насыщенность и освещенность букв, для чего воспользуемся функцией Hue/Saturation (Цвет/Насыщенность) из меню Image (Изображение) подменю Adjust (Настройки). Насыщенность цветов необходимо несколько уменьшить, так как хром все же больше сероватый металл, нежели синий, а вот освещенность лучше увеличить, дабы добавить блеска.
Посмотрите на представленное итоговое изображение. Если в процессе цветокоррекции несколько осветлился фон, то это можно исправить, воспользовавшись диаграммой уровней (Levels), перетащив темный указатель несколько правее.

Наращиваем небо
Проблемы композиции встречаются чаще, нежели другие. Особенно часто этот вопрос возникает при использовании готовых фотографий. В этой главе мы рассмотрим один из самых распространенных недостатков — это непропорциональность изображения.

Вариант 1
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Первый рассматриваемый вариант — это панорамы. Такие изображения имеют большую длину, но недостаточную высоту. Они пригодны только лишь для любования ими, но если ваша цель иная и вы хотите после работать с таким изображением или использовать его в качестве фона, то придется сперва его несколько преобразовать.
Для начала увеличьте размер холста. Для этого необходимо проделать Image->Canvas Size (Изображение->Размер холста). После того, как эта команда будет выполнена, появится область, залитая фоновым цветом.
После выполнения данной операции размер холста увеличится, а исходное изображение будет расположено внизу.
Обратите внимание на верхнюю часть неба. Оно чистое, а следовательно, достаточно однородное. В этом случае для восполнения недостающего фрагмента можно воспользоваться таким инструментом, как Gradient (Градиент (G)).
При помощи инструмента Eyedropper (Пипетка) установите в качестве основных цветов (Foreground и background Colors (Цвета переднего плана и фона)) наиболее темный и светлый цвета неба.
Тип градиента выберите линейный (Linear), а вид — Foreground to Background (От цвета переднего плана к цвету фона). Закрасьте таким цветом образовавшуюся белую пустоту вверху. Поэкспериментируйте с различным направлением градиента, подбирая самый подходящий, то есть реалистичный.

Вариант 2.
Данная ситуация может встречаться как на панорамных, так и на любых других изображениях. В чем состоит принципиальное различие между этими двумя изображениями, мы разберемся после, а пока просто увеличьте размер холста аналогично тому способу, который был указан выше, а именно при помощи операции Canvas Size (Размер холста).
А теперь о различиях.
Обратите внимание на край этого неба. Оно все в облаках, а значит, какой бы градиент мы ни создали, правдоподобного результата добиться не удастся.
Способ, описанный здесь, позволяет увеличивать небо не намного, но и этого порой бывает вполне достаточно. Выделите фрагмент неба до самого высокого фрагмента, расположенного на его фоне, в нашем случае выделение доходило до пика горы. Нажмите сочетание клавиш Ctrl + T, вызвав тем самым рамку трансформации. Далее, не изменяя горизонтальных размеров, не вращая и не перемещая область, вытяните ее по вертикали, тем самым растянув имеющуюся область неба на все изображение. В результате может получиться очень правдоподобная фотография, только не следует растягивать слишком сильно. Изображение, которое получили мы, представлено на иллюстрации.

Трехмерные шары в композиции
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Как уже не раз говорилось, PhotoShop — это двумерный графический редактор, предназначенный для работы с растровой графикой. Конечно, здесь есть элементы векторов, однако основная работа производится именно с растром.
Что же касается объема, то здесь несколько сложнее, так как, кроме фильтра 3D Transform, практически нет возможности управлять третьим измерением. Однако, если учесть, что объем, переданный на бумаге или мониторе, — это всего лишь игра света, тени и полутеней, то его вполне можно имитировать, чем мы и попытаемся сейчас заняться. Как известно, шар — это самая простая форма, и для ее имитации больших знаний и усилий не надо. А вот как насчет композиции шаров, которые будут закрывать один другой и сливаться?
Создайте новое изображение произвольного размера и цветовой модели. Фон должен быть черным.
Основным инструментом, с которым мы будем работать, будет Gradient (Градиент (с клавиатуры его можно активизировать, нажав клавишу G)).
Установите основные цвета по умолчанию, а именно черный и белый, для этого достаточно нажать клавишу D.
Выберите тип градиента радиальный (Radial), а вид Foreground to Background (От цвета переднего плана к цвету фона).
Щелкнув по изображению градиента в палитре инструментов, вызовите диалоговое окно Gradient Editor (Редактирование градиента) и передвиньте указатель средней точки несколько правее, то есть, ближе к белому цвету.
После того, как градиент готов, необходимо нарисовать первый шар. Обратите внимание на то, что после использования градиента шар должен быть белым на черном фоне, а не наоборот. Если же у вас получился черный шар, то при помощи палитры History (История) отмените последнее действие и в палитре параметров инструмента Gradient (Градиент) уберите или выставьте птичку возле параметра Reverse (Перевернуть). Первый шар готов.
Далее снова обратимся к палитре настроек. Обратите внимание на параметр Mode (Режим). По умолчанию он стоит как Normal (Обычный), однако для дальнейшей работы следует его изменить на Lighten (Яркость).
После этого можно рисовать следующие шары. Учитывая приведенные настройки, они не будут перекрывать предыдущие, а будут с ними как бы сливаться. Рисуя таким образом градиенты, составляем целую композицию шаров различной величины.
Если вы хотите, чтобы некоторые из шаров не сливались с созданными ранее, а находились над ними, то их следует создавать на отдельных слоях.
Единственное, что хочется сделать, так это придать этим шарам цвет или какую-нибудь текстуру. Для выполнения этого желания следует сделать следующее. Склейте все слои вашего изображения. Выделите окружение, воспользовавшись инструментом Magic Wound (Волшебная палочка). Установите допуск достаточно небольшим, порядка 3-5. Это необходимо потому, что мы хотим выделить только фон, не затрагивая объекты. Щелкните в любом месте черного фона, а после инвертируйте выделение, нажав сочетание клавиш Ctrl+Shift+I или проделав Select->Inverse (Инвертировать).
Вырежьте полученную область на новый слой, щелкнув по фоновому правой клавишею мыши и выбрав из раскрывающегося меню Layer via Cut (Слой через вырезку). Данную операцию можно выполнить и так: Layer->New->Layer via Cut (Слой->Новый->Слой через вырезку) или нажав сочетание клавиш Ctrl+Shift+J.
Дублируйте полученный слой с шарами и на нижний примените какой-нибудь стиль из палитры Styles (Стили). Лучше, если он не будет иметь резких цветовых переходов.
Чтобы сохранить объем и показать цвет, преобразуем режим наложения верхнего слоя, заменив его с Normal (Обычный) на Luminosity.
Далее можно подобрать фон для композиции из шаров. Мы создали его при помощи инструмента Gradient (Градиент), многократно его использовав.
Итоговый результат представлен на иллюстрации 3.
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	Имитация 3D в Photoshop

Реальный мир и мир трехмерный. В эти утверждения заложен один и тот же смысл, и мы можем сказать, что реальный мир - это трехмерный мир. Все, что нас окружает, имеет свой объем (в той или иной степени он может быть относительным). В отличие от плоских фигур, объемные имеют еще и третье измерение, то есть являются трехмерными, и следовательно, единственный способ реализации объемных тел в графике есть реализация 3D. Для этого существуют специальные пакеты, лучший из которых, несомненно, 3D Studio Max. Но наша песня совсем не о том, а о Photoshop, программе растровой плоской (двухмерной) графики. Зачастую перед нами встает задача, как имитировать реальность, не имея для этого специально созданных программ, либо инструментов. Попрошу обратить внимание именно на слово ИМИТИРОВАТЬ. 3D Studio Max имитирует (копирует определенные признаки реального мира) трехмерность природы. Мы же не можем сделать это напрямую. НО! Имитация доступна и в Photoshop. Правда, имитировать мы будем не природу, а трехмерную графику, ее определенные признаки, делающие 3D работы визуально наиболее реальными либо наоборот, наиболее сюрреальными.

Единственное, что делает 3D графику 3D графикой, является освещение. Да, я не оговорилась. Нет ничего отличающего 2D от 3D, кроме правильно примененного эффекта освещения. Разумеется, под этими понятиями я подразумеваю только работы, прошедшие рендер, то есть переведенные в растр, работы, ИМИТИРУЮЩИЕ 3D. Подробней об этом вы можете прочитать в серии статей о 3D Studio Max, напечатанные в КГ осенью прошлого года (они есть на сайте газеты). То есть, поняв, что представляет собой эффект 3D, можно его имитировать. Воспользуемся школьным примером с урока рисования N-ого класса. У нас есть ваза из глины. Нарисуем ее в 2D измерении. Получился контур, заполненный внутри однородным цветом, весьма условно можно принять это за сосуд. Что же необходимо для того, чтобы передать объем вазы? Посмотрим. А поверхность-то представлена не одним цветом, а целой палитрой цветов! Освещенность в разных местах разная - и как следствие, мы можем видеть объемную фигуру. Заметьте, что игра освещенности в природе и определяет существование 3D, а в графике этот процесс воссоздается в обратном порядке. Вспомните, что в школе менее освещенные места вы обозначали большим количеством штрихов, более - меньшим. В принципе, в компьютерной графике ничего не изменилось. Делать придется то же самое, разве что работы будет гораздо меньше, художественный талант нужен минимальный, а результат эффектней.

Сразу стоит сказать, что создатели Photoshop 5.5 большинство проблем, связанных с реализацией 3D, которые были еще в 4 версии (эх, четвертая версия, море пота и крови... :), решили. Основным орудием в реализации эффекта 3D стали эффекты (слой=> эффекты) и 3D фильтр (фильтры=>эффекты света=> 3D). Также дополнительные плагины, вроде PhotoTools, Eye Candy 3.0, они являются большой подмогой в имитации 3D. Но все же основная часть работы ложится на стандартные инструменты (принципиальная позиция этой серии - отсутствие приемов, основанных на применении дополнительных фильтров, ибо далеко не у всех они есть, хотя в будущем, возможно, я напишу обзор своих любимых наборов фильтров). Но сейчас речь не об этом. Итак, для начала, я предлагаю вам попробовать воссоздать при помощи Photoshop самую что ни на есть простую пуговицу, однако ваша задача заключается не в том, чтобы она выглядела как плоский рисованный объект, а в том, чтобы она была как настоящая, объемная пуговичка.

Пуговица

Итак, создайте новый файл (Файл -> создать, либо сочетание клавиш Ctrl+N). Высоту и ширину изображения установите относительно небольшую, порядка 7 - 10 сантиметров. Это необходимо для того, чтобы ваша имитация 3D была более реалистична. При создании изображений больших размеров, похожих на те, которые были созданы при помощи редакторов трехмерной графики, вам потребуется приложить немало усилий при редактировании созданного вами, при помощи инструментов рисования (карандаша, кисти, аэрографа), то есть придется проделать практически все те операции, которые вы бы делали, создавая свой рисунок на бумаге. Ну а если вы не обладаете достаточным талантом, знаниями в области образования светотеневых переходов, возникновения бликов и много другого либо у вас нет желания, да и необходимости для столь кропотливой работы, то вы можете создавать изображения небольших размеров, не прибегая к таким сложным способам их создания, какие были описаны выше.

Создайте новый слой, с которым впоследствии вы и будете работать (слой - создать - слой, либо щелкните левой клавишею мыши по иконке нового слоя внизу палитры слоев). Убедитесь, что находитесь на только что созданном слое и приступайте к непосредственному созданию пуговицы. 

Для начала при помощи инструмента "эллиптическое выделение" создайте ровный круг, если вам тяжело это сделать на глаз, то удерживайте клавиши Ctrl+Shift в процессе его создания (эта функция помогает создать идеальную окружность).
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Так как трехмерность - это только игра света и тени, в черно-белом варианте представленная в виде градаций черного, серого и белого, то наиболее простой способ создать имитацию объемной симметричной круглой фигуры - это использовать радиальный градиент, который образуется при помощи концентрических окружностей. Точка, с которой вы начинаете перетаскивать мышь, является центром вашего градиента. Таким образом, первый цвет градации появится именно в этой точке. Для создания градиента, имитирующего трехмерную пуговицу, щелкните левой клавишею мыши по кнопке "Настройка", расположенной в палитре параметров данного инструмента. В раскрывшемся меню выберите "Новый градиент". А сейчас создайте градиент, состоящий из градаций белого, серого и черного. Две трети должны быть белыми, а еще треть состоять еще из трех частей: черной, белой и снова черной. После того как вы настроили параметры нового градиента в соответствии с тем, что было написано выше, вернитесь к самому изображению.

Теперь проведите радиус градиента из центра круга. В итоге у вас должна получиться окружность, центр которой будет окрашен в белый цвет, а черно-бело-черные полосы будут расположены ближе к периметру. Окраска всего круга должна быть равномерной и одинаковой во всех направлениях. Если вы затрудняетесь определить, где центр круга, то вы можете применить сетку (Вид -> показать сетку, либо Ctrl+"). Эта опция PhotoShop разбивает всю площадь вашего полотна на небольшие квадраты, и вы без труда сможете определить, где находится центр вашей окружности.

Затем вам необходимо удалить белый центр круга, сделав его прозрачным. Это можно сделать при помощи стирки большого радиуса с твердыми краями, а можно модифицировать выделение, уменьшить его радиус (именно так поступила я, сохранив предварительно начальное эллиптическое выделение в виде маски, так как оно еще понадобится).

После того, как вы удалили середину будущей пуговицы, создайте еще один слой, перейдя в палитру слоев. Поместите его под предыдущим. А теперь закрасьте середину пуговицы (в моем случае она ограничена модифицированным выделением), применив линейный градиент, образованный переходом от белого к черному. Однако, когда вы будете проводить прямую - направляющую градиента, точки начала и конца должны лежать вне закрашиваемой области. Это необходимо для того, чтобы переход был более плавный.

Наложите ваш первый слой с ободком на второй в режиме Multiply и склейте эти слои (слои -> слияние вниз, либо сочетание клавиш Ctrl+E).

Для большей эффектности воспользуйтесь фильтром "текстуризация" (фильтр -> текстуратор -> текстуризация). Я использовала следующие настройки: текстура - холст, масштаб - 100 процентов, рельеф - 4, направление вверх.

Какая же пуговица может быть без дырочек, и ваша, конечно, не исключение. Для реализации этого положения воспользуйтесь ластиком среднего размера с жесткими краями. В палитре настроек ластика установите опцию Paintbrush. При таких настройках достаточно один раз щелкнуть данным инструментом, чтобы полностью очистить область, подвластную воздействию.

Так как вы создаете трехмерную пуговицу, то есть она обладает каким-то объемом, то она обязательно должна отбрасывать тень. Для этого воспользуйтесь эффектом слоя - отбросить тень (Слой -> Эффекты -> Отбросить тень).

Раскрасьте ваши пуговицы при помощи настройки, позволяющей влиять на цвет изображения. (Изображение - Цвет, насыщение. Не забудьте установить флажок возле опции "Цвет").

Вот и все. Результат вы можете видеть на фотографии. По-моему неплохо, и вполне объемно.

Ну а сейчас я хочу рассказать вам еще об одном трехмерном объекте - о заклепке, либо болте (окончательный результат будет зависеть от того, на каком этапе создания вы остановитесь). Я думаю, что особенно это будет интересно людям, создающим плакаты, афиши, а также веб-дизайнерам. Каждому человеку, работающему в этих областях, однажды приходит в голову мысль украсить свою страничку заклепками, шурупами, болтами. О том, как наиболее просто и реалистично создать подобную фурнитуру, и пойдет сейчас речь.

Болт

Для начала создайте новый файл с небольшими значениями высоты и ширины (необходимость этого описана выше). Создайте выделение правильной круглой формы, используя инструмент "эллиптическое выделение" (горячая клавиша М) одновременно с нажатыми клавишами Shift+Ctrl.

Так как мы договорились, что имитировать трехмерность будем при помощи переходов, осуществляемых между черным и белым цветами (в приведенных вариантах), то вновь воспользуемся возможностями, предоставляемыми градиентом (клавиша, позволяющая выбирать этот инструмент с клавиатуры G). Закрасьте выделенную область при помощи линейного черно-белого градиента. 

Модифицируйте ваше выделение таким образом, чтобы его радиус уменьшился примерно на 5 пикселов (Выделение -> Изменить -> Контрастность, величину данного параметра установите равную порядка 5).

Сейчас залейте вашу выделенную область тем же градиентом, но в обратном направлении.
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Повторите два последних действия еще раз, только выделенную область уменьшите на чуть меньшее число пикселов, чем в первый раз. В результате вышеописанных операций у вас должна получиться довольно оригинальная и стильная заклепка. Но если вы не хотите останавливаться на достигнутом и намерены все-таки создать болт, то проделайте те действия, которые будут описаны ниже.

Создайте выделение прямоугольной формы, расположенное вертикально посередине внутренней области заклепки. А теперь воспользуйтесь возможностями, которые предлагает такая функция Photoshop, как "Уровни". Для этого проделайте следующее: Изображение -> Настройки -> Уровни, либо нажмите сочетание клавиш Ctrl+L. В раскрывшемся меню вам надо изменить значение в среднем окне на значение, лежащее в диапазоне от 0,1 до 0,4. Теперь слегка сместите ваше выделение вправо, воспользовавшись инструментом перемещение, и вновь вызовите меню уровней, только теперь значение, указанное в центральном окне, необходимо заменить на величину порядка 1,5 -2,5, это позволит создать тень в области фаски, созданной при первом использовании уровней.

Для того чтобы винт выглядел наиболее реальным, на него необходимо наложить металлическую текстуру. Вы можете использовать уже готовую, а можете пойти тем путем, который использовался на том варианте, который вы видите на фотографии. Скопируйте ваш фон на новый слой (перейдите в палитру слоев и перетащите слой с фоном к иконке нового слоя). Измените напряжение только что созданного вами слоя на Screen, и если есть необходимость, то подкорректируйте прозрачность. После чего вы можете склеить ваши слои (Слои -> Слияние вниз, либо сочетание клавиш Ctrl+E). Вот и все! Болт готов к применению. Как вы смогли в очередной раз убедиться, ничего сложного в создании объектов, имитирующих трехмерную графику, нет.

И наконец, в завершение темы, я хочу предложить вам убедиться, что имитировать 3D можно, не только работая с круглыми объектами, но и с фигурами других форм. А убеждаться в этом я вам предлагаю на самых обычных трубах.

Трубы, сплошные трубы

Создайте новый файл. Однако тут размер файла не имеет никакого значения: чем больше его формат, тем больше труб вы сможете разместить и тем более запутанный рисунок у вас получится.

Создание вашего лабиринта из труб я предлагаю начать с подготовки к основному этапу, а именно с создания градиента, который будет использоваться в дальнейшем при реализации даже самых маленьких трубочек. Выберете инструмент "градиент" и в его палитре щелкните левой клавишею мыши по кнопке редактировать. Далее вам предстоит создать новый градиент. Он будет состоять из двух основных цветов: черного и белого - и из серых дополнительных оттенков. Изображение градиента аналогичного тому, который вам необходимо создать, представлено на рисунке. При его создании использовалось 7 цветовых ограничителей: белый, светло-серый, белый, темно-серый, черный, черный, белый - находящихся в положениях 0, 8, 16, 39, 57, 70, 100 соответственно. Все указатели средних точек были оставлены без изменения. 

Ну, вот половина дела сделана. А теперь преступайте к непосредственному созданию труб. Выбирайте различные инструменты выделения (элементарные области и лассо) и создавайте один за другим сегменты вашего мира из труб, поочередно закрашивайте их, используя линейный градиент (горячая клавиша G). Количество, рисунок и конфигурация ваших труб оста.тся исключительно на ваше усмотрение. Вы можете создавать любые, самые затейливые узоры, даже строить замки из труб, только была бы фантазия и желание.
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После того, как вы добились желаемого результата, вам следует предать вашему изображению металлический вид. Сделать это можно аналогично тому, как это было сделано при создании болтов и заклепок.

Для большей реалистичности вы можете выбрать кисть диаметром в 1 пиксел и, щелкнув по ней два раза левой клавишею мыши, изменить количество пробелов до 150%. После этого вы можете провести ряд горизонтальных и вертикальных линий (из-под кисти будут выходить ряды аккуратных точечек), имитирующих заклепки, которые часто встречаются на железных деталях.

На этом объяснение имитации трехмерной графики в графическом редакторе Adobe PhotoShop подошло к концу. Хочется отметить, что при создании работ в этой технике не стоит пренебрегать и другими цветами. Черный и белый цвета, положенные в основу данного объяснения, были выбраны только из-за наглядности. Вы же можете использовать и более сложную палитру, которая не будет ограничиваться только двумя цветами (синим и белым, красным и желтым и пр.). Ведь в действительности, если присмотреться к любому предмету, то на нем всегда будут лежать блики цветов тех предметов, которые окружают рассматриваемый объект. Кроме того, где-нибудь обязательно будет отражен цвет контрастный основному (красный - зеленый, оранжевый - фиолетовый, желтый - синий). Таким образом, если вам необходимо имитировать несложную объемную фигуру, вовсе не обязательно прибегать к пакетам с трехмерными графическими редакторами.
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	Раскрашивание черно-белых изображений
Наш мир цветной. Это утверждение одновременно весьма ограничено (с точки зрения физики) и всеобъемлюще (с бытовой точки зрения). Что такое цвет предмета по физике? Свойство поверхности отражать излучение одного цвета (частоты) в большей степени, нежели другого. Человек в процессе зрения получает информации о предмете в 8 раз больше по его цветовой составляющей, нежели по геометрической (форма). Цветоощущение чем-то подобно музыкальному слуху - у большинства оно развито весьма средне, у кого-то нет вообще или почти нет, а некоторые - настоящие гении в этом плане. Существует множество тестов на определение способности различать цвета, на Западе при приеме на работу в сферу дизайна и компьютерной графики часто соискателей заставляют пройти их в качестве подтверждения профпригодности.
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Зачем я все это пишу? А затем, что в сегодняшней работе постоянным читателям, наверное, впервые придется работать с цветом, как основной задачей работы. Необходимо хотя бы небольшое природное чувство цвета, иначе у вас вряд ли получится толковое изображение.

Сегодня мы будем раскрашивать черно-белую картинку. Компьютерная графика не сделала прорыва в этой области, до появления цветной фотографии солидные западные журналы имели целые отделы художников, занятых этим. Правда, сделать реалистично они не могли, нам же это доступно. Сразу замечу, что работать будем с нормальной черно-белой фотографией фруктов, а не нарисованным тушью контуром. Заниматься тем, что заливать разные части плоского рисованного изображения, не имеет смысла - это проходили еще в детском саду на книжках-раскрасках (если вы помните, что это такое :)). Наша задача во много раз более сложная, полезная и интересная - мы имеем фотографию со всеми свойствами реальных объектов. То есть, существует передача трехмерности естественным цвето-теневым переходом, неровность поверхности и прочее. Разумеется, если бы мы имели просто контур, то нарисовать естественные фрукты было бы совершенно нереально большинству пользователей (есть люди, которые в Paint по точкам изображения фотографического качества рисуют, но это так, почти исключение).

PhotoShop решил большинство проблем, которые возникают при окрашивании изображений. На чем это основано? Как уже рассказывалось, условно каждый пиксель можно разделить на две параметрические составляющие (условно, повторюсь). Это цветовая составляющая (RGB параметры) и световая составляющая (освещенность). То есть, если у нас поверхность состоит из одного вещества (материала), а мы как раз такое изображение подобрали, то единственное, что в ней меняется, это освещенность. Это значит - физически вся поверхность одного цвета (так как она имеет одинаковые физические свойства во всех точках - в рамках разумного, конечно, отражает так же свет одинаково). Следовательно, рассматривать мы будем только вторую составляющую - освещенность. И тут возникает мысль, что на черно-белой фотографии это и есть единственный параметр. Что я хочу сказать? Логически возьмем абсолютно черный цвет (0.0.0 в RGB) как идеально неосвещенный пиксель, а абсолютно белый цвет (255.255.255 в RGB) - как идеально освещенный. У нас еще останется 254 вариации серого цвета (или 254 вариации освещенности) для передачи всех остальных свето-теневых переходов. Что мы в результате получили? Правильно, стандартную ч/б модель компьютерной графики. Как, наверное, уже догадались читатели, почти все за нас сделал PhotoShop. Логично, что, при переходе от черно-белой модели к цветной, освещенность пикселя нам трогать не надо, а необходимо добавить цветовые характеристики.

Обратим внимание на наше изображение. У нас имеется несколько видов объектов, которые необходимо раскрашивать разными цветами, но!.. Количество цветов, которые нам придется применить, будет соответствовать количеству видов, в данном случае фруктов. Итак, мы имеем:

1) Апельсины

2) Яблоки

3) Зеленый виноград

4) Красный виноград

5) Ваза

Данный пример подобран специально для этой статьи. Причины - яркость объектов, разница в окрасках и достаточно простая их геометрия. Зачем это необходимо, вы узнаете дальше.

В этой статье будет описано два способа окрашивания ч/б фотографий. Я не могу из них выбрать лучший, так как оба хороши для конкретных случаев, а чаще всего они сочетаются.

Начнем с самого распространенного и, на мой взгляд, простого приема.

Я понимаю, что найти эту же фотографию почти невозможно. Поэтому воспользуйтесь любой другой, которая состоит из нескольких объектов, несложных форм, отличных друг от друга и имеющих однородную поверхность. Проще всего цветную перевести в серые тона, это к тому же вам даст пример для сравнения. Наиболее же продвинутые читатели могут пойти по пути наименьшего сопротивления - во вторник вместе с печатной выходит и электронная версия газеты, где размещены и мои статьи. Оттуда вполне можно взять иллюстрацию для работы. Статья будет конкретно по этой фотографии.

Сразу стоит определиться, какой виноград у нас черный, а какой зеленый. Вам в этом плане задачу облегчает вторая и третья картинки - там виден мой выбор. Теперь можно приступать к окраске. Да, не забудьте перевести файл в формат RGB - "Изображение=> настройка=>RGB цвет".

Метод основан на описанной выше теории. Так как все, к примеру, апельсины одинаковы, будем использовать один цвет. На глаз определите его и поставьте основным. Затем нашим инструментом уже надолго станет все та же незаменимая кисточка. Начните закрашивать апельсин. Сразу заметно, что таким путем ничего не получится - вместо аппетитного фрукта мы получим банальный оранжевый круг. В чем причина? В том, что, добавляя каждому пикселю цветовую составляющую, мы теряли свето-теневую, так как полностью заменяли пиксели. Выхода из этого положения существует два, почти одинаковых. Первый - красить на отдельном слое, поставив его прозрачность на значение 30-40%. Многие, кстати, именно так и делают. Но я вам этого не рекомендую - этот способ очень нерациональный, и люди, пользующиеся им, просто не очень хорошо владеют PhotoShop. Создатели программы еще в четвертой (а может даже и в третьей) версии создали режим работы кисточки "цвет", который предназначен исключительно для нашей ситуации. Работает он просто - добавляет в каждый пиксель цветовую составляющую, не меняя свето-теневую (еще раз напомню, это деление на две составляющие чисто условное, примененное мной в этой статье для наглядности). Выбираем кисточку. Она обязательно должна быть твердой, иначе ничего не получится. Советую увеличить обрабатываемую часть на весь экран (Ctrl и + одновременно), иначе будет весьма нелегко ровно закрасить. Теперь щелкните левой клавишей мыши и выберите режим кисти "цвет". Начинаем закрашивать. Результат обычно не очень радует - не расстраивайтесь, под конец все будет смотреться значительно лучше. Закрасив один апельсин, примитесь за второй. Виноград и яблоки делаются абсолютно аналогично. Несколько сложнее с вазочкой - какого она должна быть цвета, только богу известно. Так что тут ответственность только на вашем художественном вкусе. Как правило, от вашего чувства цвета все и зависит - особенно при самом сложном проявлении нашей работы - закрашивании старой фотографии с людьми.

В принципе, больше ничего по первому способу объяснять не требуется. Все просто и понятно. Перейдем ко второму, на мой взгляд, значительно более продвинутому.

Вы заметили, что мы делали не совсем хорошо? Мы долго размазывали один и тот же цвет по достаточно большой поверхности. В данном случае эта работа абсолютно лишняя. В Adobe PhotoShop существует мощнейшая коллекция цветокорректирующих инструментов, которые способны решить в этом направлении любую проблему. Итак, для начала выделим апельсины. Наша задача сильно облегчена разницей в свето-теневых показателях соседних объектов. Так что можно использовать инструмент "магнитное лассо". Итак, выделим апельсин. Если эта операция получилась не очень хорошо, запомните, что выделение всегда можно изменить следующими способами:

1) "Выделить - преобразовать выделение". Очень полезный инструмент. Похож на "свободная трансформация", только работает не с изображением.

2) Использование любых инструментов выделения в сочетании с "Shift" - добавить выделение, "Ctrl" - убрать выделение.

Займемся окрашиванием. В качестве основного цвета выберите опять апельсиновый. Правда, можете не очень старательно его подбирать, сами вскоре поймете почему. Затем откроем наш основной инструмент на ближайшее время (кстати, обратите внимание - с цветокоррекцией так вплотную мы еще не работали). Это "изображение=>настройка=>цвет/ насыщение". Поставьте сразу галочку "цвет". Это значит, что на выделенную область (а если ее нет, то на все изображение) применится основная краска (мы уже установили ее апельсиновой). А далее все в ваших руках. Вы имеете три бегунка - "тон", "насыщенность", "легкость". Не буду объяснять их значение, там все интуитивно понятно. И вот, работая с этими бегунками, добивайтесь удовлетворительного результата. Аналогично операция повторяется для всех других объектов. Способ этот значительно лучше предыдущего тем, что сразу не всегда можно подобрать для объекта идеальный цвет. А так возможно очень быстро подобрать, изменяя три параметра, отличный вариант. Но сразу скажу, что применение второго способа ограничено очень большим количеством условий к исходному изображению, вместе с тем, работа с кисточкой хоть и утомительна, но подходит к большинству случаев.

Как окрасить фотографию из семейного альбома? Задача это непростая, но себя стоит - вашим близким будет приятно увидеть себя молодыми, во всей красе, то есть цвете :). К тому же сейчас напечатать обычную фотографию из файла проблемой не является.

Прежде всего оцените количество объектов. Не рекомендуется работать с групповыми фотографиями - работа будет непосильная. Лучше всего раскрашивать портретную фотографию, это не займет у вас очень много времени. Далее подумайте, под что вы будете стилизировать фотографию - под современную или под старую цветную. Разница существенная. Легче, конечно, работать под старое фото - цвета там контрастные, переходы резкие. В любом случае вам понадобится еще одна фотография для примера - на глаз цвет, к примеру, лица вы не воспроизведете. А далее работаем так - если лицо, то копируем отдельно глаза, нос, губы и так далее и работаем с ними дифференцировано. Если вы надеетесь раскрасить лицо по принципу апельсина, то вы большой оптимист. Лицо гораздо сложнее геометрически, к тому же кожа носа не точь-в-точь такая, как щек.

Гораздо легче с волосами и одеждой. Там просто берем и закрашиваем. Повторюсь, повозиться придется только с кожей.

Описанные нами приемы весьма просты, но между тем крайне важны. Когда вы сделаете закраску, покажите фотографию кому-нибудь и спросите, не видит ли он чего-нибудь необычного. Если ответ будет "нет", значит ваша работа вполне удалась. Хотя вряд ли она вам понравится - вы будете видеть мелкие недостатки, которые другие никогда не заметят. И это замечательно - значит вы человек творческий.
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	Повальное увлечение Web привело к тому, что за компьютерное рисование приходится приниматься простым смертным, в распоряжении которых нет ни навороченных профессиональных пакетов визуализации, ни навыков работы с ними.
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Однако многое можно сделать и обычными графическими средствами. И не боги горшки обжигают. При желании свою маленькую виртуальную реальность может создать каждый. Надо только немного подумать, попробовать и чуточку больше знать.

Кстати, о реальности. В природе нет идеально гладких ровно окрашенных поверхностей. Поверхность любого материала имеет свою фактуру, свой объем. Следовательно, свет ложится на нее неравномерно, есть тени и блики. Чтобы компьютерный рисунок приблизился к реальности, не теряя при этом, разумеется, своеобразного "виртуального" шарма, надо попробовать передать на плоскости эту игру света и теней.

Профессиональные пакеты трехмерной графики обладают мощными средствами наложения текстур на каркасные модели созданной в памяти компьютера сцены. Они позволяют расположить источники света, задать их характеристики и получить близкую к естественной картинку. Хочешь - трехмерную. Хочешь - плоскую.

Исходя же из того, что таких программ в нашем распоряжении нет, предлагаю посмотреть, как подобные вещи можно сделать в обычном графическом редакторе. Для примера давайте возьмем типовую задачу - нарисуем освещенную лампой стену из красного пористого кирпича. Сделаем это в Adobe Photoshop, как вы уже, наверное, догадались по картинкам. Этот редактор обладает богатыми средствами и инструментами рисования и служит образцом для создания других подобных программ, так что данный эксперимент будет полезен и тем, у кого Photoshop нет.

Итак, за дело. Первый шаг после того, как будет создан новый файл, заключается в подборе цвета для поверхности. Это не так просто, как может показаться на первый взгляд, так что рекомендую не ограничиваться палитрой быстрого выбора, а обратиться к окну точной настройки цвета Color Picker. Вызывается оно в Photoshop щелчком мышки по квадрату с текущим цветом в палитре инструментов. Подобрав подходящий оттенок, зальем им всю плоскость картинки, то есть ее единственный слой Brick Color. Если цвет был выбран для фона, нажимаем клавиши [Ctrl]+[Del], если же вы подобрали основной цвет, нажимайте [Alt]+[Del].

Полученная поверхность совсем не похожа на кирпичную. Ей, в первую очередь, не хватает фактуры. К счастью, рельеф вручную рисовать не придется, так как в 4-й версии Photoshop, которой я пользуюсь, в стандартном комплекте фильтров имеются средства текстурирования. Однако применять их в лоб не спешите. Не все так просто. Кирпич порист и шероховат. Он практически не бликует, так что текстура должна состоять практически только из теней.
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Создаем новый пустой слой Brick Relief и закрашиваем его белым, чтобы можно было применить стандартный фильтр редактора Photoshop. Фильтр этот вызывается через меню Filter/Texture/Texturizer. В его окне можно выбрать тип поверхности, но кирпича там нет. Подбирая что-нибудь похожее, я остановился на песчанике (Sandstone). Манипулируя регулировками масштаба (Scaling) и глубины (Relief) рельефа, задаем подходящую для кирпича по грубости фактуру поверхности. Перед применением данного фильтра не забудьте проверить направление света. Оно определяется композицией. Для примера предположим, что свет падает сверху и слева (Top Left). 

 

То, что видно на экране, сейчас больше всего походит на цементную стену или на штукатурку. Это белая шершавая поверхность с серыми тенями. Поэтому для получения должного эффекта придется воспользоваться режимом наложения слоев не Normal, а Multiply (умножение). При умножении цвета слоев "перемножаются", причем результат получается всегда более темным или оптически плотным. Для нас самое главное, что белый цвет из накладываемого слоя при умножении игнорируется, а черный остается. В результате поверхность кирпича будет лишена бликов, то есть станет матовой. Переключается режим наложения в палитре слоев.

Ну вот, глина уже есть. Теперь ее надо "нарезать" на кирпичи. Для прослойки раствора, необходимого атрибута любой кирпичной кладки, включая виртуальную, создадим еще один слой - Cement. На этом слое надо провести жирные черные линии, наметив ими рисунок кирпичной стены. Толщина линий зависит от размера и разрешения картинки, но в любом случае она должна быть больше, чем вам показалось на первый взгляд. Тут проникаешься преимуществами работы со слоями - ничто не мешает перерисовать сетку заново, не трогая уже удавшуюся часть изображения.
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Геометрическая строгость линий, равно как и чрезмерная четкость краев, в жизни не встречается. Поэтому нам надо сделать линии кладки расплывчатыми. Воспользуемся фильтром Gaussian Blur, радиус размывания в котором и определит вид граней наших "виртуальных" кирпичей. Я воспользовался радиусом в 4 пиксела. 

 

Теперь предстоит одним выстрелом убить двух зайцев - окрасить цемент в его родной серый цвет и заодно придать картинке объем. Это поможет сделать фильтр Filter/Stylize/Emboss. В нем три настройки. Первая задает угол, под которым падает свет на картинку. По нашим "вводным" свет падает сверху слева. Чтобы полоски получились утопленными, установим угол в -45 градусов. Следующий параметр - Height (высота) - определяет высоту краев, и его величина зависит от разрешения и размеров картинки. Поставим 4 пиксела. Третья регулировка - Amount. Она также определяет глубину эффекта объемности.

Чтобы цемент не выглядел как оконная замазка, его поверхности надо придать фактуру. Тут снова пригодится фильтр Texturizer с режимом Sandstone. Однако на этот раз нам не потребуется имитировать матовую пористую поверхность кирпича, так что обойдемся без дополнительного слоя, применив его сразу к Cement. Рельеф зададим меньший, чем выбрали для кирпича, руководствуясь при этом школьными наблюдениями за природой, когда перекуривали за школой в уголке, созерцая кирпичный забор. Я поставил масштаб 80% вместо 100% для кирпича и рельеф 10 вместо 20. Не переборщите, так как сейчас вы изменяете и цвет цементного раствора, а он должен оставаться светлым, если стенке, конечно, еще не сто лет.

Чтобы кладка выглядела еще объемнее и красивее, по оси цементной прослойки изобразим выпуклость. Для этого надо создать еще один слой - Cement Center и провести на нем по оси линий кладки черные линии. Они должны быть раза в три-четыре тоньше, чем мы рисовали в прошлый раз. В нашем примере толщина этих линий получилась 4 пиксела, тогда как в прошлый раз я рисовал линии по 16 пикселов.

Далее повторяем те же действия, что и для основных линий кладки, только в фильтрах Gaussian Blur и Emboss устанавливаем другие параметры. Размывание должно быть примерно вдвое меньшим, как и высота выпуклости. Чтобы у нас получилась именно выпуклость, а не канавка, в фильтре Emboss в соответствии с принятым направлением света поменяем угол на противоположный, то есть поставим 135 градусов. Уменьшим этак на треть и глубину тени Amount. Последним в цепочке действий следует применение фильтра Texturizer, значения в котором менять не стоит, так как зернистость-то раствора та же.
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Ну вот, стенка из красного кирпича практически готова. Она выглядит в духе современной компьютерной виртуальной реальности, то есть заметно искусственно, но в то же время довольно похожа на натуральную кирпичную кладку. Чтобы усилить эффект реальности, следует разобраться с общим освещением в картинке. 

 

Собственно, с этого вопроса следовало начинать, но я тогда оговорил всего один источник света типа электрической лампочки, расположенной недалеко от стены слева вверху. Вы можете в своих композициях применить больше фантазии. Чтобы при этом обойтись малой кровью, изучите возможности фильтра Lightning Effects, находящегося в меню Filter/Render, особенно заложенные в него стандартные установки.

Этот фильтр обладает богатыми возможностями имитации искусственного освещения. В принципе, с его помощью можно создать эффект и естественного дневного света, но не всегда. А вот разного рода лампы и прожекторы - сколько хочешь и какие хочешь. Можно управлять цветом источника, его положением, углом рассеяния и т.п. и т.д. Но чтобы разобраться в настройках было легче, начинайте работу с ним с просмотра предварительных вариантов настроек, коих множество. И уже выбрав один из них, попробуйте подвигать туда-сюда регуляторы и поиграть с цветом лампы.

Перед применением фильтра нам придется распрощаться со слоенностью изображения, применив к нему команду Flatten Image из меню палитры слоев. Но перед объединением слоев стоит сохранить картинку в формате Photoshop на тот случай, если придется менять что-то в самой кладке. Когда слои будут слиты в один, подправить там ничего не удастся. Или по крайней мере сделать это будет чертовски трудно.

Накладывая на картинку освещение, обратите внимание на угол, под которым падает свет. Он должен совпадать (или быть близким) к тому значению, которое применялось в фильтре Emboss. Несовпадение может привести к потрясающему результату, когда впадины рельефа станут восприниматься как выпуклости. Так что этот вопрос стоит продумать заранее и держать под контролем.

Не знаю как вам, а мне итоговая картинка понравилась. Правда, в черно-белом газетном варианте вы не видите и половины эффекта объемности кирпичной стены. Беду можно исправить, обратившись к Web-версии "КГ", где, понятно, картинки выставлены в цвете.

Не могу обойтись и без резюме. Хотелось бы, чтобы предложенный пример не воспринимался вами как нечто уникальное в своем роде. Конечно, он носит вполне законченный характер и может быть использован на практике, но для меня важнее было показать вариант создания в обычном графическом редакторе объема, то есть рисования выпуклостей и впадин, а также придания неживой идеальной компьютерной поверхности фактуры и рельефа, близких к натуральным.

Как видите, при наличии некоторой фантазии и опыта справиться с этим позволяют обычные фильтры редактора. Причем делается все достаточно быстро и без сложностей, которые всегда провоцируют на ошибки.
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	Почти все предыдущие статьи были посвящены реализации спецэффектов, сегодня же я хотела бы рассказать еще об одной возможности PhotoShop - о создании текстур. Несмотря на то, что поначалу это кажется весьма бесполезным, в итоге оказывается очень важной частью работы. Особенно это касается тех, кто работает с Web-графикой, создает объявления и плакаты. К тому же вы сможете применить созданные вами текстуры в шрифтах, рамках, а также в качестве фона к вашему изображению. В принципе, существуют специальные фильтры, имитирующие те либо иные материалы, также вы можете воспользоваться уже готовыми изображениями, а в PhotoShop 6.0 некоторые аспекты данной проблемы решены при помощи встроенных функций. Однако тем, кто не хочет устанавливать кучу дополнительных фильтров, чтобы единожды ими воспользоваться, не имеет желания пересматривать сотни картинок в поисках подходящего изображения, и будет полезна данная и последующая статьи.
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Создание текстуры "кирпичи"

Итак, начнем мы с создания простой кирпичной стены. Для начала создайте новое изображение необходимого вам размера (Сочетание клавиш "Ctrl+N", либо Файл - Создать).

Подберите цвет для вашей будущей стены. Я выбрала красный, но не забывайте, что кирпич бывает и белый, а если вы пожелаете, то может стать синим, зеленым, желтым или любого другого цвета. После того как выбор цвета был сделан, залейте весь формат данным цветом при помощи инструмента "Заливка" (Клавиша, позволяющая выбрать данный инструмент с клавиатуры, - К).

Так как кирпичная стена не имеет идеально гладкую поверхность, то нам необходимо наложить на цвет фона какую-либо фактуру. С этим проблем не возникнет, потому что в стандартном наборе фильтров для PhotoShop данный вопрос решен. Осталось определиться с выбором необходимого фильтра. Если посмотреть на реальную кирпичную стену, то можно заметить, что она имеет матовую поверхность и легкую шероховатость. Следовательно, фильтр не должен добавлять на ваш фон яркие световые пятна, а также имитировать не крупные, а мелкие структурные единицы. На приведенной иллюстрации я воспользовалась фильтром из раздела текстур "Текстуризация". Для достижения большей реалистичности вам необходимо создать новый слой (Щелкните по иконке, изображающей белый лист внизу палитры слоев), залейте данный слой белым цветом, после чего можете приступать к непосредственной работе над структурой. После того как вы откроете диалоговое окно данной опции, вы можете выбрать подходящую текстуру из списка, предлагаю отдать предпочтение "Песку". Масштаб, величина и направление света остается на ваше усмотрение. Сейчас вы можете видеть изображение белого цвета. Для того чтобы вернуть ему первоначальный цвет, вам необходимо заменить в настройках нового слоя опцию Normal на Multiply. В результате данного преобразования цвета ваших двух слоев перемножатся. При перемножении белый цвет игнорируется, а черный остается, вследствие чего светлых бликов на вашей стене не будет, а поверхность получится матовой.

Теперь приступим к созданию цементных полос, отделяющих кирпичи друг от друга. Для этого создайте еще один слой. На нем нанесите при помощи инструмента "линия" (клавиша N) довольно толстые линии черного цвета. После чего примените к ним фильтр "Гаусс-размытие" из раздела "Размыть". Это необходимо для того, чтобы придать вашим полосам более неправильную и нечетко выраженную форму. Параметр силы установите примерно на 3-4. Теперь необходимо слегка осветлить цемент, так как в природе он имеет серый цвет, и придать ему немного объема. Совместим эти две задачи в одну и решим их при помощи фильтра "Рельеф" из раздела "Текстуризация". Параметры необходимо устанавливать исходя из желаемого результата. Я установила направление света из верхнего левого угла (-45 градусов), высоту - 4 пикселя, а итоговую величину взяла максимальную - 500 процентов. Для того чтобы создать имитацию шероховатости цемента, вы вновь можете воспользоваться фильтром "Текстуризация", однако не надо применять его на новом слое и переводить его в режим умножения.

Если вам кажется, что цементным линиям не хватает объема (чаще всего это встречается при работе с большими изображениями), то вам необходимо создать еще один слой. На нем повторите все те же операции, которые проводились с первым "цементным" слоем, но толщину линий установите раза в 3-4 меньше, размывать так сильно тоже не стоит, а при создании рельефа используйте противоположное данному направление света (а именно 135 градусов).

Вообще, в шестой версии программы есть встроенный экшин, позволяющий рисовать кирпичи, но делает он это не просто убого, а сверхубого. Ни одного дополнительного фильтра, реализующего эту же задачу, я припомнить не могу, так что описанный способ можно считать единственным.

Как писать в Adobe Photoshop по-русски

Вообще-то, в мои планы не входило писать про это, но большое количество писем от читателей говорит о том, что в широких массах это проблема номер один. Для ее решения существует несколько (я знаю пять) способов решения. Предложу вам два, наиболее приемлемых и удобоваримых во всех отношениях.

Способ первый - терапевтический

1. Запустите редактор реестра (например, в директории Windows запустите Regedit.exe или в основном меню выберите "выполнить" и наберите "regedit");

2. Откройте HKEY_LOCAL_MA-CHINESYSTEMCurrentControlSetControlNlsCodePage;

3. Теперь измените значение 1252:

для Windows NT "C_1251.NLS"

для Windows 95/98 "cp_1251.nls".

4. И обязательно перезагрузите компьютер. А то многие не перегружают и плачут, что не работает гадкая программа как надо.

Если вы все сделали правильно, то должно заработать.

Способ второй - хирургический

Я предпочитаю именно его, так как решаются еще некоторые проблемы, свойственные работе в NT. Но это к теме отношения не имеет. Итак, способ этот прост, как устройство кувалды. Шрифты у вас в системе изначально не кириллистические, поэтому их просто надо заменить на русские. Для этого покупаем диск со шрифтами (или тащим из сети), удаляем из системы старые шрифты и ставим новые (для тех, кто не знает - при помощи "шрифты" из панели управления). Результат стопроцентный, и кроме того, вы будете иметь много интересных шрифтов для нестандартных дизайнерских решений.

Eye Candy 4.0 - новый друг лучше старых двух

Сегодня та часть нашей статьи, которая уже традиционно посвящается дополнительным плагинам для Adobe PhotoShop, будет рассказывать про, несомненно, лучшего представителя своего жанра - программу Eye Сandy 4.0. Как, наверное, помнят постоянные читатели, я уже писала про предыдущую версию этой программы. Теперь, когда вышла полная версия 4.0, было бы просто недопустимо не посвятить этому вопросу время. К тому же совсем недавно Eye Сandy 4.0 был признан лучшим дополнительным плагином года, разделив премию с KPT 6.0. Сегодня я напишу про Eye Candy, а в ближайшее время развернуто рассмотрю KPT.

Первое впечатление - работники Alien Skin совершенно не напрасно кушают свой хлеб. Программа явно удалась и в моих глазах несомненно является сейчас самым полезным набором для пользователя из всех ныне существующих. Интерфейс практически не изменился, да это и не нужно - он и раньше был крайне удачным и не требующим никаких особых доработок. Все фильтры выросли в том плане, что стали гораздо эффектней выглядеть - как правило, значительно более реалистично. Добавилось несколько новых, несомненно, очень и очень полезных эффектов - о них немного ниже.

Antimatter - как вы, может быть, помните, я назвала этот фильтр самым бесполезным и примитивным в наборе Eye Candy 3.0. И это действительно было так - фильтр этот напоминал самые первые уроки начинающего программиста - просто напросто переворачивал показатели RGB для каждого пикселя, то есть изменял значение яркости для каждого канала (основной показатель в RGB) и тем самым добивался эффекта фантастичности. Сейчас же фильтр этот стал весьма и весьма приличным и очень усложнился.

Теперь он уже имеет два показателя, которые можно изменять, перевернуть яркость и изменить насыщенность. Причем в процентах! На мой личный взгляд, просто супер. Чего не ожидала, того не ожидала. Как это работает? Примерно так. Возьмем синий канал (для простоты - в полной RGB модели все значительно сложней). Представим, что его значение яркости равно 37 (полный диапазон яркости от 1 до 255). Если значение бегунка будет стоять на 40, то после применения этого фильтра оно изменится до 198. Все просто до гениальности.

Bevel Boss - как я поняла, это сильно доработанный Carve из прошлой версии. Абсолютно ответственно могу сказать, что это самый лучший фильтр для создания выпуклых поверхностей из всех мною когда-либо виденных.

Действительно, босс среди своих собратьев. Куча параметром, большинство из которых были и в carve, но есть и новые, в том числе и революционно новые. Особенно хочу отметить возможность выбирать, куда должно быть направлено действие - в текстуру или наружу.

Интересна возможность создания многоцветных (два цвета на одной поверхности) светов и теней. Кроме того, вы найдете множество готовых настроек, которые удовлетворят почти все потребности. Идеально этот фильтр подходит для создания кнопок и прочей выпуклой мелочи.

Crome - не очень полезный фильтр, но сейчас можно хоть иногда использовать. У меня получалось реалистично превращать любую поверхность в металл. Весьма неплохо этот фильтр заменяет PhotoGroove из наборчика PhotoTools. Очень быстро можно создать красивую рамку к изображению. В общем, ничего особенного, но симпатично.

Corona - новый фильтр в наборе. Создает внешнее свечение вокруг объекта, причем не простое свечение, а очень интересное, больше всего мне это напоминает солнечную корону (возможно, от этого и пошло название фильтра). Настроек более чем достаточно, особенно помогает кнопка Random. Она есть почти во всех фильтрах и меняет случайным образом вид. Этот плагин идеально подходит для прорисовки планет, звезд, метеоритов и так далее.

Cutout - полезный фильтр. Можно выполнять две операции - рисовать несложные, но между тем реалистичные тени и создавать псевдотрехмерные фигуры. Мне он импонирует именно в последнем плане - попробуйте создать в нем шарик, используя эллиптическое выделение. Я думаю, вас это впечатлит. Неплохо реализуется и эффект уходящего изображения.

Drip - новый фильтр, наверное, самый интересный для любителей из всех новых. Позволяет создавать капающую жидкость - как будто стекает что-то с вашего изображения или ваше изображение (это уже выбирает пользователь с помощью настроек). Скажу по секрету, кровь получается ну просто отличнейшая по реалистичности. Так что господа, любящие различные кровавые сцены, - вперед, вам это явно понравится. Мне очень импонирует, как в этом фильтре проработана освещенность - действительно, все, что надо, на месте.

Fire - самый любимый массами фильтр. Огонь. Как он сейчас выглядит! Раньше тоже не жаловались, но сейчас это просто верх мечтаний по реалистичности.

В нем просто чувствуется объем. Из настроек стоит сказать про самое основное усовершенствование - теперь можно задать направление огня, просто поворачивая кнопку по кругу. Это очень и очень удобно - раньше приходилось много страдать, пока огонь пойдет как надо. Теперь же - одно движение руки. Значительно усложнился и усовершенствовался механизм создания собственных настроек - теперь он больше всего напоминает работу с градиентами в PhotoShop.

Fur - в настройках почти ничего не изменилось. Но фильтр явно значительно улучшился - хотя бы в том плане, что теперь просто рисовать всякие волосатые предметы. Я, к примеру, за несколько минут нарисовала забавную шерстяную овечку.

Glass - стекло. В плане настроек почти ничего не изменилось, однако изменилось кое-что другое. Результат. Раньше если и оставались сомнения в том, стеклянное ли получившееся изображение или нет, то теперь их не останется однозначно - очень реалистично.

Gradient Glow - внешнее свечение. Красивый, полезный и простой эффект. Появилась возможность делать это свечение непосредственно градиентным, что открывает перед пользователями огромные возможности - эффект неоновой вывески займет всего несколько секунд.

HSB Noise - как был, так и остался, просто очень навернутый шум.

Jiggle - великолепный искривляющий фильтр. Сильно доработан. Очень много возможностей, которые описывать нет возможности - это просто надо видеть. К примеру, с помощью этого фильтра легко имитировать горную породу.

Marble - непосредственно мрамор. Новый фильтр. Очень реалистично, все необходимое.

Melt - тоже новый плагин в наборе. Чем-то напоминает Drip, но там стекают только капли, здесь же течет все изображение, как будто оно сделано из какой-то вязкой массы, вроде геля. Эффект интересный, но, на мой взгляд, еще мало проработанный.

Motion trail - ничего нового, только естественней.

Shadowlab - все для тени. Очень навернутый инструмент, даже описывать неохота, - в общем, за тенью туда.

Smoke - все, что можно сказать про огонь, можно сказать и про дым. Тот же объем, та же возможность задать направление, куча настроек и готовых вариантов. Дымите, господа, на здоровье!

Squint - единственный фильтр, в котором не доработали ничего.

Water Drops - водяные капли. Гораздо больше, чем в прошлой версии, эти самые капли напоминает. Улучшена освещенность, и самое главное, - создатели поняли, что не все капли имеют правильную форму.

Weave - плетение из соломки стало куда более реалистичным, вот и все.

Wood - фильтр, позволяющий создавать текстуру дерево. Очень реалистично, особенно мне нравится возможность рисовать сучки (точнее, те места, где они были).

Вот и все. Стащить этот плагин можно с http://fasi.da.ru или официального сайта компании Alien Skin. Весит он немного, меньше мегабайта, поэтому это не займет у вас много времени и денег.
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	Эта статья, в противовес нескольким предыдущим, будет полностью посвящена тексту, точнее, не конкретно тексту, а способам его преобразования. Как, наверное, помнят наши постоянные читатели, эта тема уже затрагивалась в этой серии статей. Шрифты и работа с ними - это одна из наиболее часто используемых возможностей PhotoShop в массах (особенно если учесть просто-таки нездоровое увлечение народа Web-дизайном). Достаточно часто приходится применять именно некоторое приукрашивание текста, принцип здесь прост - одновременно совместить визуальную эффектность и информативность (читаемость). За примером далеко ходить не надо - посмотрите первую страницу этой газеты, точнее, название. На мой взгляд, очень хорошее решение, грамотное и приятное. Кстати, в PhotoShop 5.5 реализуется за несколько минут очень простыми действиями.
Но сразу хочется предупредить - будьте очень осторожны с эффектами над текстом, особенно при создании сайтов. Сделать хороший дизайн вообще без картинок тяжело, с минимумом картинок очень тяжело, а с множеством - почти нереально. Сайты, выдержанные в преимущественно графическом стиле и при этом приятные визуально, можно пересчитать по пальцам, на мое личное мнение, конечно. Но все же грамотно примененные графические изображения украшают странички и, стоит сказать, упрощают работу создателю.

Традиция украшать шрифт уходит своими корнями в глубокую древность. Заглавные буквы рукописей средневековья сами по себе представляют художественную ценность, сочетая в себе орнаментальную роспись с элементами миниатюрной живописи. Это было связано с редкостью и необыкновенной стоимостью книг, так что каждый экземпляр являлся неповторимым. С приходом печатного станка эта традиция несколько утратилась, хотя еще долгое время заглавные буквы печатались со множеством украшающих элементов. С возрастанием числа образованных людей в Европе украшение надписей приобрело другой смысл - рекламы. Теперь, если и было написано, к примеру, "Трактир", то непременно надпись была обрисована колбасами, дичью и кружками с пивом:). Как можно заметить, за последние лет 400 почти ничего не изменилось. В ХХ веке вернулась традиция средневековья - украшать непосредственно сам шрифт. Это было связано с появившейся возможностью массовой печати в цвете, да и вообще с развитием полиграфии. Но наибольшего распространения непосредственная обработка шрифтов достигла только несколько лет назад, с переводом всего издательского дела на электронные рельсы и Интернет. Именно о преобразовании самих шрифтов, а не области вокруг них, и пойдет сегодня речь.

Сейчас мы поговорим об имитации снега в Adobe PhotoShop. Зима на носу, там Новый год, так что актуальность этой темы повышается:). В принципе, этот эффект применим по отношению к любому изображению, но мы будем рассматривать его в контексте со шрифтами. В который раз скажу, что все эти эффекты уже реализованы в дополнительных плагинах к программе PhotoShop, однако не все имеют возможность (да и, как правило, необходимость) их достать. Для особо продвинутых в этой сфере скажу, что фильтр такой есть на www.webutilites.com.

Снег
Для начала создайте новое изображение (примерно 300 на 300 пикселей). Слишком большое создавать не стоит, так как тогда сделать хоть что-то правдоподобное будет нереально (в этом вы убедитесь позднее). В качестве фона я рекомендую взять либо зимний пейзаж, либо просто голубой фон (цвет наиболее "зимний"). Затем напишите слово "КГ". Еще раз напомню, что добиться от PhotoShop умения писать по-русски можно несколькими способами, лучший из которых - заменить шрифты системы на непосредственно русские. Тогда вы не будете иметь этих проблем и в ряде других программ.

Теперь займемся непосредственно созданием снега. Возьмем кисть с мягкими краями (некоторые предпочитают аэрограф) и вручную нанесем белую краску в местах, где по логике должен был бы скопиться снег, если бы он падал на надпись. Для ориентации посмотрите на иллюстрацию, хотя тут процесс сугубо творческий и индивидуальный. Не старайтесь сделать слишком много - не будет смотреться.
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После того, как вы создали заготовку для будущего снега, начнем придавать ему реалистичный вид. Воспользуемся инструментом "палец". Внимание! Впервые в этой серии статей упоминается этот, не побоюсь громкого слова, замечательнейший инструмент. Возможности, которые он предоставляет, просто не поддаются описанию. Запомните "палец", вы еще не раз помянете его добрым словом. Действие данного инструмента похоже на эффект размазывания пальцем сырой краски. Итак, возьмите и смажьте края снега так, как будто он под своей тяжестью стал сползать. Если у вас упорно не получается, измените параметры "пальца", они интуитивно понятны любому пользователю.

Следующий этап связан с предыдущим инструментом, при помощи которого производятся преобразования изображения. Мы будем имитировать наплывы снега. Подобный эффект можно наблюдать во время оттепели, когда подтаявший снег сползает, образуя своеобразные формы. Создаются они просто - тем же самым "пальцем" смазывайте снег в вертикальном направлении. Сразу стоит предупредить - делайте это аккуратно, так как палец - инструмент не слишком тонкий в работе. Места, где снег сполз неубедительно, исправьте при помощью кисти.

Но все же пока картинка производит впечатление не очень зимнее. Причина тому - снег, вещество не гладкое, состоящее из множества гранул. Это и необходимо нам сейчас передать. Решение приходит само собой - стандартный фильтр "шум" (кстати, на первый взгляд он кажется начинающему пользователю абсолютно бесполезным, но на самом деле применяется очень и очень часто). При использовании этого фильтра на все изображение накладывается эффект зернистости и создается иллюзия фактуры. Итак, добавьте шум, количество определите визуально (фильтр не применяется на неотрисованный слой). Величина указывает диапазон оттенков, на который новый цвет пикселя может отличаться от первоначального. Например, если вы указали значение равное 20 и работаете в цветовой модели RGB, то новый цвет может отличаться от исходного на 20 оттенков по красному, зеленому и синему каналам. Если значение превышает 255, то программа будет выбирать любые цвета из 16-миллионной палитры. Чем больше будет сила, тем больше вероятность того, что близлежащие пиксели будут окрашены в цвета с противоположных концов гаммы. Данный параметр влияет только на цвет, а не на яркость изображения.

Последние штрихи подведите следующим образом. Примените фильтр "размытие" несколько раз, пока результат вас не удовлетворит. При использовании данного фильтра создается впечатление смешивания цветов, как будто на изображение разлили воду и от этого все фигуры несколько расплылись.

Пишем водой
Еще один весьма интересный эффект, выглядящий впечатляюще, но реализуемый без особого труда - это надпись, представленная в виде водяных образований.

Начните создание своего изображения с создания нового формата в одном из цветовых режимов, таких как RGB, CMYK, Lab. Выбор режима обусловлен конечным пунктом назначения вашего творения. Зайдите в палитру каналов и создайте новый, щелкнув по иконке, изображающей чистый лист, либо нажмите левую клавишу мыши, указав на маленький черный треугольник, расположенный в верхнем правом углу, и из раскрывшегося меню выберите "Новый канал".
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Установите цвет переднего плана на белый, убедитесь, что находитесь на только что созданном вами канале и при помощи инструмента "текст" напишите желаемую надпись. Если вы недовольны размером шрифта либо его местоположением, то нажмите сочетание клавиш Ctrl+T и исправьте все недостатки. (Процесс создания надписи, расположенной по кривой линии, описывался в КГ N№31 от 2000 года). Для того чтобы вы могли продолжать работу с текстом, его необходимо отрисовать. Для этого щелкните правой клавишею мыши по букве "Т", расположенной на слое с текстом, и выберите из раскрывшегося меню пункт "рендеринг слоя". При помощи инструмента кисть (горячая клавиша В) добавьте несколько капель вокруг надписи. Это действие не обязательно, но желательно.

Создайте копию вашего канала, перетащив его к эмблеме нового, удерживая левую клавишу мыши. Теперь придайте буквам объем. Для этого примените фильтр "Набросок ->Замазка" из стандартного набора фильтров для PhotoShop. Я использовала следующие настройки: Баланс - 22, смягчение - 2, направление - сверху.

Перейдите в палитру слоев и создайте новый. (Слой - Создать - Слой, либо сочетание клавиш Ctrl+Shift+N). Теперь вам необходимо загрузить выделение с созданного вами канала. Для этого вы можете проделать следующие операции: Выделение - Загрузить область, и в раскрывшемся меню указать название второго созданного вами канала. 

Выберите цвет, которым должна быть написана ваша надпись, и установите его как цвет переднего плана, после чего зайдите в меню "Редактировать" и выберите там "Выполнить заливку".

В палитре инструментов возьмите "волшебную палочку" (клавиша, позволяющая выбирать данный инструмент с клавиатуры, - W). Допуск установите равный порядка 32, а в палитре слоев поставьте флажок в графе "сохранить прозрачность". Данный инструмент позволяет выделить сплошную область одинаково окрашенных пикселей, щелкнув внутри нее. Величина допуска указывает на количество оттенков, на которые расширится ваше выделение. Сейчас кликните по изображению в любом пустом месте. В результате должно выделиться все кроме надписи. Преобразуйте выделение при помощи функции "Подобные оттенки", которая находится в меню "Выделение", и расширьте полученную область на 1-2 пикселя (Выделение - Изменить - Расширить). Инвертируйте выделение для того, чтобы выделенным оказался текст (Ctrl+Shift+I, либо Выделение - Инвертировать).

Далее сделайте слой маску (Выделение - Сохранить область). Перейдите в меню каналов и выберите там второй созданный вами канал. Для того чтобы вода приобрела более четкие границы, вы можете применить фильтр "контурная резкость". Для придания еще большего объема вашей надписи воспользуйтесь эффектом слоя "отбросить тень". Если вы используете данные эффекты, то впоследствии могут возникнуть проблемы с форматом, в котором вы захотите сохранить ваше изображение. Самый простой способ решить их - это сохранить файл как копию.

И напоследок хочется вам предложить еще один эффектный способ преобразования обычной надписи в текст, исполненный в виде молнии, либо лазерного сияния.

Лазерная надпись
Для начала создайте новое изображение с белым фоном. Напишите на нем текст черным цветом. Отрисуйте полученный слой. Примените к полученному изображению фильтр "Пластик" из раздела "Художественный". Благодаря этому фильтру буквы становятся несколько объемнее и на них появляются слабо выраженные грани, представленные в виде более светлых полос. На опубликованном изображении настройки данного фильтра были следующие: подсветка 16, детали 8, мягкость 10.

На следующем этапе необходимо появившиеся светлые полосы сделать более контрастными по отношению к темному цвету самой буквы. Я рекомендую использовать для этих целей кривые (Изображение - Настройки - Кривые, либо сочетание клавиш Ctrl+M). Поэкспериментируйте с настройками, но не забывайте, что на горизонтальной шкале указывается входящий цвет, а на вертикальной - выходящий. Зная это несложное правило, вы довольно быстро добьетесь желаемого результата.
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Сейчас необходимо придать цвет вашему сиянию. Предлагаю сделать это следующим образом: Изображение - Настройка - Выборочный цвет. На приведенном вашему вниманию изображении цвет был установлен в соответствии с такими настройками: Голубой - +82, Фиолетовый - +1, Желтый - -89, Черный - 0. Вы можете выбрать любой другой цвет, а также любой другой способ его реализации в данном изображении. На мой взгляд, предложенный способ один из наиболее простых и рациональных, хотя существует еще не менее 10 других.

Выделите ваш текст и создайте новый слой через копирование, щелкнув правой клавишею мыши по слою, на котором расположен фон. Первый слой закрасьте черным цветом.

Для придания большей выразительности вашему тексту вы можете воспользоваться одним из эффектов в разделе "Слои". Я применила эффект "Внешнее свечение", цвет которого установила темно-синий.

На этом позвольте остановиться. Конечно, в этой серии описаны далеко не все возможности работы со шрифтами (хотя бы потому, что все описать невозможно). Я сознательно ухожу от очень банальных примеров, однако если читательская аудитория заинтересована в описании азов, то сообщите об этом на мой e-mail либо на e-mail редакции. Если у вас есть вопросы, также напишите, постараюсь ответить на все (кроме неоправданной критики) вам лично либо в последующих статьях.

	Трюки и спецэффекты в Photoshop 5.5 (часть 13)
2002-08-15


	Автор: Галина Корабельникова 


	Страницы: [1] 

	
	Комментарии [0] 

	


	Эта статья будет посвящена анимации, реализуемой при помощи PhotoShop. Вопрос этот не настолько простой, как может показаться сначала, поэтому, вопреки уже сложившейся в этой серии статей традиции, уделим повышенное внимание теоретическим вопросам.
Иллюзия движения, достигаемая стремительной сменой изображений на экране, называется анимацией. Любая компьютерная анимация выполняется обычно следующим образом: вносятся изменения в изображение на экране со скоростью, достаточной для того, чтобы последовательно сменяющиеся изображения казались движущейся картинкой. По научным данным, для того, чтобы успеть увидеть и осознать содержание изображения, человеческому мозгу необходимо не менее четверти секунды. Когда вы смотрите фильм в кинотеатре, вы видите 24 различных изображений, или кадров каждую секунду. Следовательно, каждый кадр показывается в течение 1/24 секунды. Ваш ум не успевает осознать отдельно взятый кадр, но он воспринимает движущуюся картинку. Компьютерная анимация работает по тем же принципам. Однако, важное отличие состоит в том, что далеко не везде есть возможность использовать 24 кадра в секунду, да и вряд ли есть в этом необходимость, особенно в нашем случае.

В основе создания анимации при помощи PhotoShop лежит формат gif89a (compuserve gif). Появился он в 1989 году как способ увеличить скорость передачи графических изображений в сетях compuserve. Его можно считать одним из самых удачных графических форматов. Основная причина тому - небольшие занимаемые размеры, правда, из этого вытекает и недостаток - максимум вы можете использовать 256 цветов, много это или мало - решайте сами. Так вот, после создания, gif прожил несколько лет просто форматом для хранения картинок, пока один программист (не пинайте ногами, никак не могу вспомнить его фамилию) не обнаружил в нем скрытую возможность - сохранять в одном файле несколько изображений, которые при вызове файла сменяют друг друга с заданным интервалом. Это его открытие первоначально всех удивило, потом на некоторое время об этом забыли (не было коммерческой надобности), но пришел год этак девяносто пятый, а вместе с ним тотальное развитие Интернета. Наступает золотое время формата gif. Правда, создание страничек, прежде всего, ограничено одним условием - размеры продукта. Не имеет смысла создавать такие документы, загрузка которых займет большое время - пользователь просто-напросто уйдет на другой ресурс. Поэтому существует два графических формата, действительно распространенных во всемирной паутине - gif и jpeg. Сравнение и советы, где их применять, оставим для авторов, пишущих про web-дизайн. Нас интересуют только анимационные возможности gif.

Рассуждая о вопросе "как?", стоит прежде всего задуматься над вопросом "зачем?", ибо он даст нам ответ и на первый. Действительно, зачем? Даже упорно подумав, я не вижу ни одной области применения данного вида анимаций, кроме Интернет. Но зато в сети данный продукт имеет небольшие размеры файлов и относительно приличный вид. Кроме того, не стоит пренебрегать возможностью делать часть изображения прозрачной. То есть, делаем вывод - если и создавать gif-анимацию, то исключительно для Интернет. Из этого следует, что каждый файл должен быть небольшим по размеру. Учтите, что каждый ваш кадр со своей массой суммируется к общей массе файла. Поэтому никак применять 24 кадра в секунду не стоит. В основном идет 1-2 смены в секунду, иногда один кадр не меняется очень долго (к счастью, есть возможность задать, сколько та или иная часть анимации должна быть видимой, по своему усмотрению). Второе - длинные анимации по времени применить также не получится. Поэтому сюжет должен быть в той или иной степени зациклен (идеальный пример - развевающийся по ветру флаг). Однако, не везде это применимо (баннерная реклама, как правило, не зациклена с точки зрения сюжета). Однако, прежде чем приступить непосредственно к описанию процесса создания анимации, стоит сделать несколько замечаний. По своей идее, анимация должна украшать сайты, улучшать их дизайн. Однако, как правило, это имеет обратный эффект. Практически никто не может сделать хороший дизайн с анимацией, не говоря уже о том, что она не везде полезна, а в некоторых случаях даже вредна (например, деловые сайты). Я не смогу назвать и двух десятков ресурсов, приятных визуально, профессионально сделанных и с анимированными gif-ами на своих страницах. Однако, совсем отказываться от этой возможности тоже не стоит.

Разумеется, сам PhotoShop 5.5 анимационные файлы не создает. Пока. В шестой версии этого тоже не предусмотрено, но, надеюсь, в седьмой все эти вопросы будут проработаны. Однако мы и сейчас имеем мощнейший инструмент, специально созданный для этой операции. Что это? А это поставляемый в комплекте с PhotoShop 5.5 ImageReady 2.0. Я действительно считаю эту программу лучшей в области адаптации графики под всемирную сеть, gif анимации и некоторых других задач. Она великолепно дополняет PhotoShop благодаря своей теснейшей с ним интеграции.

Прежде, чем приступить непосредственно к анимации, необходимо заготовить кадры. Каждый кадр в первозданнном своем виде представляет отдельный GIF файл. Сколько их необходимо? Вообще, чем меньше можно взять для приемлемого результата, тем лучше. Пример мы возьмем самый примитивный, который даже смешон своей примитивностью. Разумеется, иллюстрации не будет, какой смысл на статичной фотографии в газете показывать анимацию? Итак, сюжет нашего примера - на кадре по букве появляется надпись "Газета". Эффект печатной машинки в очень простом варианте. Я выбрала этот пример только потому, что в нем не нужно рисовать и можно полностью окунуться в изучение анимации (либо, как ее иногда называют, "псевдоанимаций").

Итак, создадим новый файл с прозрачной основой (в корне создания нового файла вам будет предложен выбор фона). Сразу же стоит перевести файл в режим "индексированные цвета" - изображение=>режим=>инд. цвета (так как сохранять будем в GIF). Хотя, учитывая возможности PhotoShop, этого можно не делать (почему - дальше). Первым кадром сохраним пустое изображение: появление букв сразу - это как-то неестественно. Для того чтобы это сделать, вы можете воспользоваться одним из трех нижеописанных способов.

1) Если файл у вас - изображение уже в индексированных цветах, то достаточно нажать ctrl+s (сохранить), либо alt+ctrl+s (сохранить как копию), выбрав из раскрывшегося меню необходимый формат.

2) Если изображение у вас в RGB системе, то можно воспользоваться импортом. Для этого нажмите File=>Import=>Gif89a.

3) И наиболее приемлемый вариант, появившийся только в версии 5.5, - сохранить оптимизированным для web (alt+ctrl+shift+c). Нажав это сочетание клавиш, вы увидите окно сохранения.

Обратите внимание на следующее: вы можете выбрать формат файла, поэтому исходное изображение не обязательно должно быть в indexed color. При использовании gif вы сами можете выбрать количество цветов, в которых сохранять. Разумеется, чем меньше их, тем лучше. В данном случае достаточно двух - фона и цвета букв. Поэтому количество цветов возьмите за 2. Можно также удалять ненужные руками - щелкаете в color table по квадратику с лишним цветом и жмете del.

Сразу создайте директорию, в которой будут лежать будущие кадры. Зачем это нужно, поймете потом. Файлы необходимо называть по их очередности - это, во-первых, удобно, а во-вторых, облегчит работу в дальнейшем.

Затем на изображении, которое у вас есть в PhotoShop (обратите внимание, alt+ctrl+shift+c не закрывает файл), пишем первую букву и сохраняем аналогично под именем "2". Точно так же делаются все остальные кадры.

Работа в PhotoShop закончена, переходим непосредственно к созданию анимации в Image Ready. Опытные читатели могут возразить, что кадры с большим выигрышем времени мы могли сделать и в ImageReady непосредственно. Отвечу. В данном примитивном примере - да. Но обычно - нет (если вы работаете со сложными объектами). А смысл того, что мы делаем, - описать общий механизм создания псевдоанимации при помощи Adobe PhotoShop.

Итак, запустим программу. Я не ставлю себе в этой статье целью описать ImageReady - на это необходимо несколько статей, посвященных ему непосредственно. Поэтому не стоит упрекать меня, если я не укажу что-либо об этой программе, важное с вашей точки зрения. В этой статье будут описаны лишь инструменты анимации, и то достаточно поверхностно.

Раньше приходилось указывать все кадры программе по очереди. Но с появлением ImageReady все стало значительно легче. Теперь можно открыть целую папку, в которой лежат кадры. Именно поэтому я просила вас сохранять все в новой папке и нумеровать по порядку - дело в том, что программа сортирует периодичность кадров сама. И в основу порядка идут цифры. То есть, в правильном порядке станут не только 1.gif, 2.gif, 3.gif, но и image1.gif, image2.gif... Все удобство данной опции вы сможете понять только тогда, когда будете делать анимацию кадров из 20. Для того чтобы выполнить описанную операцию, нажмите file=>import=>folder as frames. Да, кстати, эта программа открывает видео avi файлы, так что кадров для какого-нибудь изображения можно натягать и оттуда.

В этой статье мы будем работать только с одной панелью ImageReady - animation. Сразу после открытия папки вы увидите появившиеся там кадры. Первым делом проверьте, в правильном ли они порядке идут. Если нет, исправьте положение простым перетаскиванием. Вы уже можете просмотреть свою анимацию. Для этого достаточно нажать "play" в нижней части панели. Скорее всего, вас сразу не устроит скорость. Как это исправить? Очень просто. Под каждым кадром у вас есть цифры. По умолчанию это 0.00. Это значит, что задержки на кадре не происходит. Для исправления ситуации нажмите на этой цифре и в появившемся меню выберите другое значение. Я лично остановилась на 0.2 секунды. Ну, уже гораздо приличнее. Однако, что-то еще не то? Надо установить задержку на последнем кадре. Для этого просто поставьте там значение равное четырем секундам.

Так же вы можете указать "проигрывание файла все время" не останавливаясь, один или указанное число раз. Для этого кликните по надписи "forever" (по умолчанию стоит значение всегда), а затем выберите то, что вам нужно. Теперь осталось только сохранить файл, а далее использовать по назначению. Обратите внимание на вес итогового файла, он должен быть достаточно маленьким (у меня - 1.1 kb).

Письма читателей.

Вообще, я получаю достаточно большое количество писем с вопросами. Но вот со своими примерами получила только одно. Но зато первый блин был никак не комом, и поэтому я вставляю его целиком и даже с иллюстрацией :). Такое вот выражение благодарности автору письма за старание.

Письмо от Xangel:

Хочу лично поблагодарить вас за все ваши старания. Я уже давно почитываю вашу рубрику и иногда нахожу в ней что-то, чего я не знал, чем не пользовался.

А пишу вам потому, что хочу пополнить библиотеку приемов работы с Photoshop наших белорусских дизайнеров и РС-художников. Так вот, рассказать вам хотел об одном весьма, на мой взгляд, привлекательном эффекте, который я получил в Photoshop'е: эффекте жидкости.

Прежде всего, хочу заметить, что пользуюсь только английской версией Photoshop (и вам советую;-)), и поэтому названия фильтров, соответственно, на родном Photoshop языке. Итак, чтобы создать жидкую поверхность, а точнее объемную жидкость, выполняем следующие действия.

Для начала создадим новый файл и в нем новый слой. Затем, к только что созданному слою применим фильтр /Filter/Render/Clouds (обратите внимание: цвет созданных облаков соответствует текущему цвету, установленному в панели Tools). Теперь применяем /Filter/Sketch/Chrome (там можно настроить подходящие параметры, хотя результат будет довольно схожим во всех случаях).

Теперь, для того чтобы жидкость была не металлического цвета, изменим цвет с помощью /Image/Adjust/Color Balance, в моем случае я делал воду и применял голубовато-синий цвет. Вот и все - основная часть готова!

После этого можно применять другие фильтры, например, для эффекта водоворота можно использовать /Filter/Distort/Twirl. Но для создания эффекта объема жидкости нужно еще кое-что изменить: задаем значение прозрачности нашего слоя (я использовал 70%), переходим на нижний слой и там создаем такую же поверхность, только при выборе цвета выбираем цвет темнее предыдущего.
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Проделав эти действия, можно вставить фотографию, рисунок или текст на нижний слой. После чего для реалистичности добавить следующие фильтры: /Filter/Distort/Wave (я использовал: Number of Generators=12 Type=Triangle Wavelength (Min/ Max)=55/60 Amplitude=1/4 Scale (Horiz/Vert)=30/70). И, наконец, можно еще применить фильтр /Filter/Distort/Ocean Ripple с параметрами Ripple Size -> побольше, Ripple Magnitude -> поменьше.

Вот и все! Дальше можете экспериментировать сами - делать текст под водой объемным, вместо воды можно сделать красивую раскаленную лаву и т.д.

Еще раз спасибо за такую полезную рубрику!

P.S.: Пользуйтесь Gimp'ом!;-)

С уважением, Xangel.

От себя хочу отметить, что описанный нашим читателем эффект действительно интересен и неочевиден. Спасибо от имени всех остальных ваших коллег-читателей. Было бы крайне неплохо, если бы и другие присылали свои интересные находки в качестве помощи ближним :).

В этой статье не было опубликовано ни одного описания нестандартного фильтра, но я обязательно вернусь к данной традиции в следующем номере.

На сим позвольте сегодня попрощаться.
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	В наше время при помощи PhotoShop реализовывается множество различных проектов и задач, но основными являются несомненно те, которые связаны с созданием собственных изображений и визуальной обработкой готовых. Правда, возможности этой программы настолько велики, что порой все задачи сливаются в одну. Дело в том, что иногда уже готовый материал претерпевает столь значительные изменения, что трудно сказать, была ли произведена лишь коррекция, либо было создано новое изображение. Источником первичных материалов служат, как правило, собственноручно отсканированные изображения, либо клипарты (диски с изображениями в популярных растровых форматах). Продаются они в достаточно большом количестве и способны удовлетворить любого, даже очень притязательного пользователя. Но все же, несмотря на огромный выбор, иногда подобрать необходимое изображение довольно тяжело, а порой и невозможно. Тогда остается только один выход - найти что-либо немного похожее на необходимое вам изображение и собственноручно довести его до идеала.
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Особенно характерны такие преобразования для панорамных (отображающих определенную местность) фотографий. Действительно, часто бывает, что вроде и деревья подходят и небо нечего, а вот солнца нет. Или необходимо создать эффект грозового, пасмурного неба. В принципе, создание природных явлений - одна из наиболее необходимых и часто реализуемых задач при создании и обработке изображений пейзажного или панорамного характера. Существует множество дополнительных плагинов PhotoShop, помогающих справиться с этой не простой, но необходимой задачей.

Разумеется нет смысла искать эти фильтры, если они вам нужны единовременно. Именно тогда и применяются приемы ручной коррекции. О таком случае сегодня и пойдет речь. А поговорим мы о возможности, реализовать эффект восходящего солнца. Наша задача не в том, чтобы восход существовал как бы вне изображения и был представлен в виде простого фона. Цель - в достижении наиболее правдоподобного результата.

Подберите изображение, с которым вы будете работать. Обратите внимание на то, чтобы ваша фотография была совместима с восходом, который вы намериваетесь создать. Под совместимостью я имею в виду отсутствие еще одного солнца, либо луны, достаточное небесное пространство, а так же ряд других факторов, наличие или отсутствие которых остается на ваше усмотрение. Хотя про некоторые нюансы светотеневой коррекции, которая все ровно вам понадобится, будет рассказано несколько позже.

Для начала вам необходимо отделить область, подвластную редактированию, от области, которая будет находиться вне его досягаемости. Для этого откройте палитру каналов и рассмотрите различные каналы, входящие в состав RGB. Их горячие клавиши: Ctrl + 1 - красный, Ctrl + 2 - зеленый, Ctrl + 3 - синий. Среди этих каналов подберите тот, в котором небо будет больше всего контрастировать с предметами, расположенными на его фоне. В моем случае это был синий канал. Сделайте его дубликат (перетащите, выбранный вами канал к иконке с изображением чистого листа, расположенной внизу палитры, и вы увидите новый Alpha 1 - канал). Именно его вы и будете редактировать, не изменяя при этом оригинального изображения. Теперь вам необходимо создать маску, которая впоследствии будет преобразовываться в выделение. Для того, что бы граница выделения стала более четкой вам необходимо увеличить контрастность между небом и объектом. Способ, который я вам предлагаю, удобен тем, что в нем не используются ни уровни, ни кривые.

В палитре инструментов выберете губку (Sponge), силу нажима установите равную 100 процентам, а опцию тонирования- "насытить". Применение данного инструмента с приведенными выше настройками позволяет снизить насыщенность цветов, в результате чего они тускнеют и осветляются. Возьмите большую кисть с мягкими краями и хорошенько обработайте область неба, причем вам необходимо заходить во все, даже самые небольшие места (такие, например, как проем между колоннами). Не беспокойтесь о влиянии на остальную часть изображения.

После того, как вы осветлили небо, возьмите инструмент "обжиг" (Burn). Силу нажима установите примерно равную 50-65 процентом, а область воздействия - "тени". Выберите кисть с мягкими краями и обработайте ваши объекты, находящиеся на фоне неба. Перетаскивание обжига делает пиксели изрображения менее яркими. В итоге у вас должно получиться весьма контрастное изображение, а если вы проделали вышеперечисленные операции с особым усердием, то вы получили черно-белое изображение. Увеличение контрастности таким путем намного удобнее, нежели использование уровней и кривых, так как воздействие производится только на необходимые области, не влияя сразу на все изображение.

Теперь вам необходимо немного подкорректировать вашу маску перед тем, как приступать к непосредственному созданию восхода. Для этого вернитесь вновь в режим RGB (CTRL + ~) и загрузите вашу маску в выделение (щелкните левой клавишей мыши по пунктирному кружку внизу палитры каналов), не забывайте о том, что белые участки вашей маски преобразуются в выделенную область, а черные, соответственно, в область ограниченную от последующего воздействия. Корректировка выделения нужна для создания более реалистичного изображения. Ведь если восход действительно происходит, то он отразится на всем, а не только на небе; свет должен попасть на все предметы, находящиеся на фоне неба. Для того чтобы добиться всего этого, вам необходимо модифицировать ваше выделение. Для этого проделайте следующие операции: "Выделить -> Изменить - >Растяжение". Я расширила область своего выделения на 5 пикселей. Так как свет огибает предметы и плавно переходит в полутень, а затем и в тень, ваша светотеневая маска должна быть реализована с плавным переходом от выделенных областей к невыделенным. Для этого вам необходимо размыть область выделения и тем самым смягчить переход между областями света и тени. Выполните следующее: "Выделить -> Изменить -> Сглаживание". Радиус размытия установите несколько меньше, чем радиус растяжения (в моем случае он был равен 4 пиксела). Однако величины, которые вы используете, зависят от размеров вашего изображения и его разрешения. Например, чем меньше объект, тем меньшим модификациям должна быть подвержена ваша маска.

Теперь вам необходимо перейти в палитру слоев. Так как мы хотим работать с поверхностью выделения, не изменяя при этом базового изображения, то нам необходимо создать еще один слой, непосредственно с которым и будет производиться работа. Создать новый слой вы можете щелкнув левой клавишей мыши по эмблеме нового слоя (чистый лист) внизу палитры. Теперь мы имеем новый прозрачный слой с выделенной областью.

На следующем этапе нам необходимо создать сам восход. Для этого мы воспользуемся таким инструментом, как радиальный градиент, который реализуется через светопереходы, в виде концентрических окружностей, диаметр которых увеличивается от центра к периметру области, подвластной редактированию. Итак, для начала нам необходимо создать свой градиент, который впоследствии будет олицетворять собой наш восход. Выберете в палитре инструментов "градиент". На панели параметров градиента установите правку. Создайте специальный градиент, напоминающий восход солнца. Я создавала его, используя градации от желтого к черному. В самом начале добавила небольшую секцию белого цвета, который впоследствии преобразуется в солнце. При создании перехода, в цветовой полосе, расположенной под прокручивающемся списком, вы можете видеть предварительный вариант вашего градиента. Начало цвета обозначается ограничителем, расположенным слева, аналогичным ограничителем справа - его конец. Над цветовой полосой вы можете увидеть указатели средних точек, представленные в виде небольших ромбов. Каждая из этих точек указывает на то место, в котором цвета (переход между которыми осуществляется) смешиваются в одинаковых пропорциях. Изменяя месторасположение цветовых ограничителей и средних точек, добавляя новые, либо удаляя ненужные, вы сможете создать необходимый вам градиент. Добавить цветовой ограничитель вы можете, щелкнув левой клавишей мыши в необходимом вам месте вдоль нижней части цветовой полосы. На месте щелчка появится новый цветовой указатель и одновременно PhotoShop поставит маркеры средних точек между новым ограничителем и соседними. Появившийся цветовой маркер является активным, и вы сразу можете указать его цвет, выбрав его в цветовой палитре. Если же вам необходимо удалить ненужный цветовой ограничитель, то просто передвиньте его за пределы полосы с цветовыми переходами. Ограничитель исчезнет, а цветовая полоса преобразуется в соответствии с новыми условиями. Если вам необходимо скопировать цветовой маркер, не удаляя его с того места, где он находился ранее, то следует перетащить его мышью при нажатой клавише Alt. Перемещать указатели можно при помощи мыши, либо, сделав их активными, указать числовое значение опции Location (Положение). Имейте в виду, что если вы используете числовое позиционирование цветовых ограничителей, то 0 процентов соответствует крайнему левому положению, а 100% - правому. Эти позиции абсолютны на полосе цветов и не изменяются при добавлении новых цветовых ограничителей. Совсем иначе обстоит дело при числовом задании положения указателей средних точек. Там значение 50 процентов соответствует среднему положению между двумя соседними цветовыми ограничителями; 0% - положение над левым ограничителем; 100% - над правым. Таким образом положение средних точек задается относительно цветовых указателей, а не цветовой полосы. При изменении цветовых ограничителей PhotoShop автоматически перемещает отметку средней точки, сохраняя ранее заданные пропорции. Если ваши цветовые ограничители, либо указатели средних точек находятся слишком близко друг другу, то вы можете использовать клавишу Tab для перехода между ними. Для реализации эффекта восходящего солнца я создала градиент, состоящий из 3 цветов: белый, желтый и черный. Цветовые ограничители находились в положениях: 0, 3, 100 - соответственно. Указатель средней точки между белым и желтым цветом был в положении 40%, между желтым и черным - 15%.

PhotoShop автоматически сохраняет созданный вами градиент в формате Prefs. Но файлы этого формата не очень надежны. Поэтому, если вы хотите и впоследствии пользоваться вашими заготовками, то вам следует щелкнуть на кнопке Save в диалоговом окне Gradient Editor, и вы сможете сохранить свои работы в более надежном месте.

После того, как вы создали свой градиент, выберите его из прокручивающегося списка и установите следующие настройки: прозрачность - 100 процентов, режим - экран, тип - радиальный. Восход солнца должен начинаться на горизонте и расходиться равномерно по всем направлениям. Для этого щелкните левой клавишей мыши в том месте, где должно быть расположено солнце, и, удерживая клавишу, перетащите мышь в верхний угол. Так как ваш градиент находится в отдельном слое и является абсолютно непрозрачным, то для достижения желаемого эффекта, режим вашего нового слоя необходимо установить в Screen. Если ваш градиент вопреки ожиданиям имеет черный центр и плавно переходит в желтое окружение, то вам просто необходимо удалить, либо добавить флажок "обратно" в палитре настроек градиента. Надеюсь, вам удалось добиться желаемого результата.

Теперь пришло время все же немного подкорректировать свет на вашем изображении. Прежде всего, вам следует загрузить маску в выделение. А теперь подумайте, что вы будете корректировать: небо, либо объекты, расположенные на его фоне. Лично я выполнила оба типа преобразований, так как используемая мной фотография была слишком темной. Для начало поработаем над объектом. Для этого инвертируйте ваше выделение (Ctrl + Shift + I, либо Выделить -> Инвертировать). Теперь откройте палитру слоев и щелкните левой клавишею мыши в правом верхнем углу по маленькому черному треугольничку. Из раскрывающегося меню выберите "новый слой настройки", там в свою очередь установите имя параметра "тон-насыщенность" (непрозрачность - 100 процентов, Mode - обычный), нажмите ввод, и перед вами появится таблица с настройками. Флажок возле параметра обозначает, что цвет необходимо убрать и работать только с параметрами легкости и насыщенности, причем Edit из раскрывающегося меню выберите Master. При свето-теневой коррекции здания я использовала величину легкости равную 39, а насыщенности - 75. Затем, вновь загрузив выделение, я немного изменила освещенность неба. Я использовала положительные величины настроек, так как мое изначальное изображение было довольно темно; если же у вас оно наоборот слишком освещенное, то вам следует затемнить как объект, так и небо, а может и совместить оба процесса, в принципе решать вам. Использование этих настроек весьма удобно, так как в процессе работы вы можете регулировать только степень освещенности, не изменяя при этом цвет вашего изображения.

Для достижения более реалистичного эффекта я советовала бы вам поменять слой с градиентом и слой со свето-теневой коррекцией местами. Это необходимо потому, что при коррекции света вы использовали четкие границы выделений, и плавные градации от освещенных областей к затемненным, ради которых вы модифицировали вашу маску при создании слоя с градиентом, были нарушены. Поменяв слои местами, вы вновь придете к желаемому результату, а именно: к весьма реалистичному восходу солнца.

Как вы могли убедиться, реализация даже довольно сложных явлений, связанных со световыми эффектами не представляет особого труда при работе с PhotoShop. К тому же вы имели возможность заметить, что при необходимости создания маски с увеличением контрастности вовсе необязательно пользоваться кривыми и уровнями, что очень удобно, особенно для любителей.
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	Приступая к любой работе, мы прежде всего составляем более либо менее конкретный план того, как мы будем ее выполнять. Иногда приходиться продумывать все до мельчайших подробностей, а порой мы всего лишь выбираем с какого конца подступиться, чтобы в итоге прийти к поставленной цели. Это касается практически любого вида деятельности. Мы строим планы того, как изучить интересующий нас вопрос, как заработать деньги, либо как хорошо провести время.
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Однако если мы начнем говорить об изобразительном искусстве и о компьютерной графике, то тут эта теория оправдывает себя всего лишь на половину, и возможно два варианта.

1. Художник тщательно продумывает сюжет своего творения, способы реализации, затем долго и кропотливо прорисовывает эскизы, которых иногда создается огромное количество экземпляров, и только потом приступает к основному живописному либо графическому полотну; скульптуре либо батику; чеканке либо архитектурному сооружению. Именно так чаще всего работали старые мастера (эпоха Возрождения, классицизм, барокко).

2. Здесь процесс создания работы диаметрально противоположный вышеописанному. Все основано на чувствах, эмоциях. При создании творений таким способом зачастую отсутствует даже начальный замысел. Художник берет кисти, краски - и вот готов его шедевр, или не совсем шедевр, тут уже дело вкуса. Особенность такого письма заключается в том, что, садясь за работу, даже сам художник не всегда представляет, а если говорить точнее, совсем не представляет, что же получится в итоге. Именно в таком стиле работали многие художники ХХ века (сюрреалисты, дадаисты, творцы, работающие в стиле метафизической живописи, а так же многие другие).

Не стали исключением из вышеописанных правил работы художников, работающих с Adobe PhotoShop. Благодаря огромному набору инструментов, фильтров, а так же ряду других возможностей, представляемых данной программой можно создавать практически любые произведения, количество и содержание которых зависит только от фантазии и желания автора. Сегодня я хочу предложить вам поработать как в стиле описанном в 1-ом пункте, так и в стиле 2-ого.

Для начала я предлагаю вам создать совсем не сложный эффект. Отражение чего-либо в воде. Это явление каждый из нас видел тысячи раз, поэтому конечный результат мы можем себе представить довольно четко. Я буду работать с изображением цветка.

Выберете картинку, с которой вы будете работать, либо создайте ее сами. Подумайте, какого цвета должен быть фон на вашем изображении, так как при создании отражения отразиться и ваш фон, вследствие чего на его цвет будет наложен еще слой синего цвета. Чтобы избежать ненужных трудностей я рекомендую использовать цвет заднего плана, близкий к синему либо черному. Так как первоначальный фон на моем изображении был белый, то я его заменила фоном, выполненным в синеватых тонах. Сделала я это при помощи фильтра: "Фильтр -> Рендер ->Облака", предварительно выделив свой цветок инструментом "волшебная палочка". Если вы хотите воспользоваться этим фильтром, то не забывайте, что он создает произвольные переходы между основным цветом переднего плана и цветом фона. Я установила цвет переднего плана - насыщенный синий, а цвет фона - темно-синий, практически черный. Если вам кажется, что в вашем фоне не хватает яркости, либо насыщенности, то вы можете исправить эти недостатки при помощи кривых, баланса цвета/насыщенности, яркости/контрастности. Либо вы можете удерживать клавишу Shift при использовании облаков, это позволит увеличить насыщенность цветов на вашем фоне.

После того, как вы подготовили изображение, отражение которого намереваетесь создать, можете переходить к следующему этапу, а именно: к созданию пространства, которое впоследствии будет заполнено водой. Для этого вам необходимо проделать следующее: "Изображение -> Размер холста", - а теперь в раскрывшемся меню установите якорь вашего холста посередине верхнего ряда, а высоту - равную 200 процентов, ширину оставьте прежней, нажмите ОК. Вы видите, что холст, на котором расположено ваше изображение, увеличился в два раза, а сам рисунок размещается в верхней части полотна. Теперь выделите при помощи прямоугольного выделения нижнюю часть вашего холста и создайте там воду. Вы можете использовать свои заготовки. Однако я вам предлагаю самый простой способ создания воды, который вполне пригоден для создания отражения, хотя отдельно от этого эффекта применять его я не рекомендую: вода, созданная таким способом выглядит не достаточно натурально без последующих преобразований. Просто создайте градиент с переходом от темно-синего к светло-голубому и расположите его так, чтобы его светлая часть была внизу. Я еще раз хочу сказать, что описанный способ создания воды далеко не единственный, и если вам нравятся другие, то вы можете воспользоваться ими. Приведенный выше способ наиболее простой и мало затратный по времени.

Инвертируйте ваше выделение (теперь выделено само изображение) Ctrl+Shift+I. Скопируйте выделенную область в буфер обмена Ctrl+C, либо "Правка -> Копировать". Переверните изображение зеркально по вертикали. "Изображение -> Вращать холст -> Перевернуть вертикально". Запомните, что переворачивать изображение необходимо именно по вертикали, а не на 180 градусов. Это связанно с тем, что нам необходимо зеркальное отображение нашего рисунка. На следующем этапе вам необходимо создать новый слой. Вы можете это сделать, щелкнув левой клавишей мыши по иконке нового слоя, расположенной внизу палитры слоев, либо "Слой -> Создать -> Слой", либо сочетание клавиш Сtrl+Shift+N, либо щелкнуть по маленькому черному треугольничку, расположенному в верхнем правом углу палитры слоев, левой клавишей мыши и выбрать в раскрывшемся меню "Новый слой". Как вы можете видеть, программа Adobe PhotoShop предлагает целый ряд возможностей для выполнения даже самого простого действия, не говоря уже о создании каких-либо эффектов, поэтому вы можете выбрать тот стиль работы, который импонирует вам больше всего. Я предпочитаю работать с клавиатурными сокращениями, так как они помогают наиболее быстро выполнять необходимые операции, вместо ряда действий достаточно нажать лишь одно определенное сочетание клавиш. Всего в этом графическом редакторе есть более чем 550 клавиатурных сокращений, но достаточно запомнить лишь основные, которые при создании изображения проделываются многократно.

Вставьте в только что созданный вами слой область из буфера: "Правка -> Вставить", либо нажмите сочетание клавишь Ctrl+V. Используя инструмент перемещения (горячая клавиша V), установите ее в самой верхней части холста так, чтобы получилось полностью симметричное изображение, ось симметрии которого проходит в горизонтальном направлении и располагается посередине холста.

Если вы сделали все правильно, то у вас должно получиться полностью симметричное изображение. Но есть одно исключение. В верхней части вашего изображения расположено два слоя, а в нижней - лишь 1. Переверните ваше изображение по вертикали снова, хотя если вам хочется повернуть его на 180 градусов, пожалуйста. "Изображение -> Вращать холст -> Повернуть вертикально (180 градусов)". Здесь уже не имеет никакого значения, как вы будете поворачивать свой холст.

А теперь вам необходимо наложить голубоватую дымку на нижнюю часть изображения, так как любое изображение имеет голубоватый оттенок, если смотреть на его отражение в воде. Но для того, чтобы эффект был более реалистичным, я предлагаю вам перейти на тот слой, где расположена половина изображения, и изменить его прозрачность. Перейдите в палитру слоев и установите эту величину на значение примерно равное 50 процентам.

Если вы хотите добиться большей реалистичности, то добавьте немного ряби к водной части изображения. На приведенном примере это сделано следующим образом: выделена та часть холста, на которой располагается водное пространство и применен "Фильтр -> Искажение -> Океанская дрожь". Опция размера была установлена на значение равное 9, а опция мощности - 8.

По-моему, получилось довольно похоже. Вы в очередной раз смогли убедиться, что благодаря Adobe PhotoShop, решение на первый взгляд непростых задач оказывается довольно легким. Но создавая это изображение мы с самого начала представляли себе результат, который хотим получить в итоге. А теперь я предлагаю попытаться создать что-нибудь такое, конечный результат чего не возможно будет предугадать. Я предлагаю взять еще один цветок, либо какой-нибудь другой объект, попытаться опустить его в воду и посмотреть, что же произойдет.

Для начала откройте изображение, с которым вы будете работать. Теперь вам предстоит один из самых главных этапов, для выполнения которого потребуется кропотливость и усидчивость. Вам необходимо выделить объект, который вы собираетесь опускать в воду. Сделать это вы можете разными способами. Например, использовать такие инструменты, как лассо (клавиша, позволяющая выбрать этот инструмент с клавиатуры - L), волшебная палочка (горячая клавиша - W), либо вы можете воспользоваться таким инструментом, как перо (Р), создав при его помощи путь, а затем преобразовать его в выделение. Если вы создаете область выделения поэтапно, и вам необходимо добавить, либо исключить какую-нибудь ее часть, то для этого вам необходимо использовать инструменты выделения с нажатыми клавишами: Shift - при добавлении и Alt - при исключении. После того, как вы создали свою выделенную область, сохраните ее в виде маски. Для этого вам необходимо перейти в палитру каналов и щелкнуть левой клавишей мыши по иконке преобразования выделения в маску. Она расположена внизу палитры и представлена в виде белого кружочка, ограниченного пунктирной линией, на сером фоне.

Сейчас вам необходимо создать еще один слой с объектом, над которым вы работаете. Для этого вам необходимо загрузить маску в выделение. Щелкните левой клавишей мыши по каналу с маской при нажатой клавише Ctrl, либо по иконке преобразования канала в выделение внизу палитры каналов (пунктирный кружочек). А теперь создайте новый слой через копирование. "Слой -> Создать -> Слой через копирование", либо сочетание клавиш Ctrl+J.
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Создайте еще один слой для воды. "Слой -> Cоздать -> Слой", либо Ctrl+Shift+N. Сделайте на нем квадратное выделение в нижней части (горячая клавиша М) и заполните его облаками. "Фильтр -> Рендер -> Облака". На представленном вашему вниманию рисунке цвет переднего плана был установлен белым, а цвет фона - светло-голубым. Если вам не нравится такой способ создания воды, то вы можете воспользоваться любым другим, можете использовать также и готовую структуру. После того, как вы определились со способом создания воды и создали ее, снимите выделение и, перейдя в палитру слоев, поменяйте местами слой с копией вашего объекта и слой с изображением воды.

Перейдите на слой с копией объекта и, выбрав инструмент "перемещение" (горячая клавиша V), подберите подходящее место для вашего изображения, что бы оно находилось наполовину погруженным в воду. Выделите нижнюю половину цветка, используя инструменты выделения, либо, загрузив маску, созданную в начале работы, в выделенную область, удалите при помощи прямоугольного выделения и клавиши Alt верхнюю часть выделения. А теперь создайте еще один слой из выделенного участка. "Слой -> Создать -> Слой через вырезку", либо сочетание клавиш Ctrl+Shift+J. Так как ваш объект погружен в воду, то та часть, которая находится под водой, будет несколько подернута голубоватой дымкой. Для того, что бы дробиться такого эффекта, вам необходимо подкорректировать прозрачность этого слоя, установив ее в диапазоне 30-50 процентов. Создавая линию погружения объекта в воду, я рекомендую использовать перо, особенно если ваш предмет имеет не плоскую, а цилиндрическую форму. При погружении в воду предметов с такой сложной формой линия перехода должна быть не ровной, а несколько изогнутой, и поэтому перо наиболее удобный инструмент для ее создания, так как изгибы можно корректировать после создания основной линии.

Сейчас я предлагаю вам создать фон для остальной части объекта, которая находится вне воды. Вы можете использовать для этой цели любые готовые изображения, но я предпочла еще раз воспользоваться фильтром имитирующим облака. "Фильтр -> Рендер -> Облака". Цвет переднего плана я выбрала голубой, такой же как использовался при создании воды, а цвет фона - темный, насыщенный синий цвет.

А теперь перейдем к завершающему этапу создания изображения. Вспомните, когда вы бросаете камешки в воду, то в месте их падения начинают разбегаться круговые волны, почему бы таким волнам не возникнуть и при попадании в воду вашего объекта. Для того, что бы создать данный эффект вы можете воспользоваться любым из нижеперечисленных способов, а можете и обоими сразу.

Способ 1. Этот способ заключается в том, что бы применить фильтр зигзаг к тому слою, на котором расположена вода. Откройте палитру слоев и выберите там слой с изображением воды. Создайте на нем эллиптическое выделение, часть которого будет погружена в воду, а часть выступать над ее поверхностью. Примените к выделенной области фильтр зигзаг. "Фильтр -> Искажения -> Зигзаг". После применения этого фильтра цвета группируются в зигзагообразный узор, исходящий из центра изображения. В итоге образуется набор концентрических волн, которые и образуют рябь. После того, как вы проделали следующие операции: "Фильтр -> Искажения -> Зигзаг", - перед вами появилось диалоговое окно, содержащее следующие опции.

Величина - определяет величину ряби. При положительном значении рябь выступает над поверхностью, при отрицательном - создается впечатление, что она опускается ниже уровня поверхности.

Складки - эта опция определяет количество волн в выделенной области.

От центра - в этом случаи пикселы будут перемещаться в сторону внешней границы.

Вокруг центра - пикселы поворачиваются вдоль окружности, не перемещаясь при этом к периметру.

Круги на воде - эта опция соединяет в себе две вышеперечисленные.

Способ 2. Этот способ фактически ничем не отличается от первого, только здесь фильтр зигзаг применяется к тому слою, на котором расположена нижняя половинка цветка. Я воспользовалась именно этим способом, так как он наиболее подошел к моему цветку. Если же ваш объект имеет более правильную форму, то вам следует воспользоваться первым способом, либо обоими сразу. На изображении, представленном вашему вниманию, настройки были установлены таким образом, что величина равнялась 100, складки - 6, а тип из раскрывающегося меню - вокруг центра. Если вы создаете такой эффект с текстом, то я вам советую применять фильтр зигзаг вместе с фильтром рябь. Это позволит создать множество противоположно направленных волн ряби, пересекающих друг друга.

После того как вы выполнили вышеописанное действие, вы наверно заметили, что волны появились не только на том участке, который погружен под воду, но и на том, который по задумке должен выступать. Для того чтобы исправить этот недочет, я рекомендую воспользоваться ластиком (горячая клавиша Е). Это позволит вам исправить возникшие недостатки. Дело в том, что вы сейчас работаете с тем слоем, на котором расположена нижняя часть вашего объекта, поэтому, если вы сотрете те пикселы, которые появились над водой, то вы тем самым не сотрете изображение верхней части вашего объекта.

Напоследок вы можете склеить все 4 рабочих слоя (Слои -> Слияние вниз, либо Ctrl+E), удалить дополнительный канал-маску. Это позволит вам сохранять ваше изображение в различных форматах, что порой бывает необходимо, однако если вы хотите впоследствии еще продолжить работу над данным изображением, то все слои и маска еще могут понадобиться, и вы можете сохранить свое изображение в формате PhotoShop PSD (в таком случае ваш файл займет несколько больше места чем сохраненный, например, в формате JPEG).

На примерах предложенных к вашему рассмотрению в этой статье, я еще раз хотела показать вам безграничные возможности, предоставляемые графическим редактором Adobe PhotoShop. Используя его, можно создать столь интересные и впечатляющие изображения, которые на первый взгляд позволяет создать только трехмерная графика. Как вы могли убедиться, PhotoShop вновь оправдывает свое имя лидера в области создания и редактирования растровой графики.
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	Творческий подход к использованию любого инструмента, реальной или виртуальной разработки есть единственный путь к успеху. Ограниченность инструментов отнюдь не значит такой же ограниченности возможностей. Вспомните - достаточно иметь, к примеру, один карандаш и создавать уникальные работы, но с другой стороны, наличие великолепных инструментов никак не гарантирует вам хоть что-то сносное в результате. То есть, первое условие успеха это именно человеческий фактор. Однако, появление мощных оконных пакетов разработки расширило круг людей, способных работать в дизайнерско-оформительской сфере хотя бы полупрофессионально. Теперь наличие художественных способностей никак не является непременным условием работы (хотя желательным), достаточно наличия мало-мальски пристойного вкуса и знаний в области своей работы.
Что есть знания? Я лично считаю, что разрабатывать новые способы работы и новые эффекты есть задача абсолютно каждого пользователя. Кстати, именно новички, пользующие программы по методу "научного тыка", часто находят очень интересные решения, правда, понять их оригинальность им, как правило, не приходится. Эффекты же, описываемые в этих статьях, несомненно, получены опытными пользователями в процессе сознательного поиска. В принципе, стоит посвятить PhotoShop несколько недель - и пользователь начинает интуитивно чувствовать, как достигнуть того или иного результата. К примеру, видя рекламу в журнале, сразу представляешь, с помощью каких именно средств она была создана. Кстати, как правило, эти решения просты до невероятности. Правда, еще чаще (особенно в нашей стране) компьютерная графика страдает просто невероятной халтурой и отсутствием вкуса.

В этой статье продолжится тема имитации некоторых природных явлений в Photoshop. Как помнят постоянные читатели, в одном из прошлых номеров мы рассмотрели создание восхода солнца. Сегодняшние примеры, на мой взгляд, менее сложны и более эффектны визуально. Приступая к работе, учтите, что во многом реалистичность изображения зависит от исходного изображения. Поэтому процессу отбора исходного материала необходимо уделять значительно больше времени, чем может показаться на первый взгляд. В который раз повторю, что если вы собираетесь заниматься графикой постоянно, вам просто необходимо наличие компакт-дисков с коллекциями картинок. Впрочем, в Интернете материала хватает, но поиск займет очень много времени, а если провайдер с вас берет деньги поминутно, то это крайне невыгодно экономически. Если же вы решили самостоятельно отсканировать изображение, помните - необходимо исходное изображение очень высокого качества, желательно на глянцевой бумаге. Скорее всего, будет необходимо провести операции цветокоррекции, что потребует времени и терпения.

Туман
Первое, что мы опишем, будет туман. Сразу стоит сказать, что существуют дополнительные плагины, решающие эту проблему в считанные секунды, но у нас их нет и мы будем все делать стандартными средствами Adobe PhotoShop. Изображение желательно брать природного содержания, еще лучше - с рекой или озером. Заметим, что решения, позволившего бы нам создать туман, что говориться, "в лоб", у нас нет. Поэтому пойдем обходным путем. В Photoshop очень многое решается через так называемые корректирующие слои - слои, не вносящие предметных изменений в картинку, но меняющие ее внешний вид. Итак, создайте новый слой. Этот слой будет выполнять роль осветлителя, причем осветлителя местами (то есть создаст основу для отображения неравномерности распределения тумана). Для создания этого эффекта возьмите фильтр из "эффекты света" - "облака". Не пугайтесь результата - у вас все скроется под этими самыми облаками. Для исправления ситуации в параметрах слоя установите значение прозрачности 20-40 процентов (зависит от конкретного изображения), пока вы не почувствуете особых изменений.
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Вспомним некоторые свойства тумана. Чем дальше от точки смотрящего, тем более он становится непрозрачным и густым. Это нам необходимо передать. Как многие уже догадались, идеальный инструмент для этого - градиент. В данном случае градиент от черного к белому. Выберите его. Можно несколько подвигать бегунки в свойствах градиента, дабы подбить его под свою картинку (по умолчанию переход 50%). Необходимо применить градиент, причем таким образом, чтобы самая светлая часть находилась там, где ей необходимо быть логически (в самом дальнем месте реки, к примеру). В свойствах слоя поставьте тип "экран" и настройте прозрачность слоя (на глаз). Сейчас мы уже имеем некоторое подобие тумана. Но все же он выглядит как-то неинтересно и нереалистично. Чтобы исправить эту ситуацию, пойдем несколько трудоемким путем. Сразу посоветую посмотреть конечную картинку, дабы понять, что мы сейчас будем делать. Обратили внимание на ярко выраженные неоднородности, придающие туману особую эффектность? Их-то нам и требуется нарисовать. Возьмите кисточку и нарисуйте несколько линий, желательно размещенных несимметрично. Это будет основа. Но разумеется, туман не может образовывать столь ровные формы. Некоторую реалистичность мы придадим следующим образом - выделяйте небольшие кусочки линий и применяйте к ним фильтр "вихрь" из "искажения". После выполнения этой операции необходимо перейти к общему размытию тумана. Я советую это выполнить с помощью фильтры=>размытие=> размытие в движении. В параметрах укажите ориентацию - снизу вверх.

В принципе, изображение готово. Для доведения до еще более высокого качества можете поэкспериментировать с размытием и прозрачностью и на других слоях.

Космос
Следующая картинка, процесс создания которой я хотела бы предложить вашему вниманию, будет иметь несколько фантастический характер. Я предлагаю вам попробовать создать космос. Процессов создания данного изображения может быть очень много, и все они будут разные (звездное небо, например, можно нарисовать при помощи фильтра "шум", наложенного на темно-синий либо черный фон), но мне хочется предложить вам наиболее яркий и реалистичный прием.

Создание данного изображения мы будем начинать с чистого "листа". Для начала необходимо создать само небесное пространство, но так как небо никогда не имеет равномерную окраску, то результат, который может быть получен при использовании инструментов заливки и градиента, будет далек от идеала. Поэтому предлагаю вам использовать фильтр облака, предварительно установив цвета фона и переднего плана на черный и белый (клавиша D) либо темно-синий и белый. При помощи данного фильтра создаются произвольные переходы, имеющие неправильную конфигурацию, от основного цвета к цвету второго плана. Эти возможности очень часто применяются при создании эффектов, имитирующих природные явления, которые нельзя передать при помощи правильных линий и форм.
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Далее вам необходимо немного подкорректировать цвета и тени на вашем изображении. Это необходимо сделать для того, чтобы придать некоторую глубину и создать впечатление безграничности на вашем рисунке. Для реализации данного замысла воспользуйтесь "Уровнями" (Изображение => Настройки => Уровни, либо сочетание клавиш Ctrl+L). Поэкспериментируйте с настройками в диалоговом окне, появившемся перед вами, они могут быть абсолютно любыми и зависеть только от вашего вкуса.

Вот само небо уже и готово, но выглядит оно очень уныло, поэтому необходимо его несколько оживить. Предлагаю вам добавить немного звезд. Из специального набора кистей выберете что-нибудь подходящее и при помощи инструмента "кисть" либо "аэрограф" создайте несколько звездочек. Если у вас не установлен дополнительный набор кистей, то вам необходимо щелкнуть левой клавишею мыши по маленькому черному треугольнику в верхнем правом углу палитры кистей и из раскрывшегося меню выбрать "загрузить кисти". Вам необходимо найти и открыть каталог 
rushes и загрузить файлы с расширением .abr.

После того как созданы звезды, необходимо создать еще и планеты. При их создании вы можете воспользоваться и готовыми объектами, а можете при помощи весьма несложных приемов создать свои собственные. Я предлагаю вам описание одного из таких приемов. Создайте выделение в виде окружности (горячая клавиша М). Выберете цвета для вашей будущей планеты и воспользуйтесь фильтром "облака" вновь. При использовании данного фильтра цветовая поверхность получается неоднородной, имитируя тем самым объект не совсем правильной формы. Воспользовавшись настройкой "уровни", вы можете несколько изменить освещенность вышей планеты. Для того чтобы преобразовать плоский круг, созданный вами, в шарообразный объект, воспользуйтесь фильтром "эффект света" из раздела "рендер". Для достижения более реалистичного результата вам следует направлять свет так, чтобы более темная часть вашей планеты располагалась на более темном участке неба, именно при таком наложении объектов легче всего добиться имитации трехмерного пространства.

На изображении, представленном вашему вниманию, кроме эффекта света, еще дважды применен фильтр "блик" из раздела "рендер". Первый раз тип линзы был установлен на значение 105 мм, а во второй - 35 мм. Яркость - 80 и 65 процентов в первый и второй раз соответственно.

В итоге у вас должно получиться изображение, напоминающее космическое пространство. Этот эффект был описан потому, что он весьма реалистичен, может иметь множество инторпритаций, к тому же создается с чистого "листа" и как следствие абсолютно не нуждается в подборе основы - начального изображения, а также абсолютно не зависим при выборе цветов для его создания. Это исключительно художественная реализация данной тематики.

Радуга
Но наряду с созданием новых изображений очень часто возникает необходимость в коррекции уже готовых. Следующий описываемый эффект - это процесс создания радуги. Замысел, лежащий в основе создания данного изображения, похож на замысел, использовавшийся при создании восхода солнца (описанного несколько статей назад), но способ реализации несколько отличается.

Подберите изображение, с которым вы будете работать, обратите внимание на то, что создавать вы будете радугу, а следовательно и небо, играющее роль фона, должно быть подходящим.
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Для того чтобы создать радугу, необходимо сперва определить, что же она собой представляет и каким способом можно наиболее реалистично имитировать ее. Если присмотреться, то самая простая радуга выглядит как участок цветных концентрических окружностей довольно большого радиуса, расположенных в определенном порядке. Воссоздать данный результат можно при помощи радиального градиента. Но прежде, чем воспользоваться данным инструментом, необходимо создать такой градиент, при помощи которого можно будет реализовать фигуру, напоминающую радугу. Для этого в палитре градиентов щелкните по клавише "Редактировать", в раскрывшемся меню выберете опцию "новый" и приступайте к созданию градиента. На представленном вам изображении радуга реализована при помощи 4 цветов: черный, зеленый (28 137 18), желтый (210 255 0), красный (255 60 0), и снова черный - расположенных в указанном порядке. Числа указывают на составляющие данных цветов в цветовой модели RGB. Все цветные маркеры вы должны расположить в самом краю цветовой полосы, на небольшом расстоянии друг от друга. Переходить от одного маркера к другому вы можете при помощи клавиши Tab, что очень облегчает работу с близко стоящими цветовыми указателями.

После того, как вы закончили с созданием градиента, необходимо подготовить само изображение. Дело в том, что радуга обычно располагается за предметами, расположенными на фоне неба, поэтому необходимо изолировать деревья либо другие объекты от коррекции, которой подвергнутся все изображения в последующем.

Перейдите в палитру каналов и выберете наиболее контрастный. Затем, сделав его копию, воспользуйтесь инструментом "губка" (режим - насытить) для осветления белых мест и инструментом "обжиг" (режим - тени) для еще большего затемнения черных мест. После того, как вы смогли отделить передний план от фона, преобразуйте маску в выделение (щелкните по каналу с маской левой клавишею мыши при нажатой клавише Ctrl), после чего вернитесь в режим RGB (Ctrl+~) либо любой другой режим цветовой модели, с которым вы работаете.

Перейдите в палитру слоев и создайте там новый слой, на котором будет располагаться радуга. Установите режим данного слоя в "Экран", убедитесь, что все объекты, расположенные на фоне неба, выделены, и приступайте к созданию самой радуги. Для этого воспользуйтесь инструментом радиальный градиент. Найдите наиболее подходящее положение для вашей радуги. Если вам кажется, что цветовые переходы слишком резкие и яркие, то поэкспериментируйте с прозрачностью слоя, на котором расположена радуга, а также можете воспользоваться фильтром "размытие".

Теперь вы можете склеить слои, выкинуть маску, - и изображение готово.

Целью этой статьи было показать вам, что благодаря PhotoShop можно имитировать даже сложные природные явления, которые нельзя реализовать при помощи простых линий и правильных форм.
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	Обзор некоторых дополнительных фильтров

Эта статья будет несколько отличаться от всех прочих, входящих в эту серию. В этом цикле предполагалось описывать приемы работы со стандартными инструментами, фильтрами и эффектами. Но за последние несколько недель я получила много писем, в подавляющем большинстве которых были просьбы написать про дополнительные плагины (фильтры) к PhotoShop. Описывать их так же, как описаны эффекты в других статьях, нет смысла, ибо невозможно объять необъятное (из-за количества и разнообразия). Но написать, какой наборчик что делает, стоит, дабы не пришлось изучать методом научного тыка.

Наборов дополнительных плагинов (отдельные фильтры я пока не рассматриваю) существует великое множество, правда, подавляющее большинство из них абсолютно бесполезны. Причина - многое создано не в коммерческом варианте, а следовательно деньги туда не вложены. Ну, и результат соответствующий. Есть, конечно, исключения. Где можно взять плагины? Я советую купить диск. Расходов с этим немного, а программ лежит великое множество. С другой стороны, покупать диск ради одного пакета вряд ли стоит, особенно имея выход в Интернет. Там этого добра лежит на любой вкус в огромных количествах. Я, в частности, видела сайт, на котором было представлено более 10 000(!) дополнительных фильтров к Adobe PhotoShop. И вам, возможно, будет выгоднее взять их оттуда.

Описывать я буду только то, что сама считаю необходимым и чем регулярно пользуюсь. Этот подход субъективен, но рассказать обо всем невозможно - формат газетной статьи этого не позволяет. Я не буду описывать новые программы - их не так просто найти, в то время как описанные тут общедоступны. Размещение описаний в статье не связано с полезностью программ, так как то, что полезно для одного человека, совершенно бесполезно для другого.

Extensis photographics. Незаменимая для Adobe PhotoShop программа. Причина - нереализованная создателями от Adobe необходимость пускать текст по заданному пути. Представьте, что вам нужно сделать эмблему с надписью по окружности. Реализовать стандартными средствами это тяжело и занудно (см. статья 1 этой серии). А если вам приходится делать такую работу каждый день? Photographics спасет вас - вы можете пустить текст по кругу, параллелограмму, многоугольнику либо любому другому выбранному вами пути. Возможности настройки текста также очень неплохо выполнены. Да, в 6 версии Adobe PhotoShop текст по пути интегрирован (наконец додумались).

Eye Candy 3.0

Не скрою, один из самых моих любимых наборов плагинов. Очень удобно, эффектно, не тормозит. Множество настроек практически для каждого фильтра, готовые варианты настроек... все это делает его практически незаменимым (кстати, по сведениям журнала "Imagine" - Eye Candy самый используемый в своем роде продукт). Итак, что в него входит:

Antimatter - самый бесполезный фильтр в наборе. Соответствует "инвертировать" в Photoshop - заменяет RGB параметры на "противоположные". Что-то вроде негатива. Мне пока ни разу не пригодилось, хотя, может, кто и использует.

Carve - крайне полезно. Позволяет создавать имитацию объема, рельефности. Идеален для создания объемного шрифта, затраты времени минимальны. Существует множество настроек, основные из которых - 4 типа рельефности. Можно сказать, что этот фильтр из любой серости конфетку сделает.

Crome - создает на вашей поверхности чередующиеся полосы неправильной формы и заданных цветов. Много настроек. Я применяла для имитации древесины, очень правдоподобно получается.

Cutout - довольно сложно описать. Ваше выделение копируется и сносится на определенную дистанцию в выбранном вами направлении. Достаточно полезно, реализуются красивые эффекты, рассказывать про которые нет смысла - надо видеть. Можно сделать шрифт несколько объемней (что это такое, поймете сами, когда попробуете).

Drop Shadow - простая тень. В Eye Candy два типа тени, эта первая. Представляет собой тень, образованную параллельным переносом формы тела. Создается впечатление, что тело зависло над поверхностью и освещается сверху. Применяется очень часто, в особенности при работе со шрифтами. Ну и, как и для всех плагинов в этом пакете, есть все необходимые настройки.

Fire - собственно огонь. Очень эффектный фильтр, множество параметров, куча готовых вариантов.

Fur - наносит на поверхность нечто похожее на изморозь на окнах зимой. Выглядит красиво, на практике применить не довелось.

Glass - стекло. Правда, чтобы было похоже на стекло, придется повозиться с параметрами. Хороший фильтр, но реализация стекла не самая правдоподобная.

Glow - эффект "x-files" помните? А сколько с ним возились? С помощью этого плагина затратите всего несколько секунд, да и вариаций у вас будет побольше.

HSB Noice - обычный шум, только очень навернутый. Позволяет создавать интереснейшие текстуры.

Inner Bevel - похоже на Carve настолько, что и описывать не стоит.

Jigle - мнет в прямом смысле слова ваше изображение. Наверное, один из самых интересных и полезных фильтров. Реализация прикольной надписи или старого листка бумаги происходит в секунды.

Motion Trail - некий гибрид "ветра" и "тени". Сносит в указанную сторону "дымку" цвета объекта на необходимое расстояние.

Outer Bevel - не чувствую особой разницы от Inner Bevel.

Perspective Shadow - тень от объекта под любым градусом в любом направлении. Незаменимая вещь для фотомонтажа и любой графической работы. Реализовано просто великолепно, не видела ни одного пакета, где было бы настолько проработано.

Smoke - дым он и есть дым.

Squint - вариации на тему "X-files". Отличается от Glow тем, что с расширением размытой зоны уменьшается зона нерасширенная.

Star - Просто звезда. Параметров много, но... эффект не очень красивый. На мой взгляд это лучше реализовывается с помощью Button в Phototools, но об этом наборе ниже.

Swirl - Полезный эффект. И красивый. Превращает выделенную область (а если она не выделена, то весь слой) в некую дымчатую субстанцию. Можно сделать, к примеру, надпись из дыма за несколько секунд.

Water Drops - реализует достаточно правдоподобные капли воды.

Weave - делает изображение как бы плетеным из соломки. Куча настроек делает фильтр широко применимым.

Как вы заметили, выше описанные эффекты во многом мы уже создавали стандартными средствами. Но эффект у нас был не столь впечатляющим. И опять же, не стоит ставить дополнительные фильтры только ради одной работы, если это можно сделать руками. Это то же самое, что покупать принтер ради распечатки одного документа.

Extensys Intellihance Pro 4.0 - на мой взгляд, лучшее, что было создано в сфере цветокоррекции. Хотя во многом уступает фотошоповским кривым, но значительно дополняет эту программу и облегчает процесс обработки фотографий, в основном благодаря возможности открыть множество вариантов в одном окне (что-то похожее есть в Image Reader, который поставляется в комплекте с PhotoShop 5.5, но там это направлено не на цветокоррекцию, а на адаптацию изображений под интернет). В принципе, описывать более подробно не стоит, но если ваша работа связана с коррекцией уже готовых изображений, то ставьте незамедлительно - очень поможет.

Rayflect fourseasons - в двухмерной графике нет отдельных пакетов, созданных для рисования пейзажей (точнее, они, безусловно, есть, но широко не используются, и мне, к примеру, пока ни одного на глаза не попадалось). В трехмерной есть общеизвестный Bryce 3D, в котором без особых затрат сил и времени можно нарисовать что-нибудь радующее неискушенный глаз. А что делать нам, двумерщикам? В ряде статей этой серии было описано, как создавать природные эффекты на фотографиях. Так вот, эта программа позволяет значительно упростить задачу создания и изменения пейзажей. Ориентирована она, правда, больше на атмосферные явления, но все равно крайне полезна. Единственное, что мне не нравится - достаточно неудобный интерфейс.

KPT 3.0

Несколько лет назад это был просто культовый набор плагинов. Сразу могут спросить - почему третья, а не пятая или шестая версии? Во-первых, третья куда более доступна. А во-вторых, все, что мне нравилось в третьей, так там и осталось. Рассказывать про все фильтры я не буду, рассмотрим самые интересные.

Spheroid Designer - самый интересный фильтр в наборе. Позволяет создавать и размещать в рабочей области от 1 до 1000 шаров. Проработан более чем тщательно. Огромное количество настроек позволяет создать все, что захочется. И между тем удачный интерфейс - программа осваивается в считанные минуты. Но есть одна вещь, на которую никто вначале не обращает внимание и в результате очень много теряет. Внизу рабочего окна размещены две стрелки. Подведя к ним мышку, можно увидеть названия. Первая "Preset menu" - позволяет выбрать из множества уже готовых вариантов наиболее подходящий. Там есть очень интересные образцы, а поменяв их параметры, можно добиться чего-нибудь оригинального. Вторая - "Apply control" - дает возможность выбрать вариант размещения шаров в рабочей области.

Gradient designer - уникальные возможности создания градиентов. Все (!) необходимые настройки и огромнейшее количество готовых градиентов.

Texture Explorer - лучший, на мой взгляд, фильтр для создания текстур. Широчайшие возможности и куча уже созданных текстур. Единственное, чем он страдает - излишняя яркость большинства вариантов. Но это можно после и подкорректировать благодаря стандартным настройкам программы.

Page curl - я думаю, вы не раз видели в полиграфической рекламе изображенный завернутый уголок. Так вот, как правило, он делается этим фильтром (во всяком случае, все, что видела я, были сделаны именно так). Настроек не очень много, но фильтр все равно очень полезный.

Остальные фильтры этого набора менее интересны. Если у вас есть возможность, то используйте также KPT 6. Описывать его не стану, так как на это нужна отдельная статья.

GenesysV2Pro - несомненно, лучшее в области создания эффектов света и бликов. Действительно, оправдывает Pro в названии. Но сразу стоит сказать, что эта программа требует реально больших системных ресурсов и даже на мощных машинах тормозит безбожно. Но цель оправдывает средства - все очень красиво и реалистично. Описать словами это невозможно, делать иллюстрацию нет смысла - газетная бумага не передаст всех бликов и тонких переходов. Но всем, кто пользуется Adobe PhotoShop регулярно, очень советую обратить внимание на GenesysV2Pro.

Extensys PhotoTools - вообще-то, в кругах пользователей нет единого мнения относительно этого плагина. Мне лично он нравится, в нем есть просто незаменимые вещи. Хотя многое интереса не представляет, поэтому рассмотрим фильтры выборочно.

PhotoButton - лучший инструмент для создания кнопок или других выпуклых объектов из всех мною виденных. Почему? Во-первых, очень удобный интерфейс, готовые формы кнопок, возможность их изменять. Множество настроек для имитации выпуклости. И самое главное - возможность накладывать свою текстуру. Причем не одну, а несколько разных, на любой элемент кнопки. Это дает огромные возможности при минимуме времени.

PhotoTexture - плагин, отлично дополняющий Texture Explorer из KPT. Если там лучше создавать яркие, сюрреалистичные поверхности, то этот фильтр, наоборот, делает небросающиеся в глаза текстуры, идеально подходящие для web-страниц, для чего он и был создан.

Все остальное из этого набора повторяет фильтры от Eye Candy, причем тени, к примеру, реализованы значительно хуже.

WebUtilites - к ним относится достаточно большая группа простые, мало весят, эффекты яркие и интересные. Мы рассмотрим три из них.

Type - ряд наиболее часто используемых эффектов над шрифтами, среди которых огонь, лед, выпуклая надпись, порванная надпись. В принципе, выглядят они симпатично, но если сравнивать fire из Type и fire из Eye Candy, то последний будет значительно впереди по всем показателям.

Particle - эффекты, применимые к изображению в целом. Очень интересные, между прочим. В особенности мне нравятся дождь и снег, так как больше они почти нигде не реализованы. Так что если вам нужно сменить погоду на вашем изображении в худшую сторону, смело тащите его из Интернета, либо немного подождите - в одном из следующих номеров будет описано, как реализовать эти эффекты стандартными средствами.

Art texture - фильтр для создания текстур. Гораздо хуже аналогичных, описанных выше. Оправдывает себя только тем, что мало весит.

На этом обзор закончим. Еще раз напомню, что эта статья не совсем относится к тематике серии и написана исключительно по многочисленным просьбам читателей. Со следующего номера мы вернемся к описанию эффектов, получаемых стандартными приемами. Я и раньше старалась и буду стараться впредь указывать, каким дополнительным плагином можно реализовать описываемый эффект - для тех, кому легче вытащить из Интернета, чем рисовать руками. Для критиков еще раз напомню, что описанные в этой статье программы лучшие для меня, но это не значит, что они лучшие в принципе. Поэтому письма вроде "А я Eye candy ненавижу..." можете не писать. Хотя если вы мне пришлете URLs интересных фильтров, я буду вам только благодарна.

	Трюки и спецэффекты в Photoshop 5.5 (часть 16)
2002-08-15


	Автор: Галина Корабельникова 


	Страницы: [1] 

	
	Комментарии [0] 

	


	Ранее уже очень много было сказано о пользе красочных и запоминающихся надписей. Немало было рассказано и о способах реализации различных спецэффектов при работе с текстом. Но за последнее время я получила довольно много писем с просьбами рассказать о способах работы с текстом и о создании замысловатых надписей поподробнее. Учитывая желание читателей, в этой и в нескольких последующих статьях будет рассказано еще о некоторых способах реализации интересных и неочевидных эффектов при работе со шрифтами. Их вы сможете применить при создании сайтов, плакатов, объявлений, а также в других целях (то есть, если сказать короче, - там, где вашей душе угодно).
Для начала поговорим о таких шрифтах, которые еще ни разу не упоминались, не было описаний и похожих на них. Итак, предлагаю вашему вниманию пример создания металлического текста. На мой взгляд, это очень интересно и имеет широчайшее применение. Начнем мы, пожалуй, с такого благородного и дорогого металла, как золото. В последующих статьях я расскажу о том, как создать текст из ртути, серебра, хромированные буквы, железные шрифты, но об этом после, а сейчас вернемся к теме сегодняшней статьи, а именно - к золоту.

Начало создания данной графической надписи ничем не отличается от создания предыдущих текстовых изображений (см. "Компьютерную газету" 31 - 46).

Итак, откройте новое изображение в любой из цветовых моделей. Черно-белая не является исключением, но запомните, что это применимо к данному эффекту, а в других случаях может лишь навредить, работа с этой цветовой моделью в данном случае возможна, так как почти на протяжении всего времени мы будем иметь дело с изображением, реализованным в черных, белых и серых тонах.

Залейте фон черным цветом, воспользовавшись инструментом ведро (клавиша, позволяющая выбирать данный инструмент с клавиатуры, - К). Я упоминаю клавиатурные сочетания для тех, кто предпочитает работать с ними. Конечно, невозможно запомнить их все, так как я насчитала таковых порядка 250, а сколько их еще существует, не знаю. Для того чтобы цвет переднего плана стал черным, вам вовсе не обязательно открывать цветовую палитру и выбирать его там, а достаточно нажать клавишу D - и по умолчанию цвет переднего плана станет черным, а цвет фона - белым.

Выберите инструмент текст (клавиша - Т) и пятидесятипроцентным серым напишите надпись. Советую выбрать шрифт массивный, на нем лучше смотрится эффект металла. (Хотя очень громоздкие буквы тоже не подойдут). После того как текст написан, его можно корректировать, нажав клавиши Ctrl+T. Благодаря данной опции вы можете исправить размер букв, их наклон и местоположение. (В версии PhotoShop 6.0 данный инструмент проработан более тщательно, здесь вы можете изменять не только вышеперечисленные настройки, но и шрифт, которым данный текст написан, пускать его по разнообразным путям, ряд которых предлагается уже в готовом варианте, изменять стиль букв, их цвет, а также ряд других параметров.)

Для дальнейшей работы с буквами их необходимо перевести в растр. Для этого щелкните правой клавишею мыши по букве "Т", расположенной на слое с текстом, и из раскрывшегося меню выберите "Рендеринг слоя". После того, как вы проделали данные операции, вы можете работать с текстом, как с обычным растровым изображением. 

Теперь вам необходимо выделить буквы. Наиболее простой способ это сделать - воспользоваться волшебной палочкой (клавиша - W). Допуск можете установить любой, кроме, конечно, 255 и близким к нему, так как у вас выделится все изображение целиком. Сохраните выделение в отдельном канале в виде маски. Для этого достаточно щелкнуть по изображению белого кружка, ограниченного штриховой линией, расположенного в нижней части палитры каналов, либо проделать следующее: Выделение - Сохранить выделение (в раскрывшемся меню выберите сохранить в новом канале). Сделайте активным только что созданный вами канал и размойте его при помощи фильтра "Размытие по Гауссу" из раздела "Размыть" с радиусом равным примерно 2 - 3 пикселя. Сейчас вернитесь в RGB-канал (либо в тот канал, с которым вы работаете) и перейдите в палитру слоев.

Обратите внимание: чтобы активным был слой с текстом, проделайте следующее: Фильтр - Рендер - Эффект света. В разделе "Текстура канала" выберите канал с размытым текстом. Остальные настройки на приведенном вашему вниманию изображении были следующими: Тип - точечный, Негатив - 35, Фокус - 39, Блеск - 0, Материал - 69, Действие - 0, Среда - 8, оба цвета в настройках - белые. Я не буду подробно останавливаться на описании значений данных настроек, так как думаю, что они будут понятны и интуитивно, но все же если у вас возникнут вопросы, пишите мне.
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Для того чтобы придать буквам более металлический вид, необходимо воспользоваться кривыми (для выбора данной функции можете нажать сочетание клавиш Ctrl+M, либо Изображение - Настройки - Кривые). Нарисуйте кривую, похожую на ту, которая изображена на иллюстрации (на примере, предложенном вашему вниманию, использовалась именно эта кривая). Напомню, что кривые очень часто используются при коррекции фотографий. Благодаря им можно воздействовать на отдельные цвета и тона, изменять их насыщенность, не затрагивая других. Также возможно подвергать коррекции отдельные цветовые составляющие цветовой модели (различные цветовые каналы). На горизонтальной шкале показаны входящие тона, на вертикальной - выходящие, хотя если вам удобно, вы можете поменять местами горизонталь и вертикаль. Для создания новой кривой вы можете добавлять новые точки в стандартную линию (которая загружается по умолчанию) и затем передвигать их в вертикальном направлении. Вы можете воспользоваться карандашом, чтобы нарисовать собственную кривую, а затем сделать ее гладкой и слегка отредактировать.

Теперь вам необходимо перевести ваше изображение в какой-либо из цветовых режимов (я рекомендую RGB, хотя результат будет ничуть не хуже, если вы предпочтете работать в CMYK либо Lab), так как сейчас пришло время разукрасить надпись, то есть превратить этот серый невзрачный металл в блестящее золото. Для этого вам необходимо воспользоваться опцией "Изображение - Настройки - Цвет, насыщение", либо сочетание клавиш "Ctrl+U". Установите флажок возле параметра цвет, а теперь, передвигая указатели, подберите подходящие параметры. Я предпочла следующие настройки: Тон - 56 (указывает на цвет будущего изображения), Насыщенность - 60 (эквивалентна яркости цвета), Легкость - +13 (на сколько больше выражен данный цвет по сравнению с тем, каким он был бы, будь он переведен в черно-белый режим). Если ваше изображение получилось недостаточно ярким, то можете подкорректировать его при помощи настроек "Яркость, Контрастность", которые находятся там же, где и предыдущая опция, к сожалению, клавиатурного эквивалента данная операция не имеет.

Текстура камуфляжа

Следующее, о чем мы поговорим, - создание текстуры камуфляжа. Данная часть статьи будет являться продолжением предыдущей, а следовательно, все то, что писалось о сферах применения прошлой текстуры, а именно кирпича, можно отнести и к данному объекту. Однако создание этого изображения займет у вас намного меньше труда и будет менее кропотливым. К тому же фон является ничуть не менее важной частью любого изображения, чем непосредственный центр композиции, а именно текстура зачастую выступает в роли фона. Кроме того, вы можете заливать ею любой текст либо другой рисунок.

Для начала создайте новое изображение. Однако при создании данной текстуры очень важен размер вашего формата. Во-первых, он должен быть квадратным, а во-вторых, его размеры в пикселях должны быть кратны 64. Первое необходимо потому, что позже вам придется вращать изображение на 90 градусов, а затем совмещать его с первоначальным. Второе ограничение нужно для получения бесшовной текстуры.

После того как вы определились с размером изображения, установите основные цвета, предусмотренные по умолчанию, а именно черный и белый (можете выбирать их в цветовых таблицах, а можете - при помощи клавиши D).

Воспользуйтесь фильтром "облака", который находится в разделе "Рендер". После этого слегка размойте полученный результат. Для этого проделайте следующее: Фильтр - Размыть - Размытие по гауссу. Радиус зависит от размера вашего изображения, например, для своего формата 320х320 я установила величину размытия равную 5.2 пикселя. Чем больше ваше изображение, тем больше его необходимо размывать.

На следующем этапе из этого размытого рисунка вам необходимо создать изображение, которое будет состоять исключительно из белых и черных пятен. Для этого предлагаю воспользоваться такой настройкой, как "Яркость, Контраст". О ней уже упоминалось ранее, однако, если вы забыли, то вызвать ее диалоговое окно можно при помощи следующих операций: Изображение - Настройки - Яркость, Контраст. Контрастность установите на максимально возможную величину, а именно на +100, а яркость подберите таким образом, чтобы белого и черного цветов на вашем изображении было примерно одинаковое количество (я установила значение данного параметра на 3).

Сейчас слегка смягчите переход между цветами при помощи фильтра "Еще размыть" из серии "Размыть".

Выделите все ваше изображение при помощи сочетания клавиш Ctrl+A, либо Выделение - Выделить все. Скопируйте выделенную область в буфер (Ctrl+C, либо Вид - Копировать). После чего откройте новый файл (Ctrl+N, либо Файл - Новый), размеры по умолчанию вам предлагаются равные размерам файла, находящегося в буфере обмена. Теперь вставьте скопированное изображение при помощи сочетания клавиш Ctrl+V, либо Вид - Вставить. Поверните только что созданное вами изображение на 90 градусов по или против часовой стрелки (значения не имеет). (Изображение - Вращать - 90 CW (CCW)). А теперь еще раз вставьте копию первого изображения. Оно скопируется на новый слой. Для того чтобы появился результат, напоминающий желаемый, вам необходимо установить значение напряжения слоя в Multiply, а прозрачность на 50 процентов. В итоге у вас должно получиться черно-белое изображение текстуры камуфляжа.
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Для того чтобы придать ему цвет, для начала необходимо склеить слои вашего изображения, а их у вас должно быть 3: первый с изображением фона, второй - тот, на который вы первый раз копировали изображение, и третий - изображает скопированный рисунок повторно. Для того чтобы склеить слой, нажмите сочетание клавиш Ctrl+E, либо Слой - Слияние вниз.

И, наконец, пришло время сделать ваше изображение цветным. На мой взгляд, наиболее простое и целесообразное решение данной задачи является следующее. При помощи волшебной палочки выделите поочередно черные, серые и белые пятна, заливая выделенные области темно-зеленым, салатовым и светло-зеленым цветами соответственно. Такой способ действия возможен здесь потому, что в вашем изображении присутствует только 3 цвета, а потому работы и немного. Способы раскраски многоцветных (теоретически) изображений были описаны в одной из предыдущих статей.

Photoshop 6.0: Liquify, или Кое-что о новом

Итак, господа, сейчас уже не проблема купить полную версию самого нового PhotoShop, с чем я вас и поздравляю. Сразу у многих возникает вопрос: а стоит ли переходить с проверенной 5.5 на загадочную пока что шестую версию. Вопрос этот не столь простой. Вообще-то, стоит, но есть условия, при которых лучше пока воздержаться от такого апдейта. Во-первых, если вы привыкли к русской версии, то вам будет тяжело переходить на английскую, а русскоязычного PhotoShop 6.0 пока нет. С другой стороны, не так там тяжело адаптироваться, у меня это заняло несколько часов, но тут есть одно условие - необходимо хорошо знать русскую версию программы и английский язык.

Читатели просят рассказать что-нибудь конкретное про шестую версию, спрашивают, собираюсь ли я менять название серии под новый PhotoShop. Некоторые даже спрашивают, почему серия про 5.5, когда есть 6.0. Но ответ здесь простой и состоящий из двух частей: во-первых, эта серия начала выходить в начале августа, когда шестая версия еще не вышла. А во-вторых, я ориентируюсь на большинство читателей, а новый PhotoShop для нас пока скорее экзотика, чем стандарт. Поэтому серия пока не изменится, но дабы учесть желания той части читателей, которые уже приобрели новую программу, я напишу в нескольких статьях про новшества 6.0.

Начнем с наиболее интересного для большинства читателей нововведения - Liquify. Что это такое? По сути, это несколько интереснейших искажающих фильтров, которые объединены в один пакет и вынесены в один параметр. Что-то подобное вы можете найти в KPT 5.0, KPT Gel, KPT Goo (который был описан в одной из статей этой серии).

Посмотрите на иллюстрацию. На ее создание у меня ушло всего 27 секунд (специально засекла и не спешила). До обработки при помощи Liquify это была вполне приличная кошка с мухой, только что глазки были немного сведены к носу. Сейчас это то, что вы видите.

Итак, приступим непосредственно к описанию этих эффектов. Найти их можно по пути Image - Liquify. Почему они там оказались, для меня загадка, возможно, чтобы обратить большое внимание на явно прогрессивное и полезнейшее дополнение самого популярного графического редактора. После того, как вы откроете, вы увидите достаточно стандартное окно с инструментами и параметрами. Постараемся описать их в некой связке, правда, кое-что придется взять отдельно. Ну, в путь.

Warp Tool - первый инструмент в списке и, на мое мнение, наиболее полезный из всех (хоть на первый взгляд и не самый впечатляющий). Действует несколько подобно стандартному инструменту PhotoShop "палец". Он берет пиксели из области кисти (размер которой вы можете регулировать) и сносит в сторону движения инструмента. Причем у инструмента есть параметр эффективности, который сводится к тому, какое процентное количество пикселей сносить на какое процентное расстояние от расстояния (звучит дико, но проще в одной фразе не сформулируешь). Но это все просто слова, на самом деле все гораздо веселей и проще. Этим инструментом (по большей части, хотя и не только им) у меня сделаны кошкины глаза. Неплохо, правда?
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Twirl Clockwise Tool - закручивание по часовой стрелке. Архизабавнейший инструментик, как сказал бы небезызвестный Владимир Ильич. По сути, просто закручивает изображение в области инструмента. Можно применять во многих ситуациях, эффект красивый и очень просто реализуемый.

Twirl CunterClockwise Tool - то же самое, что Twirl Clockwise Tool, только закрутка идет против часовой стрелки. На мой взгляд, создатели PhotoShop должны были соединить эти инструменты в одном, но не сделали этого, видимо, по коммерческим причинам.

Pucker Tool - при помощи этого инструмента можно сужать изображения. Он как бы стягивает содержимое области инструмента к центру. Идеальный инструмент, чтобы на фотографии из вашего полного друга сделать жертву концлагеря. Весьма рекомендую.

Bloat Tool - инструмент, обратный по действию предыдущему. Вполне возможно из худого товарища сделать толстяка.

Shift Pixels Tool - а вот назначения этого инструмента я так и не поняла. Точнее, что он делает, вполне понятно, а вот зачем это необходимо - не совсем. В общем, этот инструмент делает то же самое, что и Warp Tool, но только за тем исключением, что перенос пикселей происходит не по направлению движения кисти, а перпендикулярно ему, прием по физическому правилу левой руки. Возможно, что-то за ним скрывается, но мне эта истина так и не открылась.

Reflection tool - страшно перемешивает ваше изображение. Не очень впечатляет, но иногда может пригодиться.

Reconstruct Tool - вам этот инструмент очень понадобится. Он возвращает к исходному уровню результат ваших художеств, причем делает это постепенно и поэтому можно уловить идеальную временную точку искажения в том случае, если вы чрезмерно применили какой-либо эффект.

Freeze tool - невероятно полезный инструмент в сочетании со всеми остальными. Позволяет выделить область, которую нельзя редактировать. Механизм обозначения этой области похож на создание масок. Советую сразу же освоиться с этим инструментом.

Thaw Tool - инструмент, удаляющий замороженную область.

Итак, с описанием инструментов закончено, теперь несколько коснемся остальных параметров.

Tool Options - параметры кисти. Имеет отношение ко всем инструментам. Значения:

Brush Size - размер кисти, Brush Pressure - эффективность кисти.

Reconstruction - навернутая отмена действий. Позволяет очень точно отменять именно то, что надо. Параметры:

- Mode. Как показывать отмену. Так как я не считаю это необходимым, то подробно описывать не стану.

- Reconstruct - показать отмену анимировано.

- Revert - просто все отменить.

Freeze area - область редактирования замороженной области. Параметры:

- Invert - поменять выделенную и невыделенную область местами. Очень полезно - если я хочу редактировать небольшой кусочек, мне не надо замазывать все остальное, что по сути своей долгий и утомительный процесс, а достаточно выделить только этот маленький участок и нажать "invert".

- Thaw all - удалить все выделения.

View options - настройки интерфейса программы. Параметры:

- Show frozen areas - видеть замороженные области. Когда выделение мешает, то лучше галочку с этого параметра убирать.

- Show Image - видеть изображение. Зачем его не видеть, я так и не поняла, но, возможно, бывают ситуации, когда это просто необходимо.

- Show Mesh - видеть сетку. А вот это просто невероятно полезно. Вы можете увидеть сетку, на которой видны все ваши преобразования. До невероятности проработанный момент, мне очень понравился.

- Mesh size - размер сетки.

- Mesh color - цвет сетки.

- Freeze colour - цвет замороженной области.

Ну, вот и все, с этим мы покончили. Как вывод из этой статьи, я бы сказала перефразируя Маяковского: "Я бы Photoshop 6.0 поставил только за то, что есть в нем Liquisy". Не в рифму, но зато чистая правда :).
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	Начну я эту статью, как обычно, с ответов на наиболее часто встречаемые вопросы читателей. Первый и наиболее актуальный в связи со сменой названия: "Можно ли создавать описываемые эффекты не только в версии 6.0, но и в 5.5?" Ответ на этот вопрос однозначен - "Да", причем не только в PhotoShop5.5, но и в 5.0, а некоторые предлагаемые способы реализации доступны и в более ранних версиях программы.
Дело в том, что создатели данного графического редактора совершенствуют некоторые инструменты, добавляют новые, но основы, положенные в их принцип действия, были разработаны значительно раньше. Например, сейчас, для того чтобы отбросить тень, достаточно воспользоваться эффектами слоя "Layer style", раньше же эта операция выполнялась дольше и требовала больше способностей, но все же была возможна. К тому же все эффекты, описываемые в данной рубрике, полностью реализуемы в версии 5.5, это делается для того, что бы люди, которые еще не перешли к новой версии программы либо не до конца ее освоили, тоже могли воспользоваться этими советами.

Второй вопрос: "Подходят ли дополнительные фильтры, которые описывались ранее и использовались в версии 5.5, к 6.0?". Да, они работают и устанавливаются аналогичным способом. А именно: чтобы установить дополнительные плагины, которые представлены в виде файлов с расширением .8bf, необходимо просто положить их в папку Plug-ins (или что-то в этом роде, зависит от источника установки PhotoShop); если же они представляют собой мини-программы, которые необходимо инсталлировать, то место установки укажите именно эту папку, она находится в папке PhotoShop X.X. Почти все фильтры, описываемые ранее, а также еще несколько других интересных программ можно найти на сайте www.fosi.da.ru, хотя если вы оплачиваете Интернет повременно, то проще, да и дешевле будет купить отдельный диск, на котором будут лежать самые популярные, да и не очень, дополнительные фильтры.

Теперь от вопросов читателей перейдем непосредственно к теме сегодняшней статьи. И снова поговорим о шрифтах и о способах их оформления. Несмотря на то, что написано было уже об этом очень много, хочется остановиться еще на нескольких интересных решениях. Тем, кому эффекты с текстом не интересны, но хочется узнать о возможных способах оформления каких-либо объектов, рекомендую не переворачивать страницу, так как некоторые из описываемых сегодня приемов применимы не только к шрифтам.

Эффект X-file 
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Способ, предлагаемый для решения данной задачи, актуальнее для более ранних версий программ, а также для тех, кто считает, что одарен не совсем тонким художественным вкусом, так как именно при использовании данной методики эффект достигается практически со стопроцентным успехом. Это один из самых эффектных и простых трюков, так что если вы только начинаете осваивать премудрости данного графического редактора, он не вызовет особых трудностей и проблем. Появился он достаточно давно, и в PhotoShop 6.0 есть альтернативный вариант создания при помощи стилей слоя (Layer Style), а точнее внешнего свечения (Outer Glow). Однако, качество эффекта от этого не выиграло, а как раз-таки наоборот. Именно поэтому я предлагаю делать старым, проверенно качественным способом, а именно - через каналы.

Итак, прежде всего, создайте новое изображение. Его лучше взять не очень больших размеров - удобней будет работать, хотя все зависит от размера надписи (в примере) либо рисунка, над которым будут производиться нижеописанные манипуляции. Обязательно залейте фон черным либо очень темным цветом (наиболее ярко выглядит итоговый результат), это лучше сделать сейчас, хоть и понадобится только в самом конце работы.

Прежде всего, создайте новый канал, щелкнув в палитре каналов (Channel) по кнопке с изображением листка бумаги (Create a New Channel) либо по черному треугольнику, расположенному в верхнем правом углу палитры, и из раскрывшегося меню выберите "Новый канал" (New Channel). Назовите его "Black", почему, вы поймете несколько позднее.

Теперь напишите слово или букву, с которой будете работать. Цвет надписи должен быть белым, так как он символизирует выделенные области. Ее лучше писать каким-нибудь массивным шрифтом или сделать вручную, используя Free Transform (Ctrl+T).

Продублируйте слой "Black". Сделать это можно несколькими способами, наиболее простые - это кликнуть правой клавишей мыши по дублируемому слою и выбрать "Duplicate Layer" (Дублировать слой) или перетащить его к иконке с изображением чистого листка внизу палитры каналов. Назовите полученный канал "White".

Вы, наверно, обратили внимание на выделение, которое появилось при написании текста. Именно с его преобразованием и будет связан следующий шаг. Если вы его сняли, то исправить это очень просто. Воспользуйтесь инструментом Волшебная Палочка (Magic Wound), чтобы выделить весь белый цвет в активном канале. Необходимо расширить выделение на несколько пикселей. Чтобы сделать это, нажмите Select->Modify->Expand (Выделение->Изменить->Расширить). Значение поставьте 2-3 пикселя.

В итоге вы получите выделение, которое шире буквы. Теперь необходимо сделать так, чтобы буква соответствовала выделению, но граница получилась расплывчатой. В таких случаях применяется, как правило, Gaussian Blur: Filter->Blur->Gaussian blur (Фильтр->Размытие->Размытие по Гауссу). Значение необходимо выставить такое же, как и в расширении границы или немного больше.

В результате, вы получите канал, на котором будет изображена буква "X" с размытыми краями.

Продублируйте канал "White" и назовите его "Yellow". Опять необходимо расширить выделение, но уже на 3-4 пикселя, и размыть по гауссу с подходящими настройками.

Ну, на этом создание каналов не закончено. Остался еще один - "Green". Создается он так же, как и два предыдущих, но увеличение области выделения теперь равно 5-7 пикселей. Если вы все сделали правильно, то последний канал будет весьма отдаленно напоминать первоначальный текст либо рисунок.

Загрузите канал "Green" как выделение. Для этого достаточно кликнуть по нему мышкой с зажатой клавишей Ctrl. В результате на изображении появится выделение в виде размытой буквы "X" (в моем случае). Сейчас необходимо залить его зеленым цветом. Выберите соответствующий цвет основным (Foreground color) и, используя инструмент Paint Bucket Tool (Ведро), залейте выделенную область.

Также вы можете воспользоваться и инструментом "Fill": Edit->Fill (Редактировать->Залить). Не забудьте только поставить "использовать в качестве источника заливки цвет переднего плана".

Аналогично поступите и с каналами "Yellow" и "White". Отличие только в том, что заливать надо уже желтым и белым цветами соответственно. Теперь становится понятно, зачем мы называли каналы такими именами.

Ну, а теперь загружаем последний канал "Black" и заливаем выделение черным цветом. Вот и все.

Сразу хочется сказать, что это далеко не самый красивый вариант данного эффекта, но зато достаточно простой и наглядный. Примененные в нем принципы можно использовать во многих других ситуациях, далеко не всегда связанных с текстом.

Хромовая надпись
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Это очень сложный эффект хромированной поверхности, а точнее текста. Новичкам за него браться не советую, однако если очень хочется, то можно попробовать. Особенность создания данного эффекта - это тонкое чувство цвета, так как здесь он задается не элементарными функциями, а кривыми, вследствие чего подход к каждому изображению индивидуален, хоть принцип действия один и тот же.

Прежде всего, необходимо написать текст. Однако, здесь, как и в предыдущем эффекте, писать необходимо на отдельном альфа-канале. Это условие, надобность которого станет понятнее позже.

Создайте новый канал. Для этого достаточно кликнуть мышкой по кнопке "Create a New Channel" в палитре каналов (Channel). В результате вы получите альфа-канал, который сразу же станет активным.

Выберите инструмент "Text" и напишите любое слово. Я будут работать со словом "hrom". Обратите внимание на цвет букв. Он должен быть средне-серым (примерно пятидесятипроцентным).

Всякий текст, написанный в альфа-канале, автоматически выделяется. Однако для выполнения следующей операции выделение необходимо убрать. Чтобы это сделать, нажмите Select->Deselect (Выделение->Убрать выделение) или горячее сочетание клавиш Ctrl+D.

Следующее действие - размытие букв. Как уже понятно, для этих целей лучше всего применить какой-нибудь из размывающих фильтров. Предлагаю остановиться на Gaussian Blur: Filter->Blur->Gaussian Blur (Фильтр->Размыть->Размыть по Гауссу). Используйте его со значением Radius 3.0 В итоге буквы будут иметь нечеткие края.

На этом редактирование изображения в отдельном канале закончено. Перейдем в RGB - простым кликом левой клавиши мыши по соответствующему пункту в списке каналов. Не пугайтесь тому, что не увидите надписи - вы и не должны ничего видеть. Так как буквы созданы в альфа-канале, то видимыми они не будут из-за того, что не являются составной частью изображения. Зачем мы их писали? А для того, чтобы сейчас применить очень интересный прием.

Итак, запустите фильтр Lighting Effects: Filter->Render->Lighting Effects (Фильтр->Рендер->Эффекты света). Настроек в диалоговом окне данного фильтра очень много, поэтому опишу их по порядку, однако тут возможны вариации: Style - Default, Light Type - Spotlight, Intensity - 24, focus - 82, Gloss - 24, Material - 68, Exposure - 13, Ambience - 10. И самое важное, без чего эффект просто не получится, - это текстура, которая будет использоваться при применении данного фильтра, - Textur Channel: Alpha 1, то есть канал с написанным текстом. Обратите внимание на то, каким мощным инструментом является данный фильтр. Он позволяет реализовывать поистине фантастические эффекты. Однако повышенного внимания я ему уделять не буду по причине того, что он понятен интуитивно.

На данный момент мы имеем уже сложившееся изображение, то есть, объем уже должен быть заметен. Но необходимо передать не просто объем, а довольно сложную, ступенчатую поверхность. Для этого примените кривые (Curves) - один из самых интересных и полезных инструментов: Image->Adjust->Curves (Изображение->Настройка->Кривые).

Приводить пример кривых я не буду, так как этот шаг не столь важен. Отмечу только, что график должен иметь несколько точек минимума и максимума, причем переход от возрастания к убыванию либо наоборот должен быть довольно резким. Именно так поступила я при создании изображения, представленного вашему вниманию. Всего у меня было две точки минимума и одна максимума.

Следующий этап можно считать одним из самых важных. От него во многом зависит внешний вид итогового изображения. Сейчас мы будем делать буквы цветными. Как, наверное, вы уже догадались, для этого лучше всего использовать инструмент Hue/Saturation: Image->Adjust->Hue/Saturation (Изображение->Настройка->Цвет/Насыщение). Не забудьте установить галочку в "Colorize" (Цвет). Цвет необходимо использовать темно-желтый либо охристый.

Эффект практически готов. Осталась последняя деталь - придать поверхности металлический вид. В данном случае нам необходимо создать блики других цветов и характерные затемнения.

Для решения этой задачи подходит только один инструмент - все те же славные Кривые. Нажмите Ctrl+M для запуска инструмента и нарисуйте кривую, которая представлена на иллюстрации, именно здесь вам и понадобится чувство цвета для того, чтобы несколько преобразовать цвета, но сохранить единство стиля.

Вот и все, работу можно считать сделанной. Результат должен быть похожим на тот, который изображен на иллюстрации.

Текст на волнистой поверхности
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При создании данного эффекта мы поговорим о том, как нарисовать текст на волнистой поверхности. Что представляет собой волнистая поверхность? Самый наглядный пример - развевающийся на ветру флаг. Примерно его мы и будем рисовать, причем сам процесс создания очень и очень прост, может быть, один из самых простых в этой серии, но достаточно интересен визуально. Прежде всего, стоит оговориться, что я не предлагаю вам создавать сложную поверхность неправильной формы, речь идет совсем не об этом. Это визуальный эффект, то есть при помощи игры света и тени, а также контрастности цветов будет создаваться впечатление изогнутой поверхности полотна и текста, на самом же деле ничего трансформировать не надо. Этот прием основан на том, что более светлый цвет как бы огибает предметы и выступает вперед. Впрочем, описывать нюансы цветоведения я не буду, так как скорее всего это вам не понадобится, ну а для подробного описания необходима далеко не одна статья. Так что предлагаю вам положиться на собственную интуицию и последовать некоторым советам, приведенным ниже.

Создайте новый файл. Я буду работать с небольшим по геометрическим размерам изображением. Сразу залейте фон красным цветом - вам тогда будет легче ориентироваться, сравнивая ваш результат с тем, который изображен на иллюстрации, в ней именно этот цвет второго плана.

Теперь необходимо написать на изображении текст. Я ограничилась всего двумя буквами синего цвета. Правда, для большей реалистичности они еще искривлены при помощи Warped text, а конкретней, Arc (в более ранних версиях это можно сделать, пустив текст по пути, используя какой-либо из фильтров), но это вовсе не обязательно.

Теперь создайте новый канал. Для этого в палитре Канал (Channel) нажмите соответствующую кнопку в виде листка бумаги.

Необходимо применить инструмент Gradient (Градиент). Нажмите клавишу "D", чтобы вернуть цвета в состояние по умолчанию (передний план - черный, задний - белый). Теперь можно вызывать инструмент "Градиент". Откройте окно его редактирования и создайте градиент, состоящий из множества чередующихся черных и белых полос, количество которых определяется лишь вашим желанием.

Напомню: чтобы создать новую опорную цветовую точку градиента (бегунок), достаточно кликнуть мышкой в зоне его размещения. Остальные параметры можно установить по своему вкусу, но прозрачность оставьте нетронутой, то есть градиент должен быть абсолютно непрозрачным в любой своей точке.

Дальнейшая работа будет происходить в альфа-канале, поэтому сделайте его активным (просто щелкните по нему мышкой).

Залейте канал градиентом, который вы только что сделали. Обратите внимание на направление - необходимо, чтобы полосы шли горизонтально (как на примере) или вертикально.

Переключитесь на RGB канал. Не стоит удивляться тому, что в нем нет никаких изменений - Alpha Channel никакого отношения к изображению, как совокупности пикселей, не имеет. Дополнительные каналы - это форма выделения.

Сейчас пришла пора непосредственного создания эффекта. Для этого необходимо применить фильтр Lighting Effects: Filter->Render->Lighting Effects (Фильтры->Рендер->Эффекты света). Не буду описывать параметры настроек, так как их можно подобрать по своему вкусу. Обратить внимание стоит только на ключевую настройку - в качестве Texture Channel был применен залитый градиентом Alpha 1. На этом эффект и основан.

Вот, в принципе, и все, что касается флага. Результат можно увидеть на рисунке.

Довольно реалистично, не правда ли?

Описание данного эффекта практически закончено, скажу только, что если, вместо линейного (Linear), взять круглый (Radial) градиент, а все остальные действия оставить без изменений, то изображение получится подобное тому, которое изображено на рисунке.

Хотя последний описанный эффект можно применять не только к тексту, но и к любому другому рисунку. Следует отметить и его недостаток, который заключается в том, что таким образом можно передавать лишь малые искажения.

На этом на сегодня все. Если у вас есть какие-то вопросы или предложения, то по-прежнему можете мне писать, и я отвечу либо вам лично, либо в одной из последующих статей.
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	Прежде всего — это Слоевые эффекты или Layer Style: Layer->Layer style (Слой->Стили слоя). В версии 5.5 слоевые эффекты были малополезным, почти не применявшимся "наворотом" — только что тень от шрифта пустить можно было (мы, к примеру, это неплохо и руками умеем делать).
Версия 6.0 стала переломной в этом плане. Появление новых эффектов и возможность объединять их в стили настолько расширили потенциал любого пользователя, что даже общая стилистика работы в PhotoShop стала меняться. Все меньше зависит от ловкости рук пользователя и все больше от того, что он знает, в какой момент какую кнопку нажать. С одной стороны, это плохо, а с другой — время и силы экономятся.
В настоящее время при помощи Layer Style создается такое количество эффектов, что можно даже сказать, что делается если не почти все, то очень многое.
Другой очень важный момент — появление элементов векторной графики. Это инструменты, объединенные в группу Shapes (Фигуры). Теперь нет необходимости мучаться в попытках воссоздать ту или иную геометрическую фигуру — они уже есть готовые. Особенно радует то, что можно при помощи Path (Контура) нарисовать любую свою фигуру и сохранить ее в примерах, а в дальнейшем при необходимости использовать.
Не забывайте также о том, что на Shapes также можно применять Layer Style и, тем самым, сложнейшую работу свести к паре манипуляций.
Одним словом, если в PhotoShop 5 после PhotoShop 4 особенно добавить было нечего, то шестая версия принесла множество ключевых изменений.
Итак, начинаем. Пример первый.

Резные деревянные буквы
[image: image48.jpg]



Сформулируем задачу — необходимо нарисовать буквы, имеющие фактуру дерева и при этом создающие впечатление нанесенной резьбы.
Разумеется, в более ранних версиях PhotoShop это было бы или вообще невозможно, или пришлось бы вырисовывать, что говорится, по пикселям. Сейчас все намного проще, но необходимо проявить смекалку.
Создайте исходное изображение (Ctrl+N). Color Mode (Цветовой режим) возьмите как RGB, размерность особого значения не имеет, но лучше сразу задать высокое разрешение (Resolution). Это несколько замедлит ход работы, но и результат будет намного качественнее. Фон (Background) исходного изображения лучше взять белый.
Выберите инструмент Text (T). Сразу стоит определиться с используемым шрифтом. Он должен быть как можно более массивным. Лучше всего, на наш взгляд, подойдет распространенный шрифт Arial Black. Он поставляется вместе с Windows, и у вас не должно возникнуть проблем с его применением.
Напишите подходящее слово. В нашем случае им стало банальное Wood. Лучше использовать только заглавные буквы, так как это облегчит дальнейшую работу. Размер шрифта должен быть максимально большим.
Цвет букв не имеет абсолютно никакого значения, так как он все равно будет впоследствии заменен.
После того, как шрифт написан, сделаем его деревянным. В PhotoShop 6.0 для этого есть очень простой и быстрый способ. Откройте палитру Styles (Стили).
Несколько уйдем от темы, чтобы разобраться, что такое Стили. Кликните по любому из них — и вы увидите, как изменились буквы. А теперь найдем причину.
Обратите внимание на палитру Layers (Слои). Вы заметили, что под слоем с буквами появились описания слоевых эффектов? Кликните по любому из них — и у вас откроется стандартное Layer Style окно.
Таким образом, делаем вывод, что любой стиль есть не что иное, как сочетание нескольких слоевых эффектов с определенными свойствами. Вы также можете создать любой свой стиль и сохранить его для дальнейшего использования.
Однако, вернемся к нашему дереву. И для его создания в стандартной поставке PhotoShop 6.0 есть готовый стиль. Откроем его.
В палитре Styles в правом верхнем уголке найдите кнопку в виде стрелки. Кликните по ней. У вас откроется меню, в котором можно выбрать подходящую группу готовых Стилей. Нас интересует группа "Textures".
В открывшихся стилях найдите "Oak". Это сделать несложно — этот стиль единственный напоминает дерево. Примените его к слою с буквами.
Результат похож на абсолютно плоскую деревянную доску. Разумеется, говорить о том, что из этого можно получить буквы, покрытые объемной резьбой, не приходится.
Но решение очень простое. Мы уже говорили, что любой стиль это сочетание слоевых эффектов. Так кто нам мешает к ним добавить еще один, создающий псевдообъем? Никто. Поэтому откройте палитру Layers (Слои) и под слоем с текстом дважды кликните по слову "Effects". Откроется стандартное окно "Layers Style". Откройте в нем эффект Bevel and Emboss (Скосы и Рельеф) и выставьте напротив него птичку.
Буквы сразу станут объемными. Но нам необходимо настроить именно правильный, подходящий вид объема. Поэтому сделайте следующее:
1. Style должен быть выставлен как Inner Bevel.
2. В Technique выберите Chisel Hard. Это жесткая техника для краев, как раз подходит под имитацию резьбы.
3. Depth и Size выставьте максимально большими. Не стоит задвигать бегунок в крайний правый угол — остановитесь на уровне, когда внешний вид букв перестанет изменяться.
4. Gloss Contur выберите как Cove-Deep.
В результате буквы станут достаточно похожими на вырезанные из дерева. На этом подготовительная часть нашей работы закончена, и мы приступаем к творческой части.
Одно из самых положительных свойств слоевых эффектов в том, что они, в отличие от фильтров, действуют постоянно. И вносимые на слой изменения сразу будут подвергаться обработке эффектом. Это свойство мы и используем в своей дальнейшей работе.
Возьмите стирку (Eraser tool). Этот инструмент по своим свойствам принято относить к простым инструментам рисования, так как в его основу положена Кисть (Brush). Как следствие, можно использовать самые разные типы готовых кистей и рисовать свои (Edit->Define Brush (Правка->Определить кисть)).
Возьмите простую круглую кисть и стиркой проведите по буквам. Понятно, к чему все клонится? У вас получилась не дырка, а ровный скос, как будто кусок дерева отщипнули долотом. Это свойство мы и будем использовать.
Загрузите методом, аналогичным тому, что использовался при загрузке Стилей, группу кистей Assorted. В ней находятся самые разные по внешнему виду кисти, всякие звездочки, снежинки и тому подобное. Выберите, к примеру, снежинку и кликните по букве. Сразу появится как бы вырезанная звездочка.
Аналогичным образом используются и другие кисти для покрытия букв резьбой.
Для улучшения конечного результата лучше добавить еще слоевой эффект Drop Shadow, выставив минимальную дистанцию распространения. Выставить же его совсем просто по точно такой же технологии, что мы уже описывали для Bevel and Emboss.
Вот и все, эффект готов. Аналогичную технику можно применять не только для букв и не только для дерева, а еще в куче случаев. Главное — использовать фантазию.
Измененный стиль вы можете сохранить как новый и, таким образом, облегчить себе работу в случае необходимости повторения. 
Вообще, привычка сохранять созданные стили является хорошей привычкой и может много раз вам помочь. Места же на диске при этом тратится мизер, да и разговаривать о дисковом пространстве при размерах современных винчестеров как-то несерьезно.
Создание маленьких GIF-файлов для Html-страниц
В одной из прошлых статей, посвященной ответам на вопросы читателей, была заметка на тему "как убрать белые линии на краях gif файлов". Но это породило не столько ответы, сколько вопросы. Читатели стали интересоваться техникой создания таких небольших графических файлов в целом, от начала и до конца.
Сразу хочется сказать, что приведенное описание субъективно. Невозможно сказать, это лучший способ или нет — каждый пользователь работает так, как ему удобнее. Однако приведенная методика наиболее легка, и ей могут овладеть абсолютно все, даже при невысоком коэффициенте ровности рук.
Попробуем нарисовать самый сложный, самый проблематичный вариант — маленький закругленный уголок. Не возьмемся сказать почему, но именно по нему больше всего вопросов возникает у молодых пользователей, в том числе и написавших нам читателей "Компьютерной газеты".
Создайте новый документ (Ctrl+N). Цвет заднего плана (Background color) прозрачный (Transparency). Это нам необходимо для того, чтобы уголок вписывался в дизайн любого сайта. Но если фон под этим уголком у вас на страничке моноцветный, то лучше задать этот же цвет — слава богу в PhotoShop 6 можно выбирать цвета по их web-кодам.
Разрешение (Transparency) выберите равным экранному, то есть 72 PPI (Pixels per Inch). Некоторые используют определенные свойства Html-кода и пользуются более высокими разрешениями, в описании страницы потом выставляя необходимое значение. Этот способ хорош, но только для опытных пользователей, мы же рассматриваем самый простой вариант.
Размеры нужны маленькие, примерно 15 пикселей в высоту и 40 в длину. Впрочем, это уже определять скорее вам — если опыт работы маленький, возьмите несколько больше, если вы опытный, то можно попробовать поработать в "экстремальных" условиях.
У вас откроется новый документ. Для упрощения дальнейшей работы лучше проделать следующее: View->New View (Вид->Новый вид). Эта команда открывает новое окно с этим же документом. Его увеличьте (Ctrl + +) примерно до 1300%, старое окно оставьте без изменений в реальных пропорциях. Теперь все изменения вы сможете вносить и наблюдать в обоих окнах и намного лучше контролировать процесс.
Начинаем работать с окном 2. Возьмите инструмент Pen (Перо) и нарисуйте диагональ. Старайтесь это делать как можно более качественно и внимательно, от этого в наибольшей степени зависит успех всей остальной работы.
Но нас интересует не прямой, а закругленный уголок. Поэтому, дорисовав первый вариант, смените Pen на Add Anchor Point Tool (Добавить якорную точку), имеющий вид пера со знаком "+". Кликните в центре скоса уголка и вытяните его вертикально до нужной степени (тут никаких советов нет — все дело вкуса). Стоит избегать только одного — углы не должны выходить за пределы рисунка.
Убедитесь в том, что вы достаточно качественно нарисовали путь. Не должно быть слишком резких перегибов, выходов за пределы рисунка.
Теперь необходимо открыть палитру Path (Пути). В ее верхней правой части нажмите кнопку в форме стрелки, открывающую меню доступных команд. Из них необходимо выбрать Fill Path (Залить путь).
В открывшемся стандартном окне для нас существенно важен только один параметр. Это Anti-aliased. Антиалиазинг — это распространенный способ сглаживания неровностей, образованных тем, что пиксели имеют квадратную форму. Реализуется он следующим образом — переход осуществляется не сразу, а через небольшой градиент по краям.
Так как в GIF нет многоуровневой прозрачности, то переход при записи в Gif файл и превращается в эту проблемную белую линию.
Поэтому отключите флажок Anti-aliased. Путь зальется основным цветом. Просмотрите все края. Возможно, кое-где придется дорисовать пару пикселей (при помощи кисти (Art Brush Tool)). Еще вероятней придется немного затереть ластиком.
Но это еще не все. Важно правильно сохранить получившуюся картинку. Запустите команду File --> Save for Web (Файл --> Оптимизировать под Web).
Открывшееся окно представляет собой мощнейший инструмент для оптимизации иллюстраций под Всемирную сеть. Однако, это скорее тема отдельной статьи, поэтому коснемся мы только одного параметра.
Посмотрите на часть окна, обозначенную как Color Table (Цветовая таблица). В ней отображены все цвета, которые есть в сохраняемом изображении (индексированные, разумеется). В идеале у вас должно остаться только 2-3 цвета. Поэтому лишние просто-напросто удалите, пиксели таких цветов заменят цвет на наиболее близкий из оставшихся. Вот и все. Размеры получившегося файла будут просто смешные (у нас 83 байта), а качество зависит только от старания и умения.
Можно несколько упростить операцию и получить намного более качественный результат, если вместо GIF использовать формат PNG, обладающий сходными качествами, но поддерживающий 24-битный цвет. Однако при этом и значительно возрастет размер файла, что для web-странички не очень хорошо — элементы интерфейса должны загружаться мгновенно (на наш субъективный взгляд). Хотя в США, к примеру, уже мало обращают внимания на вес страничек — с их скоростями они могут себе это позволить, мы же пока — нет.

Анимированный баннер-2
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Некоторое время назад в "Компьютерной газете" вышла статья, посвященная Photo-Paint 10. В ней, в частности, описывались способы имитации так называемого эффекта матрицы, или бесконечно бегущих чисел.
Читатели с достаточным упорством просят переписать тот материал для PhotoShop 6, сделав особенный акцент на изготовлении баннеров. Переписывать мы не станем, а вот использовать эту идею для описания создания баннера в PhotoShop вполне можно.
В качестве идеи будет использована некая калька с рекламного баннера одного из минских банков, который сейчас достаточно часто можно видеть в by-нете. Причина этому не в том, что своих идей не хватает, а в том, что несколько читателей попросили описать процесс создания чего-либо подобного.
Итак, приступим. Основная проблема, которая стоит перед нами, — любой более или менее приличный баннер должен весить не более 25 Кб. Если это число значительно превышено, значит человек, который создавал такую рекламу, не совсем ценит время людей, пользующихся Интернет.
А как следствие, если мы ограничены в размерах, то в чем-то нужно экономить. Учитывая свойства формата Gif, будем выбирать между экономией на кадрах и экономией на цветах (а лучше максимально уменьшать количество того и другого). Так как бегущие цифры нормально выглядят только при соответствии количества кадров количеству строк цифр, то каждый должен определять индивидуально. В нашем случае будет пять строк, следовательно, пять кадров. Экономить придется на цветах. Наш баннер будет выполнен исключительно в зеленых оттенках.
Мы несколько уклонимся от стандартных баннерных размеров и создадим его в пропорциях 400 на 100 пикселей.
Но сначала нам нужно подготовить бегущие цифры. Создайте новый документ (Ctrl+N) размерностью 100 на 100 пикселей в Color Mode (Цветовом режиме) RGB. Background лучше сразу взять как черный.
Сделайте зеленый основным цветом. Выберите инструмент Text (T). Напишите примерно так же, как отображено на иллюстрации справа. Цифры должны занять практически всю площадь изображения, от краев не должно оставаться пустого пространства, за исключением верха.
Лучше каждую строку делать как отдельный слой — будет намного удобнее подогнать их друг к другу.
После того, как вы написали все цифры и подровняли строки, необходимо склеить все слои: Layer->Flatten Image (Слой->Склеить изображение).
Полученный файл сразу сохраните под номером "1" в формате gif, используя команду Save as... (Shift+Ctrl+S).
Сделаем смещение цифр по вертикали. Для выполнения этого есть несколько способов, но мы будем пользоваться тем же, что и в Photo-Paint, то есть наиболее автоматизированным, быстрым и простым.
Запустите фильтр Offset: Filters->Other->Offsets (Фильтр->Другие->Сдвиг). Убедитесь, что тип сдвига выставлен как Wrap around (Вращать вокруг). При применении этого способа повторяется эффект, как будто ваша картинка намотана на барабан.
Нас интересует только вертикальное смещение. Поэтому в Horizontal выставьте 0. А вот с вертикальным смещением придется немного подумать. Так как всего у нас пять строк, следовательно, будет и пять кадров. За пять кадров должна пройти вся картинка. Поэтому сдвигать каждый раз нужно на 1/5 от всей высоты.
Так как высота у нас равна 100 пикселям, то смещение составит 20. Это значение и введите в параметре Vertical. Полученный файл сохраните под именем 2.
Дальше все намного проще. Нажмите Ctrl+F (повторить последний фильтр с использованными настройками) — и картинка снова сдвинется на 20 пикселей. Сохраните ее как 3. Аналогичным образом изготовьте еще 2 кадра.
Но мы ведь делаем баннер. Поэтому после того, как готовы все пять кадров, необходимо создать новый файл размерностью 400 на 100 пикселей в экранном разрешении и RGB цветовой модели. Неважно, что вы на нем нарисуете (у нас вообще произвольный латинизм и обработанный портрет одного из авторов). Важно то, что мы будем делать дальше.
Создайте на диске отдельную папку с произвольным именем.
Добавьте к нарисованному баннеру первый кадр с цифрами путем простого копирования (Ctrl+A) с файла 1 и вставки (Ctrl+V) на обрабатываемое изображение.
Запустим команду Save for Web: File->Save for Web. Посмотрите на количество предлагаемых цветов. Оптимально их оставить на уровне 32, можно немного больше. Меньше у вас вряд ли получится. Сохраните полученный файл в созданной папке под именем 1.gif.
Аналогичным образом сделайте и оставшиеся 4 кадра, соблюдая нумерацию (это очень важно для последующей анимации).
Откройте программу Image Ready, поставляемую вместе с PhotoShop 6.0. Это можно сделать, нажав самую нижнюю кнопку в палитре инструментов, на которой нарисованы два символа и стрелка между ними.
Выполните команду File->Import->Folder as Frames (Файл->Импорт->Папку как кадры). Папку, понятно, выберите созданную, с лежащими в ней заготовками. Кадры сами выстроятся в нужном порядке, потому что мы их нумеровали поочередно. Вы сразу можете просмотреть получившуюся анимацию, нажав кнопку "Plays animations" в палитре Animation. Скорее всего, она вам не понравится — кадры слишком быстро сменяют друг друга.
Однако, это совсем несложно исправить. Обратите внимание на то, что под каждым кадром написаны цифры. Это задержка, сколько "стоит" тот или иной кадр. Кликните по этим надписям и измените до 0.1 секунды (или на другое число, которое вам больше понравится экспериментально). Всегда можно получить абсолютно любую задержку, используя вариант "Other" (Другой), в котором время определяется в удобных всем секундах.
Сохраните полученный файл при помощи команды File-> Save Optimized As (Файл -> Сохранить оптимизированный как).
Итоговая величина файла у нас составила 24.6 Кб, то есть в приемлемый размер, несмотря на большое количество кадров, удалось вложиться. К сожалению, в газете невозможно напечатать анимацию:), поэтому вам придется сделать все самим и только тогда увидеть получившийся эффект. Но это даже лучше — ваш труд не будет отягощен примером, а в основном тяжелее всего сделать что-то новое именно тогда, когда видел какой-нибудь вариант работы.
Если у вас файл получился слишком большой, то причина, видимо, в использовании слишком большого количества цветов. Откройте заготовки в PhotoShop и постарайтесь подобрать такой вариант, при котором и качество останется приемлемым, и размер фалов уменьшится. Возможно, удалять и добавлять цвета придется вручную.
В следующей статье, посвященной PhotoShop, мы снова вернемся к теме интересных примеров работы. Если у вас есть какие-либо наработки, идеи, то посылайте.
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	Эта статья будет полностью посвящена эффектам с текстом. Причина такой компоновки проста — именно этих наработок у авторов накопилось большое количество. Кроме того, мы считаем, что это одна из самых полезных областей применения PhotoShop, интересующая наибольшее количество читателей.

Стальная буква со следами насилия :)
[image: image51.jpg]\




В серии статей, посвященной PhotoShop 5.5, которая вышла прошлой осенью, уже было описано, как нарисовать металлическую букву. Наша сегодняшняя задача намного сложнее и интереснее — нарисовать такой объект, чтобы он казался очень сильно механически поврежденным (посмотрите на иллюстрацию — она говорит сама за себя).
В прошлой версии программы это было бы невозможно для обычного пользователя, так как пришлось бы рисовать по точкам, а это прерогатива профессиональных художников. В PhotoShop 6.0 возможности в создании эффектов намного шире. Разработка и создание этой буквы заняла минут пять. 
Примерно столько же должно уйти и у самого неискушенного пользователя.
Создайте новое изображение. Размеры нужно взять изначально крупные, примерно 700 на 700 пикселей. Разрешение, в принципе, подойдет и экранное (72 PPI), но лучше и этот параметр увеличить до 150 PPI — в дальнейшем это улучшит качество скосов.
Color Mode (Цветовой режим) стоит установить сразу как RGB. Цвет фона (Background color) не имеет принципиального значения, но все же лучше принять его за белый.
В качестве объекта для экспериментов авторы выбрали букву. Но это скорее дань привычке, вы же можете использовать что угодно, хотя бы Shapes. Хотя на букве этот эффект выглядит наиболее прилично.
Итак, запустим инструмент Text (T). Цвет нужно изначально выбрать правильно. Это должен быть серый средней степени, ответственность за подбор полностью лежит на Вашем вкусе.
Шрифт лучше предпочесть максимально массивный. В данном примере использован Arial Black, Вы также можете использовать его, так как он входит в стандартно поставляемые вместе с Windows шрифты. Размеры определяйте на глаз, но будут они достаточно большими (в нашем случае — 700 pt).
После того, как написана буква, нужно придать ей некоторую фактурность, которая в дальнейшем сделает металл более реалистичным. Дело в том, что стальные изделия несколько "играют" на свету неровностями и шероховатостями поверхности и в результате кажется, что металл отсвечивает несколькими цветами.
Передать это совсем несложно. Прежде всего, добавим шум: Filter->Noise->Add Noise (Фильтр->Шум->Добавить Шум). Обязательно выставьте параметр Monochromatic (Монохромный). Amount (Величину) стоит определить интуитивно, так как правильное значение зависит от размеров и разрешения Вашего изображения (нами было использовано 13).
Второй фильтр, который необходимо применить для получения нужной фактуры — Grain: Filter->Texture->Grain (Фильтр->Текстура->Зерно). Grain Type (Тип Зерна) необходимо выбрать как Clumped (Группа). Остальные настройки подберите на глаз таким образом, чтобы получилась неброская металлическая текстура.
После этого лучше несколько увеличить контраст, применив фильтр Sharpen More: Filter->Sharpen->Sharpen More (Фильтр->Резкость->Больше резкости).
Фактура готова. Приступим непосредственно к реализации задуманного эффекта.
Воспользуемся, как и большинстве случаев, великолепнейшим инструментом — слоевыми эффектами. Сейчас нас интересует Bevel and Emboss: Layer->Layer Style->Bevel and Emboss (Слой->Стиль слоя->Скосы и Рельеф). 
Сразу выставьте Style (Стиль) как Inner Bevel (Внутренний скос), а Technique (Техника) — как Chisel Hard (Вырубленный). 
Depth (Глубина), Size (Размер) и Soften (Мягкость) необходимо подобрать самостоятельно, так как данные параметры подходят только для конкретного случая. У вас есть вполне достаточная подмога — иллюстрация с готовым изображением.
Но то, что у вас получится, будет скорее напоминать бетон, чем металл. Слава богу, это исправить совсем несложно и даже не нужно выходить из окна Bevel and Emboss (Скосы и Рельеф). 
Очень сильно на внешний вид влияет параметр Gloss Contour (Блеск). По сути, это встроенные в слоевые эффекты яркостные кривые, и правила пользования Gloss Contour соответствуют аналогичным в Curves (Кривые).
Но рисовать подходящую кривую нам не придется. В стандартной поставке PhotoShop уже есть ряд готовых, которые подходят в подавляющем числе случаев. Для данного эффекта лучше всего задействовать Ring.
После можно несколько подкорректировать освещение, используя возможности светового круга (с параметрами Angle и Shadding), но это уже исключительно по желанию.
Первая часть создания эффекта готова. Мы имеем вполне правдоподобную железную букву. Если она несколько неярка, то это можно исправить при помощи Curves (Кривые) или Levels (Уровни).
Приступаем к созданию деформаций. На первый взгляд, это самое сложное, но, в конце концов, окажется, что, наоборот, все трудности уже позади. 
Первое, что необходимо создать, — отломанный кусок буквы. Как уже писалось в прошлой статье, замечательное свойство слоевых эффектов состоит в том, что их действие не одномоментно. В отличие от фильтров, эффекты действуют все время, пока существует слой. И все изменения, которые вы будете вносить в изображение, сразу же подвергнуться воздействию слоевого эффекта.
Эту возможность мы и используем при создании внешних дефектов. Запустите инструмент Polygonal Lasso Tool (Прямоугольное лассо). Выделите небольшой фрагмент буквы. Сделать это необходимо максимально неровно (в разумных пределах) — чем более неровно вы это сделаете, тем более естественно будет выглядеть отломанный кусок. В нашем случае было использовано 8 линий непосредственно на области будущего среза.
Затем вырежьте выделенную область: Edit->Cut (Правка->Вырезать) или клавиатурное сокращение Ctrl+X. Не забывайте о том, что при выполнении операции Cut мы не удаляем выделенное, а помещаем его в буфер обмена.
Буква сразу приобретет достаточно неплохой внешний вид, обломанный край будет выглядеть правдоподобно. Но нам еще нужно поместить "отломанный" кусок на изображение. Так как он находится в буфере обмена, то сделать это можно простой вставкой: Edit->Paste (Правка->Вставить), или клавиатурное сокращение Ctrl+V.
Он будет выглядеть "плоским" фрагментом, совсем не похожим на необходимый отломанный кусок. Причина этому проста — вставка происходит на новый слой, а к нему у нас никаких слоевых эффектов не применено.
Конечно, не составляет никаких трудностей вставить фрагмент на тот же слой, но в конкретном случае нам нужно, чтобы кусочек был именно на новом слое.
Исправим ситуацию самым простым способом. Откройте палитру Layers (Слои). Кликните правой клавишей мыши по слову "Effects" (Эффекты) и выберите "Copy layer style" (Копировать стиль слоя). Затем кликните уже по новому слою и выберите "Paste Layer Style"(Вставить стиль слоя). Как результат, слой с куском будет обладать точно теми же свойствами, что и основной слой.
Для лучшего внешнего вида отломанного куска его можно повернуть при помощи инструмента Free Transform (Ctrl+T) и немного изменить освещение в Bevel and Emboss, предварительно убрав птичку "Use Global Light" (иначе изменения освещения коснутся всего изображения, что крайне не желательно).
Теперь приступим к созданию отверстий, срезов и прочих повреждений. Сделать их еще проще, чем отломанный кусок. Возьмите инструмент Eraser Tool (Ластик) и, выбрав любую кисть, кликните по букве. Появится конусообразное отверстие. Причина этому уже объяснена — слоевые эффекты действуют все время, пока пользователь держит их активными (убрать эффекты слоя можно при помощи пункта в меню Layer->Layer Style, который носит название Hide Layer Style (спрятать стиль слоя)).
По этой же технологии, меняя кисти, можно создать самые разные повреждения на металле. Тут мы вам совсем не указ, действуйте исходя из собственного вкуса. Единственный совет — не стоит заклиниваться только на стандартных кистях, используйте и набор Assorted и другие. Чем больше вы будете экспериментировать, тем больше шансов получить достойный результат.
На этом эффект практически сделан. Можно несколько подкорректировать цвета при помощи кривых или уровней и сменить второй план на другой, но это уже непосредственно к задаче никакого отношения не имеет.
Примерно таким же способом реализуются и другие варианты различных металлов, правда, со своими тонкостями. В ближайшей статье будет описано, как быстро рисовать правдоподобное золото и другие драгоценные металлы.

"Облачный" текст
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Если в первой части этой статьи мы обратились к стали, то сейчас нас ждет более "легкая" работа, в том смысле, что имитировать мы станем облака. Точнее, сами облака как таковые сейчас нас не интересуют — может быть, потом мы и опишем, как из ясной погоды на изображении быстро сделать пасмурную (ранее рассказывалось, как в солнечный день добавить проливной дождь). Сейчас нам важно прикладное применение фактуры облаков, а именно — в качестве "наполнителя" для текста. Но в данном эффекте мало добиться текстуры облаков, нужно чтобы и сам шрифт стал соответствующим.
Создайте новый документ (Ctrl+N). Размеры можно взять произвольные, но не слишком мелкие (рекомендуем 700 на 400 пикселей). Color Mode (Цветовой режим) — RGB. Background Color (Цвет фона) необходимо определить как черный. Если во время создания нового файла черный не является активным цветом, то сразу залейте изображения при помощи ведра.
Создайте новый слой (Ctrl+Shift+N). Все дальнейшие действия производите уже на нем.
На этот раз мы будем писать не текстом, а маской текста. Запустите инструмент Text (T) и в палитре параметров переключите со стандартного режима на режим Create a Mask or Selection (Создать маску или выделение). 
Шрифт можно использовать абсолютно произвольный, однако, он не должен быть ни слишком массивным, ни слишком легким. Идеально подойдет Arial или Garamond. Размеры текста определяйте исходя из габаритов изображения. Мы будем работать со словом Clouds (дань постсоветской банальности :). 
После того, как маска текста создана, зачастую ее нужно немного откорректировать. Разумеется, сочетание клавиш Ctrl+T (Free Transform) тут применить нельзя — нам же необходимо изменить выделение, а не изображение. Поэтому используйте специальный инструмент Transform Selection: Select->Transform Selection (Выделение->Трансформировать выделение).
Применим к полученному выделению настройку Feather (Оперение). Это необходимо для того, чтобы избавиться от резкого перехода букв в фон — какой же может быть резкий переход в облаках? Feather создает по границе выделения область частично выделенных пикселей, поэтому переход между объектами получается плавный, градиентный.
Выберите подходящий голубой цвет. Этот цвет в будущем будет имитировать просветы неба между облаками, поэтому его выбор во многом влияет на качество результата.
Залейте выделение полученным цветом. Для этого можно использовать как инструмент Paint Bucket (Ведро), так и команду Fill: Edit->Fill (Правка->Залить).
У вас получатся простые синие буквы с некоторым эффектом объема. Это результат применения Feather, в более ранних версиях программы таким образом и делали псевдообъемные буквы. 
Далее мы будем использовать все те же Эффекты слоя, а точнее Pattern Overlay: Layer->Layer Style->Pattern Overlay (Слой->Стиль слоя->Текстурная заливка). Этот эффект позволяет залить выделенный слой одним из Примеров, несколько есть в стандартной поставке PhotoShop. Кроме того, любой пользователь может самостоятельно определять свои текстуры при помощи команды Edit->Define Pattern (Правка->Определить образец).
Но та текстура, которая нас интересует, есть в обычной поставке. Называется она Clouds. Выберите ее.
То, что получится в результате последнего действия, вряд ли можно будет назвать текстом из облаков. Серая текстура ляжет поверх синих букв, и это менее всего будет напоминать облака. Но исправить это достаточно просто. В том же окне Pattern Overlay найдите параметр Blend mode (Режим смешения). Его стоит поменять на Overlay, и тогда текстура идеально ляжет поверх цвета.
Буквы уже можно назвать "облачными". Но, как говорилось в самом начале, необходимо еще и форму придать им соответствующую, то есть местами раздутую, местами наоборот.
Для решения этой проблемы воспользуемся великолепным инструментом для многих случаев, который появился только в PhotoShop 6, а именно Liqufy: Image-> Liqufy. 
В верхнем левом углу открывшегося окна находятся инструменты. В двух словах опишем их:
Warp Tool. Инструмент, предназначенный для вытягивания изображений. Основной используемый в данном эффекте. Чем-то напоминает Smudge (Палец), только действие намного более мягкое.
Twirl Clockwise. Закручивает фрагмент, попавший в область действия, по часовой стрелке.
Twirl Counterclockwise. Закручивает фрагмент, попавший в область действия, против часовой стрелки.
Pucker Tool. Стягивает активную область к центру, сужая ее.
Bloat Tool. Расширяет активную область. При создании облачного текста этому инструменту также нужно уделить повышенное внимание.
Shift Pixels. Смещает пиксели перпендикулярно движению кисти. Не ясно, зачем этот инструмент вообще нужен.
Reflection Tool. Перемешивает все со страшной силой. Этим инструментом нужно пользоваться очень осторожно, в данном примере он вам точно не понадобится.
Reconstruct Tool. Что-то вроде стирки. Этот инструмент отменяет изменения, произведенные в Liquify для данной области.
Кроме того, вы можете изменять размер используемой кисти (Brush Size) и степени применения (Brush Pressure). Всего этого вполне достаточно, чтобы делать просто удивительные вещи. В будущем мы, может быть, напишем статью, посвященную этому инструменту, так как возможности его явно не вписываются в несколько фраз.
Используя эти инструменты, исказите текст. Пример в виде иллюстрации у вас есть перед глазами. Не стоит добиваться схожести с нашим текстом, он не догма, а работа, выполненная для ориентации. Вы можете сделать намного лучше, если приложите чуть больше усилий и стараний.
Эффект выполнен. Можно немного подкорректировать цвета при помощи кривых (Curves) или Уровней (Levels), но это уже совсем не обязательно. Даже наоборот, не владея инструментами цветокоррекции достаточно хорошо, вы скорее испортите свое изображение, чем улучшите его. Хотя, если не экспериментировать, то и научиться будет невозможно. Ctrl+Z всегда под рукой :).
На этом статья заканчивается, но так как тема, затронутая ранее, продолженная сегодня, практически не имеет конца и края, то мы обязательно к ней вернемся.
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	В нескольких последних статьях речь в основном шла об эффектах, используемых со шрифтами, хотя этим область возможного их применения не ограничивалась, но именно такие примеры приводились. Это было сделано потому, что при использовании букв можно наиболее ярко продемонстрировать разнообразные стороны той либо иной работы, благодаря их не совсем простой и не совсем сложной геометрической форме, а также разной толщине, острым углам и полукруглым местам.

Сегодня же остановимся на ничуть не уступающей в популярности области применения познаний данного графического редактора, а именно на текстурах.
Ранее уже писалось о том, насколько необходимо умение создавать разнообразные узоры, имитирующие природные материалы, фантастические орнаменты либо что-нибудь другое, которые можно применять в качестве фона при создании web странички, плаката, объявления или другого творения. Кроме того, созданные текстуры можно сохранять в качестве заливки (о том, как это сделать, написано ниже) и использовать их потом, заполняя любые объекты, например, те же самые пресловутые буквы.
В сегодняшней статье будет рассказано не только об очередном эффекте, но и о фильтрах, которые понадобятся при его создании. Это вызвано письмами читателей, которые просят несколько подробнее останавливаться на рассмотрении параметров и возможностей используемых плагинов.
После того, как сказано несколько слов об областях применения, можно и даже нужно переходить к непосредственной работе.

Кирпичная стена
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В одной из прошлых статей (КГ №46(287) от 21.11.00) уже было рассказано о том, как при помощи простых инструментов, входящих в стандартный набор PhotoShop, реализовать нечто подобное кирпичу. Однако тогда мы создавали новенькую, без единой трещинки стеночку. Все кирпичики были гладкие, швы ровные и аккуратные, и рисовали мы их руками. Сегодня же речь пойдет несколько о другом, а именно об имитации старой, потертой стены.
Прежде всего, создайте файл произвольных размеров и цветовой модели, однако если вы собираетесь в дальнейшем использовать его в качестве фона, то лучше сразу указать необходимый размер, хотя это вовсе не обязательно. Также следует обратить внимание на цвет, который может понадобиться, если вы не собираетесь остановиться на черно-белом варианте, и который поддерживается не всеми форматами.
Для того чтобы создать разводы на будущей стене, примените фильтр Sponge из набора Artistic. Настройки можно использовать любые, но лучше придерживаться золотой середины, то есть не делать их слишком мелкими или, наоборот, крупными, остановитесь на умеренной величине. На приведенном примере были использованы следующие параметры: Brush Size — 8, Definition — 7, Smoothness — 7. В результате получился эффект, напоминающий пятна, которые остаются после рисования губкой.
А теперь несколько слов, как и было обещано, о самом фильтре. Из названия, Sponge, а также из получаемого результата следует, что при использовании данного эффекта будет имитироваться наложение краски на холст или лист при помощи обыкновенной губки. Те, кто ранее сталкивался с работой в такой технике, сразу почувствуют сходство, тем же, кто нет, придется либо поверить на слово, либо попытаться порисовать самостоятельно и убедиться в данном утверждении.
При активизации фильтра перед пользователем появляется диалоговое окно, в котором можно регулировать следующие величины:
Brush Size — Размер кисти. Данный параметр изменяется от 1 до 10 и позволяет регулировать размер будущих мазков.
Definition — Контрастность. По сути, данный параметр следовало бы назвать затемнитель, так как при его увеличении (максимальное значение 25) на изображении становится больше темных цветов. Таким образом, при выставлении его равным 1, получается наиболее близкий к исходному результат, далее в нем будет преобладать все больше темных пятен.
И, наконец, последний параметр — Smoothness — Размытость. Изменяется от 1 до 15 и регулирует размытость между разными цветами.
Если исходный цвет фона был черным, то лучше инвертировать полученные цвета, проделав следующее: Image -> Adjust -> Invert, либо нажать сочетание клавиш Ctrl + I. Если же изначально изображение было белым, то данную операцию следует пропустить.
Следующим шагом будет создание самих кирпичей. Здесь можно поступить так, как было написано в одной из прошлых статей, которая уже упоминалась, тогда вы сможете контролировать не только размер кирпичей, но и ширину швов, их яркость, контрастность и другие параметры, а можно воспользоваться уже готовым фильтром, который не дает такой свободы действий, но значительно упрощает и ускоряет работу. Так что если у вас нет особенно важных причин для того, чтобы отдать предпочтение первому способу, то лучше остановитесь на втором, который заключается в следующем.
Примените фильтр Underpainting все из того же замечательного набора Artistic. Здесь есть достаточно большое количество параметров, которые, однако, не дают полного контроля за получаемым результатом, то есть вы его, конечно же, контролируете, но, к сожалению, не можете отрегулировать все до мельчайших подробностей. Писать о значении использованных величин нет никакого смысла, поэтому следует только сказать, что обязательным условием является лишь сама текстура, которая должна быть установлена как Brick, все остальное остается на ваше усмотрение.
Это достаточно интересный и полезный фильтр, так как он имитирует рисунок маслом по выбранному материалу. Полезность заключается в том, что объект, на который будет накладываться краска, может быть любым, например, кирпичом, как в рассматриваемом случае.

Несколько слов о настройках:
Brush Size — Размер кисти. Данный параметр в пояснении не нуждается, так как действует аналогично тому, как и во всех других случаях.
Texture Overage — Текстурный фон. Регулирует ширину мазка, в нашем случае кирпича, и степень его проступания, другими словами формирует выраженность нижнего рисунка, на который накладывается само изображение.
Texture — Текстура. Здесь можно выбрать одну из готовых текстур, например Brick (кирпич), Burlap (Мешковина), Canvas (Брезент), Sandstone (Известняк), а можно загрузить какое-либо изображение (Other (Другое)) формата PhotoShop (кроме тех, которые находятся в режиме Bitmap (Битовая карта)), что позволяет добиваться разнообразных и интересных результатов.
Для сопоставления масштаба текстуры и размера изображения следует использовать такой параметр, как Scaling (Масштаб), который изменяется в процентах.
Relief (Рельеф) — используется для регулирования глубины текстуры посредством изменения насыщенности темных тонов.
Light Dir (Направление света) — здесь угол падения освещения можно изменять с шагом 45 градусов, т.е. сверху, сверху справа, справа...
Кроме того, при активизации параметра Invert (Инвертировать) можно повернуть по цветовому кругу изображение.
После данного шага результат в черно-белом варианте получается достаточно симпатичным и сносным, однако, чтобы его несколько улучшить, можно слегка размыть получившийся результат при помощи фильтра Gaussing Blur, после чего повторно наложить текстуру кирпичей. При необходимости можно отрегулировать яркость и контрастность, используя настройки Brightness/Contrast из меню Image подменю Adjust.
Результатом таких действий должна стать хорошая стена, которую осталось только разукрасить. Здесь все зависит опять же от преследуемой цели. 
Если вы хотите сделать все как можно быстрее, а полученный результат не должен быть детально проработан, то лучше всего проделать следующее: Image -> Adjust -> Hue/Saturation. В открывшемся диалоговом окне установите птичку возле такого параметра, как Colorize, после чего, регулируя цвет, изменяя его по цветовому кругу, добейтесь желаемого результата.
Если же вы преследуете другую цель, то есть детальная проработка реализуемой текстуры, то возьмите такой инструмент, как аэрограф, силу нажима установите небольшую, порядка 10-20%, а режим работы Color, то есть изменяться будет только цветовая составляющая рисунка, никак не влияя на светотеневую. Начинайте закрашивать все изображение, оставляя кое-где небольшие неокрашенные участки. После того, как работа с этим цветом будет окончена, возьмите другой, близкий к первому, и проведите им несколько беспорядочных штрихов таким образом, чтобы реализовать эффект старой стены с облупившейся краской или местами разрушенным кирпичом.
На этом данный эффект можно считать выполненным. Если же вы собираетесь использовать его в качестве заливки, то необходимо определить его таким образом, чтобы это стало возможным. Именно об этом и пойдет речь ниже.

Создание новой заливки
В стандартном наборе PhotoShop 6.0 поставляется достаточно много красивых и разнообразных заливок, которые можно использовать при работе, однако, как бы ни старались разработчики программы, все равно они не смогут удовлетворить все желания пользователей. Это связано как с широкой областью применения данного графического редактора, разнообразием работ, так и с личными вкусами, которые очень редко совпадают. Руководствуясь этими и некоторыми другими причинами, создатели программы позаботились о пользователях и предусмотрели функцию, позволяющую самостоятельно создавать разнообразные текстуры.
Процесс создания новой заливки практически полностью повторит создание новой кисти, но чтобы стало окончательно понятно что да как, особенно для тех, кто не сталкивался с данной задачей ранее, все же остановимся на этом вопросе поподробнее.
Выберите или создайте изображение, которое вы хотите превратить в заливку (например, только что созданную кирпичную стену).
Если преобразовываться будет все изображение, то достаточно проделать всего одну операцию: Edit — Define Pattern (Определить заливку).
При работе с прямоугольной областью необходимо ее сперва выделить, используя инструмент Rectangular Marquee Tool (Прямоугольная область), а затем определить в качестве заливки аналогично тому способу, который описан выше.
Если возникает необходимость создавать заливку, которая будет иметь сложную, неправильную форму, то следует проделать следующее:
— выделите необходимый участок при помощи любого инструмента или путем маскирования;
— скопируйте его в буфер обмена, нажав сочетание клавиш Ctrl + C либо проделав Edit — Copy (Копировать);
— вставьте фрагмент назад Ctrl + V, Edit — Past (Вставить);
— Сделайте прозрачным нижние слои, щелкнув по пиктограмме глаза, расположенного слева от необходимого слоя. Верхний же слой, который образовался после того, как вы вставили выбранный участок изображения, должен остаться видимым.
— Определите изображение как заливку.
После того, как узор заливки создан, им можно заполнять любую, сколь угодно большую область, то есть достаточно создать небольшой образец размером всего в несколько сантиметров, а после заполнять им целые метры.
Следует только учитывать одну особенность. Если вы хотите получить бесшовную текстуру после заливки, то в первоначальном варианте правая сторона должна продолжать левую и наоборот, то же правило касается и верха с низом, так как заливка с помощью текстуры несколько напоминает оклейку обоями.
В одной из следующих статей речь пойдет о цветовом круге, который несколько раз упоминался здесь, но никогда не рассматривался подробно.
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	При представлении зрителю своей работы художник всегда старается ее оформить, сделать ее еще лучше, подчеркнуть индивидуальность. Вообще оформление — это немаловажная часть труда, которую приходится выполнять практически постоянно. Именно то, как будет выполнен заключающий этап работы, определит конечный результат. Хорошо подобранное оформление может как повысить общий уровень творения, так и снизить его практически до нуля. Это касается несоответствия стилей, неправильно подобранных цветов, формы и других мелочей, которые влияют на итоговый результат.

Что касается картин, то чаще всего они заключаются в рамки. Здесь простора для фантазии больше чем достаточно, так как художники не ограничены ни в выборе формы, ни в материалах, ни в цвете, ни в фактуре, ни в размерах, ни в прочих составляющих.
В компьютерной графике выбор несколько иной, чем в реальной жизни, так как нельзя использовать третье измерение, а можно лишь имитировать объем при помощи игры света и тени (с чем надо быть крайне осторожным, так как именно используя такой стиль легче всего испортить оформляемую работу) либо другим способом. С другой стороны, выбор значительно расширяется тем, что рисованная рамка может быть какой угодно по фактуре, цвету, форме, которой невозможно добиться, используя реальные материалы (например, огненное обрамление с оторвавшимися, но еще не успевшими погаснуть язычками пламени — согласитесь, вряд ли можно качественно, а тем более реалистично реализовать такую задумку в реальном, а не виртуальном мире).
Что касается оформления сайтов, да и не только их, то тут возможности расширяются еще больше, так как именно здесь нашли широкое применение различные декоративные детали, такие, например, как заклепки, пуговицы, болты, шурупы (о создании которых было рассказано в одной из прошлых статей), оторванные и загнутые уголки, отброшенная тень, создаваемая мнимым источником света, а также многое и многое другое, на что только хватит фантазии у художника-оформителя. Это наиболее часто используемый способ оформления, так как такие мелочи весят обычно мало, что вызвано их небольшими размерами и малым количеством используемых цветов, а при правильном их применении (главное не делать их слишком много) способны украсить практически любую страничку, сайт или плакат. 
Именно о таких мелочах и пойдет сегодня речь.
И первое, что мы сегодня рассмотрим, как наиболее реалистично нарисовать кусок скотча, которым можно приклеить что-нибудь куда-нибудь и получить достаточно неплохой результат. Точнее сказать, это не первое, а единственное, о чем пойдет речь, но из-за разнообразия приемов такой подход к работе можно будет использовать и при создании других деталей, например оторванного уголка, но об этом позже.

Скотч
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Создайте новое изображение произвольного размера и цветовой модели, которая, между прочим, может быть и Grayscale, так как в этой работе (непосредственное создание оторванного кусочка скотча) цвет не понадобится, а после можно будет перевести изображение в любой другой цветовой режим, позволяющий работать с цветом, если такая необходимость возникнет.
Выберите инструмент Rectangular Marquee (клавиша, позволяющая осуществить данное действие без использования мыши, — М). Создайте внутри изображения прямоугольное выделение, которое должно быть несколько меньше самого изображения. (На приведенном примере размер холста был 530х530 пикселей, а выделения — 410х410).
После того, как выделение создано, необходимо сохранить его как отдельный канал, для этого щелкните по иконке с изображением белого круга, ограниченного пунктирной линией и расположенного внизу палитры каналов (Save Selection as Channel (Сохранить выделение как канал)). После этого действия у вас появится новый Alfa 1 — канал. Он будет дополнительным, а следовательно, на изображение не повлияет, а будет лишь хранить информацию о выделении, которое можно загрузить в любой момент.
Сделайте активным новый, только что созданный канал, щелкнув по нему левой клавишею мыши. В результате, вместо изображения, вы увидите белый выделенный прямоугольник на черном фоне. Снимите выделения, нажав сочетание клавиш Ctrl + D либо проделав следующее: Select -> Deselect. В дополнительном канале белые цвета символизируют выделенные области, черные — невыделенные, а серые — частично выделенные. Работая с такими каналами как с обычными черно-белыми изображениями, гораздо проще создавать сложные выделения, имеющие не только своеобразную форму, но и различную степень проникновения последующих действий.
Для начала необходимо сформировать рваные края, что придаст большую реалистичность итоговому изображению. Для этого примените фильтр Crystallize из набора Pixelate. Параметр Cell Size установите равным 9, после чего края приобретут неровный и небрежный вид.
Фильтр Crystallize (Кристаллизация) используется для преобразования ровного изображения в мозаичное, сложенное из множества неправильных многоугольников, из-за чего складывается впечатление, что рисунок сформирован кристаллами. Данный эффект достигается путем усреднение цвета соседних пикселей. Единственный параметр настройки Cell Size (Размер ячейки) изменяется от 1 до 300 пикселей и определяет размер будущих кристаллов. При малой величине Cell Size изображение приобретает зернистый вид, при больших — становится похожим на неправильную мозаику.
Для того чтобы несколько сгладить полученный эффект, примените фильтр Dust and Scratches из набора Noise. На приведенном примере параметры были следующими: Radius — 6, Threshold — 3.
Dust and Scratches — Пыль и царапины. Данный фильтр ищет на изображении пиксели, сильно отличающиеся по яркости от окружающих их, и заливает их цветом соседних. Таким образом устраняются пыль, царапины и некоторые другие мелкие дефекты, которые достаточно часто возникают при сканировании изображений. В нашем случае у этого фильтра несколько иное применение, так как на изображении присутствуют только белые и черные цвета (возможны также небольшие серые пятна), поэтому мы просто сгладим чересчур сильное действие предыдущего фильтра. Threshold (Порог) определяет, насколько сильно должна отличаться яркость пикселя, который необходимо удалить, от окружающих его, тем самым является как бы пороговой величиной (откуда и пошло название). Чем меньше значение данного параметра, тем сильнее действие фильтра и тем больше ненужных и в то же время нужных деталей исчезнет, поэтому по возможности при работе с фотографиями лучше выбирать данный параметр побольше. Radius (Радиус) определяет величину области устранения дефекта. Увеличивая данный параметр вы тем самым увеличите эффект размытости. Следует помнить, что этот фильтр отдает предпочтение более ярким цветам, что не всегда влияет положительно на изображение, хотя в большинстве случаев выгодно подчеркивает контраст.
После того, как вы проделали все вышеописанные действия, у вас должен был получиться прямоугольник или квадрат со всеми четырьмя рваными неровными краями. Но если подумать, то у оторванного куска скотча неровными должны быть только два края начала и конец, а форму он должен иметь прямоугольную, с более длинными ровными сторонами. Для того чтобы реализовать данную задумку, следует использовать еще раз инструмент, позволяющий создавать прямоугольные выделенные области (Rectangular Marquee Tool (М)). Выделите вертикально либо горизонтально любой участок изображения так, чтобы данная область полностью пересекала белый квадрат в 2 местах (то есть линии, образующие прямоугольник, должны пересекать линии белого квадрата в 4 точках).
Инвертируйте полученное выделение, нажав сочетание клавиш Ctrl+Shift+I либо проделав следующее: Select -> Inverse. Залейте полученную область черным цветом. Клавиша, позволяющая выбрать данный цвет при помощи клавиатуры, — D. (Причем, при работе с дополнительными каналами этот цвет становится цветом второго плана). Если после этого нажать клавишу Del, то все изображение вокруг выбранного фрагмента зальется черным цветом.
Инвертируйте выделение назад (Ctrl + Shift + I).
Нажмите сочетание клавиш Ctrl + T, после чего можете изменить наклон выбранного фрагмента, а в случае необходимости — и его размер. Особенно эффектным выглядит поворот, так как скотч обычно приклеивается по углам, параллельно диагонали приклеиваемого листа.
Снимите выделение, нажав Ctrl + D или Select -> Deselect.
Скопируйте канал, с которым все это время проводились работы, образовав тем самым второй дополнительный. Для того чтобы это сделать, достаточно перетащить его, удерживая зажатой левой клавишею мыши, к иконке с изображением чистого листа, расположенной внизу палитры каналов.
Сделайте активным второй дополнительный канал и загрузите с него выделение. Для этого достаточно щелкнуть по нему с зажатой клавишею Ctrl или щелкнуть по иконке с изображением пунктирного круга (Load Channel as Selection).
Второй дополнительный канал необходим для создания пятнышек воздуха, которые сохраняются под скотчем при его небрежном наклеивании.
Чтобы добиться более реалистичного результата, можно слегка расширить выделенную область при помощи операции Select -> Modify -> Expand. Радиус действия не следует выбирать более 1-2 пикселей.
Примените к каналу с выделением фильтр Mezzotint из набора Pixelate. Type выберите Coarse Dots.
Mezzotint — Меццо-Тинто. После использование данного фильтра все изображение покрывается выбранным узором. Создается достаточно оригинальный эффект, который, однако, на изображениях с малым разрешением выглядит не очень хорошо, так что если при обработке фотографии либо другого изображения с мелкими деталями вы захотите применить данный фильтр, то советую сперва увеличить разрешение. В раскрывающемся меню можно выбрать один из десяти возможных вариантов рисунка, а именно 4 вида точек, 3 — линий и 3 — штрихов неправильной формы.
После того, как оба канала подготовлены, можно переходить к непосредственному созданию изображения. Сделайте фон черным, воспользовавшись инструментом Paint Bucket, командой Fill либо каким-нибудь клавиатурным эквивалентом, после чего можно переходить непосредственно к созданию скотча. Для этого откройте палитру слоев и создайте новый, щелкнув по иконке с изображением чистого листа (New Layer). Измените режим наложения данного слоя на Screen, а параметр прозрачности установите равным 13-16%.
Загрузите выделение с первого созданного канала, щелкнув по нему с зажатой клавишею Ctrl. После чего перейдите к редактированию самого изображения, нажав сочетание Ctrl + ~, что даст возможность перейти от дополнительных каналов к используемому режиму (на примере это RGB).
Залейте полученное выделение белым цветом, который практически не будет виден, но все же необходим для достижения более правдоподобного результата.
Создайте еще один слой аналогичным способом. Режим наложения выберите тот же, то есть Screen, а прозрачность несколько поменьше, порядка 10–13%. Загрузите выделение с каплями воздуха (Ctrl + щелчок по необходимому каналу), инвертируйте его (Ctrl + Shift + I), а затем найдите разность между полученной областью и первым из дополнительных каналов. Последнее действие можно сделать следующим образом: зажать сочетание клавиш Ctrl + Shift + Alt, после чего щелкнуть по необходимому (в нашем случае первому из дополнительных) каналов.
После того, как выделение готово, залейте его белым цветом на новом созданном слое, что создаст иллюзию воздушных капель под наклеенным скотчем.
На этом работу можно считать оконченной. Вместо черного фона можно использовать практически любое изображение, однако если оно выполнено в светлых тонах, то цвета на слоях со скотчем лучше инвертировать, нажав сочетание клавиш Ctrl + I либо Image -> Adjust -> Invert (они станут черными). Режимы наложения слоев со Screen изменить на Multiply, а прозрачность слоя с капельками увеличить примерно до 40%. На примере создания скотча было также продемонстрировано то, как можно создать рваные края бумаги, что тоже является неплохим приемом в оформлении, так как оторванные уголки или край листа способны приукрасить изображение. Если сочетать их с болтами или гвоздями и прибить к стене с шероховатой поверхностью, то можно получить весьма правдоподобный и впечатляющий результат.
Следует отметить, что если использовать такой прием, то для достижения лучшего и более эффектного результата можно совместить его с эффектом слоя и отбросить тень от порванного листка.
На этом остановимся, однако сочетание разнообразных деталей в оформлении дает куда более положительный эффект, нежели чрезмерное применения одного и того же объекта или приема. При оформлении страничек и сайтов следует помнить главное правило о "Золотой середине" и не бросаться в крайности.

	Ржавый текст
2002-09-23


	Автор: Unknown 
	Страницы: [1] 

	
	Комментарии [5] 

	


	Цель этой статьи рассказать вам о том, как создать вот такой ржавый текст. Я думаю, что эффект вам понравится.
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Создайте новое RGB изображение с произвольными размерами. Установите передний цвет как #362F2D, а задний как #A0410D. Возьмите инструмент Type Tool (T)и напишите ваш текст крупными буквами (более 100 пикселей) и, желательно, Bold'ом.
[image: image58.png]Rust




Выполните фильтр Filter > Distort > Ocean Ripple с параметрами по умолчанию (Ripple Size: 9, Ripple Magnitude: 9).
Вы должны получить текст, похожий окраской на мой пример справа. Если нет - то внимательно посмотрите, правильно ли вы установили передний и задний цвета на предыдущем шаге.
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Теперь надо отделить оранжевый цвет от темно-коричневого. В этом нам поможет функция Color Range из меню Select. Выполните её с уже установленными параметрами, ничего не меняйте.
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Добавьте к выделенной области шум (Filter > Noise > Add Noise) с параметрами Amount: 10%, Distribution: Gaussian, Monochromatic: включено. Снимите выделение (Ctrl+D). Снова выполните Add Noise, но теперь уменьшите Amount до 5%.
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С помощью стиля Drop Shadow (он находится в Layer > Layer Styles) добавьте к слою тень.

Примените к слою так же и стиль Bevel & Emboss с такими параметрами:
(В качестве цвета в Highlight Mode установите цвет #DEA2A2)
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	Текст с эффектом скорости.
2002-08-23


	Автор: WeX 
	Страницы: [1] 

	
	Комментарии [3] 

	


	Шаг 1
Откройте новый документ, cделайте фон черным, и напишите текст белым. Теперь нажмите CTRL+E, чтобы объеденить слой с фоном. 
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Шаг 2
Теперь идите filters-blur-gaussian и установите значение приблезительно на 1,2.
Затем filters-stylize-solarize.
И image-adjust-auto. 


Должно получиться как на картинке справа.
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Шаг 3
Далее идём filters-disort-polar coordinates , и выбераем polar to rectangular. 
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Шаг 4
Теперь поверните изображение на 90 градусов (image-rotate canvas-90°CCW). Применим ещё один эффект- filters-stylize-wind. Выберите wind-from left.
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Шаг 5
Поворачиваем изображение в обратную сторону - image-rotate canvas 90°CW. Сново идите filters-disort-polar coordinates, и на сей раз выберите rectangular to polar.
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Шаг 6
Идём к image-adjust-hue/satursation, ставим галочку на "colorize", если Вы хотите, раскрасить надпись. Лучше всего этот эффект выглядит на больших изображениях с большим разрешением.
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	Кубический текст.
2002-08-23


	Автор: WeX 


	Страницы: [1] 

	
	Комментарии [1] 

	


	Прежде всего, позвольте мне сообщать Вам, что этот эффект практически не применим на изображениях с маленьким размером. То, что Вы будете видеть справа является минимумом. Рекомендую использывать шрифт не менее 100px.

Шаг 1
Создайте новое изображение с черным фоном (например), и поместите ваш текст. Я рекомендовал бы использовать белый шрифт и раскрасить его позже. Объедените слой с задним фоном (CTRL+E) и примените фильтр размытия gaussian (Filters- blur- gaussian), чтобы получить более гладкий шрифт. 
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Шаг 2
Дублируйте этот слой, и примените Filters- Pixelate- Mosaic с настройками в 10px. Вы будете должны экспериментировать с различными значениями, я нашел что 10-12 идеально подходит для шрифта с размером в 100 пикселей. 
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Шаг 3
Установите прозрачность вашего текущего слоя 50 %. 
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Шаг 4
Примените Filters- Sharpen- sharpen 3 раза и объедените с бекграундом. Если Вы хотите, раскрасить изображение использования - Image- adjust- hue/satursation. >
Незабывайте отмечать "colorize". 
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Шаг 5
Поскольку я сказал, что эффект выглядит хорошо с шрифтом более чем 100 pix, Вы получите результат гораздо лучше этого. :)
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	Эффект с текстом.
2002-09-20


	Автор: Silver 
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	Страницы: [1] 

	
	Комментарии [1] 

	


	1. Создаем новый файл (размер изображения - произвольный). В этом файле пишем нужный текст. Затем: Layer >> Type >> Render Layer и нажимаем CTRL+E. Делаем фильтр: Filter >> Stylize >> Wind с параметрами: Method: Wind; Direction: From the right. 
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2. Делаем: Image >> Adjust >> Invert. 

[image: image81.png]



3. Filter >> Distort >> Ripple с параметром Amount: 40. 
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4. Filter >> Stylize >> Glowing Edges с параметрами: Edge Width: 2; Edge Brightness: 6; Smoothness: 5. 
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5. И последнее: делаем Image >> Adjust >> Variations и подбираем то, что нам нужно. 
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	Простой способ создания масок сложной формы.
2002-08-15


	Автор: Роман Соболенко 
	Страницы: [1] 

	
	Комментарии [0] 

	


	Как только дело доходит до чего-либо более художественного, чем простейшая корректировка экспозиции фотографий, сразу появляется необходимость создания масок. Причем при работе с фотографиями часто требуются маски с очень сложным контуром, так как в жизни не найдешь объектов простой геометрической формы.
Маски - это наиболее широко используемый способ оставить доступной для рисования или любого другого изменения только часть изображения. Кроме того, с помощью масок часто в фотографии вводятся новые объекты. Поэтому практически каждое действие, выполняемое компьютерным художником при творческой работе с фотографическими изображениями, начинается с создания маски.

Понятно, что если придется потратить на это полчаса, исчезнет всякое желание возиться с этими компьютерными картинками. Тогда проще сделать тот же коллаж дедовским способом с помощью ножниц и клея. Естественно, что авторы графических редакторов постарались оснастить свои программы богатым набором средств создания масок.

Во-первых, это инструменты, позволяющие моментально создать маску прямоугольной или эллиптической формы. Маски при этом растягиваются при нажатой копке мышки от одного из углов или от центра фигуры. Обычно имеется возможность точно задать ширину и высоту в пикселах. Из прямоугольников и кругов можно скомпоновать контур весьма замысловатой формы, используя режимы сложения, вычитания и пересечения масок. Но эти инструменты в большинстве случаев не позволяют точно обвести на фотографии реальные предметы.

Вторая группа инструментов создания маски действует автоматически, при разметке областей исходя из сведений о цвете. Волшебная палочка, лассо и их варианты действуют по одному принципу - расширяя (или, наоборот, сужая) область разметки от указанной ими точки до тех пор, пока не натолкнутся на цветовой переход, выходящий за рамки установленного художником порога чувствительности. Иногда лассо позволяет просто провести контурную линию вручную (но я не считаю, что это стоит делать без планшета) мышкой. Еще один способ создания маски - выбор по цветовому ключу - хорошо знаком телевизионщикам, где применяется для замены определенного цвета в картинке на изображение с другой камеры. Но в маску при этом включаются все пикселы в картинке, относящиеся к заданному цвету.

И наконец, не танцевать! То есть маску можно нарисовать. Простыми инструментами рисования - карандашом, кистью, аэрографом и т.п. С учетом присущих каждому из инструментов особенностей. Нарисованные маски не только могут достаточно точно (тут все зависит от вашего мастерства и упорства) повторять контуры реальных предметов, но и обладать управляемой художником полупрозрачностью.

В принципе маска представляется в редакторах полутоновым черно-белым изображением, на котором черные точки оставляют соответствующие расположению пикселы в основной картинке доступными изменению, белые, наоборот, полностью исключают любые изменения, а серые пропускают воздействие фильтра или инструмента в пропорционально своему оттенку ослабленном виде.

Благодаря этому подходу можно создавать маски сколь угодно сложной формы, включающие не менее хитроумные полупрозрачные области. Их можно легко записывать на диск и загружать с него при необходимости. По большому счету, любая черно-белая фотография может стать маской. Так что для сложности предела нет. Но вот как строить маски попроще, не тратя на это уйму времени и сил? 

И тут приходит естественная мысль - а не сделать ли маску из самой фотографии, вместо того чтобы ее рисовать вручную? Можно. Не всегда получается, но можно. Разумеется, для этого тоже есть свои приемы, неизвестные не только начинающим, но и многим профессионалам.

Рассмотрим проблему, как всегда, на несложном примере. Задача следующая. Имеется фотография снятой на фоне голубого безоблачного неба скалы в пустыне.
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Такое небо нас не устраивает, и мы хотим затянуть его облачной дымкой. Выполним задачу средствами Adobe Photoshop 4.0. Я попробовал для сравнения ту же работу сделать в Corel Photopaint 7.0 и убедился, что, несмотря на исключительное богатство фильтров, типов кистей и прочие навороты, рисует он по-прежнему плохо, рывками какими-то, и потому его нельзя назвать лучшим выбором для таких работ.

Итак, я собираюсь построить маску, чтобы заменить одно небо на другое. То есть маска должна повторять контур неба, или скалы, растительности под аркой... Какая область маски будет черной, а какая белой, безразлично. Попытка построить черно-белый рисунок в лоб из самой фотографии явно обречена на провал. Не хватит контраста, чтобы точно разделить маскируемые области.

И все же попробуем кое-что сделать. Фотография Rocks.tif у меня цветная, и для построения маски стоит посмотреть составляющие каналы - красный, зеленый и синий. Конечно, среди них найдется такой, на котором контраст между небом и остальными предметами сильнее, чем на фотографии в целом. Открываю палитру каналов Channels. В данном случае это синий канал, но для других снимков им может оказаться и красный, и зеленый.

Кстати, выбирая для создания маски один из цветовых каналов, надо не только исходить из максимального контраста между интересующими областями, но и проверить, чтобы выделяемые маской участки оказались по одну сторону от "цветораздела". То есть должна быть возможность привести абсолютно все участки, открываемые маской, к одному цвету - либо к белому, либо к черному.

О'кей, я остановился на синем канале. Для создания маски его надо скопировать на новый канал. В Photoshop это делается исключительно легко . Следует просто перетянуть мышкой в палитре Channels синий канал на кнопку создания нового канала (на пиктограмму чистой странички). Появился канал, обозначенный как #4, с которым можно безбоязненно работать, так как он не входит в цветовую модель и картинку поэтому не испортишь.
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Я выбрал самый контрастный канал, такой, на котором небо - самое светлое, а все остальное - самое темное. Но все же не белое и не черное. Следовательно, предстоит усилить контраст, доведя картинку до того, чтобы в ней остались лишь эти два цвета.

Любой, кто проработал с графическими редакторами больше недели, сразу же скажет, что сделать это можно с помощью регулировки уровней полутонов (Levels) или кривой передачи (Curves). Это если хочется поточнее все выставить. Проще всего воспользоваться командой Image/Adjust/Threshold, которая передвижением всего одного ползунка позволяет задать точку, относительно которой более светлые полутона будут заменены белым, а более темные - черным. Регуляторами яркости и контраста ничего путного не добьешься, это даже совсем зеленые новички понимают.

И все-таки перечисленные средства не самые лучшие. Есть в арсенале Photoshop кое-что получше - инструменты тонирования Dodge (осветлитель) и Burn (затемнитель). Это очень интересные средства, которыми не любят пользоваться художники, не понимая сути их работы. А ведь любой фотограф знает (и умеет), как подправить при печати переэкспонированную с одного края фотографию. Для этого следует уменьшить время засветки (экспонирования) фотобумаги в том месте, где снимок слишком темный. Просто прикрыв от света проектора на несколько секунд этот край рукой.

По этому принципу и действуют инструменты Dodge и Burn. Применение первого соответствует сокращению времени экспонирования, а второго - увеличению. Основное отличие в том, что применять эти инструменты можно отдельно к светлым (highlights), к средним (midtones) или к темным (shadows) полутонам, не затрагивая другие по тональности пикселы. Это принципиальное отличие от действующих сразу на все пикселы независимо от их тона фильтров Layers, Curves и Threshold.

Смотрите. Мне надо довести небо (и только небо) до чистого белого цвета, а все остальное затемнить до черного. Но на скале есть участки, которые практически не темнее неба. Если воспользоваться фильтрами, то и они окажутся белыми и придется потом поработать карандашом. Я поступлю иначе.

Чтобы сильнее осветлить светлое (то есть относящееся к верхней трети тонального спектра - highlights) небо, я активизирую инструмент Dodge, открываю палитру с опциями для него и выбираю в качестве зоны действия Highlights, то есть только светлые пикселы. Экспозиция (Exposure) должна быть в пределах 30 - 50%, чтобы, с одной стороны, не выбеливать слишком сильно, но, с другой, и не возиться долго. Осветлять небо предстоит вручную, и для этого рекомендую воспользоваться довольно большой кистью с мягкими краями.
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Проводим мазками Dodge по небу до тех пор, пока оно не станет практически белым. Обратите внимание, что на скалу, даже когда по ней проходит инструмент, эффект почти не действует. Ну вот, с небом разобрались. Теперь остальные участки картинки. Их надо затемнить до черного. Приступаем к этому, переключив в палитре Options инструмент на Burn и область действия на Shadows. Кисть и экспозиция пусть остаются теми же.

Практически готово. Если у вас на канале #4 остались сомнительные места на границе между черной и белой областями или на скале кое-что не удалось затемнить, попробуйте переключить Burn на действие в средней части спектра (Midtones). Не расстраивайтесь, если с первого раза получится не очень точная маска. Как и при других ручных работах, надо немного набить руку. Раза с третьего-пятого вы почувствуете, до какой степени и с какой силой надо действовать Dodge и Burn, приловчитесь управляться с границей маски так, чтобы она не наползала на соседнюю область.

В крайнем случае проверить результаты и подправить отдельные места можно, перейдя в режим рисования маски Quick Mask. Для этого надо включить отображение цветовых каналов, выключить канал #4 и загрузить маску на его основе. Звучит устрашающе, а делается двумя щелчками мышки по пиктограмме канала #4 в палитре Channels. Щелкните с нажатой клавишей [Shift] - и переключите каналы, с клавишей [Ctrl] - и загрузите маску. Подправив маску, сохраните ее командой меню Select/Save Selection в канале #4, заменив его содержимое. Пусть маска в этом канале и болтается, кто знает, сколько раз она еще потребуется.
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Когда маска готова, предстоит поработать со слоями. Для неба мне потребуется новый слой Sky, который я и сделаю, нажав на кнопку в палитре слоев Layers. Однако слой Sky лег над слоем со скалами, а должно быть наоборот. Чтобы поменять их местами, придется переименовать слой Background, сдвинуть который Photoshop не позволяет, в Rocks. Кстати, уже пора перенести результаты работы в файл. Многослойные изображения хранятся в формате Photoshop, а не TIFF, так что при сохранении надо изменить тип файла на PSD.

Если маска сброшена, загрузите ее. Небо надо удалить со слоя Rocks, но, перед тем как нажать на клавишу [Del], возьмите с картинки пипеткой голубой цвет неба - он понадобится для слоя Sky. Выберите наиболее темный оттенок. Удалив "родное" небо, переходим на слой с "синтетическим" и закрашиваем его полностью снятым с фотографии оттенком голубого.

Следующий шаг - генерация облаков. Если у вас под рукой есть фотография красивого облачного, лучше воспользоваться ею, затянув ее на слой Sky. Так получится естественнее. Но если неба нет, его можно получить, применив фильтр Filter/Render/Clouds. Запустите его несколько раз подряд, нажимая клавиши [Ctrl]+[F], пока не получите более привлекательную раскладку облаков относительно остальной части изображения.
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Гм-м. Небо-то есть, но смотрится оно неестественно. Чего, впрочем, и следовало ожидать. Для получения большого сходства с жизнью одних фильтров мало, надо еще поработать головой и руками. Во-первых, небо лишено перспективы, то есть искусственные облака подобны взгляду строго в зенит. Но с перспективой еще ладно, на дымке она заметна не сильно. Не хватает еще чего-то.

Посмотрите за окно (конечно, в солнечную погоду). Видите, что в зените небо гораздо темнее, чем на горизонте? Думаю, не стоит обсуждать природу этого эффекта, так как нас сейчас интересует в основном, как его смоделировать. Это сделать можно разными способами. С одной стороны, предстоит изменить насыщенность голубого так, чтобы в зените он остался таким же мощным, каким был на исходной фотографии, а к горизонту сошел к совсем блеклому, почти белому. Проще всего, на мой взгляд, следующий вариант.

Создаем новый слой Zenith, поместив его между скалами (Rocks) и небом (Sky). Этот слой будет использоваться исключительно для тонирования неба. Нарисуем на нем растяжку от черного к белому, направленную сверху вниз. Она соответствует степени ослабления голубого в нарисованном нами небе. Следовательно, зенит должен быть черным, а к белому стоит перейти немного выше линии горизонта.

Для совмещения характеристик двух слоев - Zenith и Sky - следует прибегнуть к специальному режиму наложения пикселов. Режимов этих много, так что практически всегда можно найти подходящий по действию. В данном случае следует применить для слоя Zenith наложение в режиме Screen, вызывающем "деление" исходного цвета (то есть с расположенного ниже слоя Sky) на вносимый (он берется со слоя Zenith). При делении черный цвет является как бы единицей и на результат не влияет. А более светлые полутона приводят к уменьшению насыщенности результата, причем белый цвет выбеливает добела.
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Нам это как раз и требуется. Переключив в палитре слоев режим для Zenith на Screen, получаем уже нечто похожее на реальность. Чтобы ослабить эффект от "деления" тонов, следует передвинуть влево регулятор Opacity. Регулируя прозрачность слоя Zenith, имеет смысл подобрать наиболее подходящую для фотографии "погоду". В общем, на этом работу можно считать законченной.

[image: image91.jpg]



Как видите, маску сложной формы удается создать на основе одного из цветовых каналов. Причем для этого лучше воспользоваться не фильтрами, а более тонко работающими инструментами тонирования, которые позволяют изменить экспозицию в заданной части спектра, не затрагивая другие полутона. А если при этом все-таки останется нежелательный ореол, его легко устранить, либо подправив маску в режиме Quick Mask, либо просто расширив ее на один-два пиксела командой Select/Modify/Expand.

А хорошая маска - это уже добрая половина работы.
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	Откройте Вашу первую картинку. Выделите все (CTRL+A) затем скопируйте (CTRL+C). 
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Откройте вторую картинку.  
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Включите режим быстрой маски (Quick Mask) и нарисуйте градиент на Вашей картинке от черного к белому. Поскольку Вы в режиме Быстрой Маски, то белый цвет выглядит прозрачным, а черный красным. Чем краснее, тем прозрачнее будет это место на картинке 

 [image: image94.jpg]



Вернитесь обратно в нормальный режим (Normal Mode) и Вы увидите прямоугольное выделение вокруг половины Вашей картинки. Теперь просто вставьте Вашу первую картинку в это выделение (EDIT...PASTE INTO). После этого Ваша первая картинка плавно сольется со второй.
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